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Chapter 1 

Introduction 

Welcome to GerbTool, the easiest, most powerful, and versatile CAM station 
available. 

GerbTool provides a powerful set of Windows-based CAM tools, including a feature 
rich and robust GerberlNC editor for ensuring a seamless link between PCB design 
and manufacturing. GerbTool is designed to provide CAD/CAM professionals with 
the tools they need for complete control over their CAM databases. From visual 
verification to high-level CAM tools, GerbTool simplifies and automates your PCB 
layout post processing and pre-manufacturing tasks. 

GerbTool's consistent and intuitive graphical user interface, and programmable 
mouse buttons and function keys, allow you to focus on accomplishing tasks, rather 
than on the technical details of operating the software. 

Using this manual 

This manual was designed to assist you in using GerbTool's features. Chapter 3: 
Quick start is especially geared toward providing the information you need to 
become immediately productive. A prior knowledge of CAD/CAM concepts and 
your computer's operating system is assumed. 
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Chapter 1 Introduction 

GerbTool features 
• Fast and easy to use. 

• Unlimited file sizes. 

• Accurate to 11100 mil (.00001 in.). 

• Fully automatic panelization and venting. 

• Complete undo to beginning of session. 

• Full design rule checking (DRC), including annular ring checking and stub 
detection. 

• Snoman ™ pad/trace filleting. 

• Teardrop pads. 

• NC drill optimizing, including step and repeat. 

• Isolated pad removal. 

• Automatic removal of silkscreen data from pads. 

• Full support for true multilayer netlists, including net highlighting. 

• Scalable check plots to HPGL, PostScript®, Laser printers, and all 
printers/plotters supported by Windows. 

• Conversion of drawn pads to flashes. 

• Macro language allows the addition of new commands. 

• Metric and Imperial formats supported. 

• Photo plotter support includes extended Gerber, FIRE9xxx, EIE, BARCO DPF 
and IPC-D-350. 

• Accurate display of power and ground plane composites. 

• Allows aperture scaling to create soldermasks, shrink/expand traces, and so on. 

• Ability to scale layers to shrink or expand the database .. 

• Merge a complete design or a single Gerber file into another. 

• Import NC Drill, HPGL, or BARCO files. 

• View up to 999 layers simultaneously. 

• Handles over 4000 apertures in up to 999 aperture lists. 

• Aperture list conversion tools allow the addition of custom aperture list 
converters. 

• Easily created custom apertures and custom fonts. 
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Chapter 2 

Configuratoon 

Color list file 

Unlike previous releases of GerbTool, this version does not require that you create a 
configuration file. Instead, use the Configure command from the Options menu. 

When starting up, GerbToollooks for a color list file named COLOR.RGB. Once 
the color list file is found, GerbTool reads the available colors from a red-green-blue 
(RGB) color and name pair list, then reads a list of the currently chosen colors. The 
currently chosen colors are those presented whenever you select colors from within 
GerbTool (for example, flash and draw colors): 

# maximum 1024 colors available ... 
[RGB Color/Name pairs] 
128 0 0 vga16red 

o 128 128 
o 128 0 

245 245 245 

255 250 240 
253 245 230 
250 240 230 
250 235 215 

vga16cyan 
vga16green 
WhiteSmoke 

FloralWhite 
OldLace 
linen 
AntiqueWhite 

# maximum 32 current choice colors ... 
[Choice Colors] 
blue 
vga16green 
white 
black 
coral 

SteelBlue 
SaddleBrown 
DarkSalmon 
DarkOrange 
DeepPink 

Sample color list. 

OrCAD Layout for Windows Gerb Tool User's Guide 3 





Chapter 3 

Quick start 

In order to help you get started quickly, this chapter provides a quick overview of 
GerbTool and its processes. A more comprehensive description for each GerbTool 
function is provided in chapters 4 through 8. 

Starting GerbTool 

To start GerbTool, choose GerbTool from the Tools menu in the OrCAD Layout for 
Windows session frame. 

Creating a new aperture list 

GerbTool's most basic function is to read a Gerber file into memory and display it 
graphically on your screen. An aperture list file describes the shape and size of all 
the apertures used in the Gerber file. GerbTool automatically reads aperture list files 
from Layout. 

Fb Note Aperture list files are not required for extended Gerber, FIRE9000 or EIB 
format Gerber files as they are embedded in the Gerber file. 

You can also create your own aperture list files. There are two ways to do this. The 
easiest method is to convert your CAD aperture list into GerbTool format. 
Therefore, if you have an aperture list that is in a format listed in the table on the 
next page, you simply specify this as your aperture list and GerbTool automatically 
converts it for you. 

Fb Note You do not need to convert aperture list files created by Layout (or by 
OrCAD PCB 386+). 

If, on the other hand, you do not have a CAD aperture list, you can enter a new, non
existing filename when you specify an aperture list and let GerbTool create it for 
you. Although it will initially be empty, GerbTool creates new apertures as needed 
when reading in your Gerber file. You can then edit the aperture list, changing the 
shapes and sizes to meet the needs of your Gerber file. 
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Chapter 3 Quick start 

Converting a CAD aperture list 

GerbTool provides aperture list conversion for most of the CAD and photoplotter 
aperture list formats in use today. The conversion process translates a CAD aperture 
list directly into GerbTool format, thereby reducing data-entry-related problems. 
Again, remember that you do not need to convert aperture files created by Layout. 
The following table shows the aperture list formats supported by GerbTool, along 
with the name of the Aperture Conversion Rule (ACR) file used for the conversion. 

Aperture list format GerbTool ACR file 

ALLEGRO ALLEGRO.ACR 

CADSTAR CADSTAR.ACR 

CADSTAR2 CADSTAR2.ACR 

CONSULTEK CONSULTK.ACR 

CSI CSI.ACR 

CSIV4 CSI4.ACR 

CSI Report CSIRPT.ACR 

DC-CAD DC-CAD.ACR 

DC-CAD 2 DC-CAD2.ACR 

EAGLE EAGLE.ACR 

EDT EDT.ACR 

EDT 2 EDT2.ACR 

EE Designer EED.ACR 

GraphiCode Report GCREP.ACR 

GerbTool Report GTREP.ACR 

HIWIRE HIWIRE.ACR 

IVEX IVEX.ACR 

Lavenir Report LA VINER.ACR 

Lavenir View VIEW.ACR 

MAS STECK MASSTEK.ACR 

OrCAD Layout (up to v6.42) MASSTEK.ACR 

McCAD MCCAD.ACR 

Supported aperture list formats (page 1 of 2). 
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Chapter 3 Quick start 

Aperture list format GerbTool ACR file 

MENTOR MENTOR.ACR 

OrCAD PCB II ORCAD.ACR 

PADS PADS.ACR 

P-CAD PCAD.ACR 

P-CADV6 PCAD6.ACR 

P-CADV7N8 PCAD78.ACR 

P-CAD Report PCADRPT.ACR 

PRANCE PRANCE.ACR 

PRANCE 2 PRANCE2.ACR 

PROTEL 1.0 PROTEL.ACR 

PROTEL for Windows PFW.ACR 

SCICARDS2 SCICARD2.ACR 

SCICARDS SCICARDS.ACR 

TANGO TANGO.ACR 

ULTIBOARD UL TIBRD.ACR 

UNICAD UNICAD.ACR 

VALID VALID.ACR 

Supported aperture list formats (page 2 of 2). 

When creating a design, specify your aperture list normally. GerbTool converts it to 
the proper format automatically. Or you may select the Convert command from the 
Apertures menu and convert it prior to loading it into GerbTool. 
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Chapter 3 Quick start 

To convert a supported aperture list to GerbTool format, select the Convert 
command from the Apertures menu, specify an input filename, then select the 
appropriate converter in the Convert Aperture Lists dialog box. 

Convert Aperture Lists dialog box. 

WI See also For more information about converting aperture lists, see Chapter 7: 
Command reference. 

Creating a new design 

To create a new design, choose either Auto or Manual mode after you choose New 
from the File menu. 

To create a design file automatically 

1 From the File menu, choose New. GerbTool displays the Create New Design 
Wizard dialog box. 

2 Enter a name for the new design in the Design Name text box, and specify a 
directory in which to create the design in the Design Folder text box, then 
choose the Next button. GerbTool displays the next dialog box in the Create 
New Design Wizard. 

3 Choose Automatic, then choose the Next button. GerbTool displays the next 
dialog box in the Create New Design Wizard. 

4 Specify the path to the directory that contains the Aperture list files for the new 
design in the text box, then choose the Next button. GerbTool displays a dialog 
box informing you that the design has been created. 

5 Choose the Finish button. GerbTool displays the Edit dialog box and includes a 
list of all the layers found in the directory. 

6 If you are using Gerber 274-D format, enter an aperture list for each layer by 
selecting that layer from the list, then entering the aperture list file (* .APP) in 
the Aperture List field. 

7 Choose the Edit button. GerbTool displays the Gerber format dialog box. 

8 Select the appropriate format, m.n setting, and zero suppression, then choose the 
OK button. GerbTool returns you to the Edit dialog box. 

9 Choose the OK button. GerbTool creates the new design according to your 
specifications. 
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Chapter 3 Quick start 

To create a design file manually 

In order to create a design file manually in GerbTool, the layers and aperture lists 
must be in standard Gerber 274D format. 

1 From the File menu, choose New. GerbTool displays the Create New Design 
Wizard dialog box. 

2 Enter a name for the new design in the Design Name text box, and specify a 
directory in which to create the design in the Design Folder text box, then 
choose the Finish button. GerbTool displays the Edit dialog box and includes a 
list of all the layers found in the directory. 

3 Enter a set of layers, and an aperture list for each layer in the appropriate fields. 

4 Choose the Edit button. GerbTool displays the Gerber format dialog box. 

5 Select the appropriate format, m.n setting, and zero suppression, then choose the 
OK button. 

6 Choose the OK button. GerbTool creates the new design according to your 
specifications. 

Whether creating design files automatically or manually, GerbTool creates a design 
file named UNTITLED.GTD in the current directory. You can use the Save 
command on the File menu to save your design file under a different name. 

Opening an existing design 

Follow these steps to open an existing design. 

To open an existing design 

1 From the File menu, choose the Open command. GerbTool displays the Open 
Design dialog box. 

2 Locate and select the design you want to open, then choose the OK button. 
GerbTool displays the Edit dialog box. 

3 If necessary, make any modifications, the choose the OK button. GerbTool 
loads the appropriate files. 

Fb Note Layout automatically generates a design file when post-processing 
(*.GTD). 
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Chapter 3 Quick start 

Saving a modified layer 

If a layer has been modified or changed, you are given an opportunity to save it 
when you select the Save, Save As, or Save All command from the File menu. 

RJ Note When GerbTool displays a list of files to save, you must select each file you 
want to save. Only those files selected are saved. 

Exiting GerbTool 

To exit GerbTool, choose the Exit command from the File menu. If any layers have 
been modified, GerbTool requests confirmation that you really want to exit. 
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Chapter 4 

GerbTool basics 

This chapter provides infonnation on GerbTool basics. 

GerbTool window 

Pane Divider 

Coordinale display 

Layer ColorNisibility 

Tool bars 

Drawing Area 

Pane Divider 

Prompt area Status Bar 

The GerbTool window consists of the following componflnts: 

• Main menu bar where you can "pull down" the command menus. 

• Toolbars where you can choose commands with a single click. 

• Settings control bar where you control various program settings, such as metric 
display mode and grid snap. 

• Color toolbars where you can change layer colors and visibility. 

• Birdseye view that shows the current view window relative the extents of the 
loaded database. 

• Adjustable pane dividers to split the drawing area into multiple views. 

• Drawing area where GerbTool displays all database items. 

• Crosshair cursor indicating the position of the mouse within the drawing area. 

• Film box graphic that indicates the size of the current film box. 

• Status bar with prompt area where GerbTool displays command messages. 

• Tool tips on most window features including toolbar buttons, control bar 
buttons and menu items. 
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Chapter 4 GerbTool basics 

Too/bars 

Settings bar 

Each icon within a toolbar represents a shortcut to a command. When you click on 
an icon in the toolbar, GerbTool executes the command associated with that icon .. 

Use the settings bar to quickly and easily control various options with a single 
mouse click. This section describes each button on the settings bar. 

Sketch 

This button toggles sketch mode on or off. When sketch mode is on, pads appear 
with an outline only, and traces appear as a single thin line. Besides speeding up 
redraw times, this mode can also help you spot stacked pads. 

Overlay 

This button toggles overlay mode on or off. When overlay mode is on, items become 
transparent when drawn on top of each other. When overlay mode is off, items 
obscure whatever is drawn previously. Overlay mode makes it easier to spot stacked 
pads. 

View Composites 

This button toggles the way GerbTool displays composite layers (extended Gerber 
and FIRExxxx only). When View Composites is on, the polarity of each layer, 
specified by the Polarity field within the Edit dialog box (from the Edit command on 
the Layers menu), is honored. If a layer is specified "Clear," all data in that layer 
appears with the current background color. 

ORC Errors iBt 
This button toggles the display of rule violation errors on or off. IfDRC errors exist 
and this setting is on, GerbTool displays the DRC View Errors dialog box. 

WI See For information on error reportIng, see the DRC section in Chapter 7: 
Command reference. 
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Chapter 4 GerbTool basics 

This button toggles the system grid display on or off. 

W See For information on grids, see the Grid section in Chapter 7: Command 
reference. 

Grid Snap .. "t:1 
This button toggles grid snap mode on or off. When grid snap mode is on, the 
crosshair cursor automatically jumps to the nearest grid point. 

W See For information on grid snapping. see the Grid Snapping section in Chapter 
7: Command reference. 

Orthogonal Snap ':~I 
Use this button to toggle orthogonal snap mode on or off. When on, lines drawn 
interactively are forced to the specified angle. 

R:J Note The current setting can be temporarily overridden by holding down the 
CTRL key. 

Arcs 360o~n~1 
This button toggles the method of creating arcs used by the Arc and Circle 
commands (on the Add menu). If on all arcs are created using 3600 circular 
interpolation. If off, all arcs are created using arcs of 90 or fewer degrees. This does 
not affect the way Gerber data is read from a disk file. It only pertains to adding new 
arcs with the Arc command (on the Add menu) and the Circle command (on the Edit 
menu). 

~ 
.... 

'M& Metric" 

This button toggles metric mode on or off. When metric mode is enabled, GerbTool 
shows all information and editing fields that represent sizes and distances (for 
example, coordinates) in metric format. 

DrCAD Layout for Windows Gerb Tool User's Guide 13 



Chapter 4 GerbTool basics 

Active layerlD-code 

You can dock the active layerlD-code control bar or allow it to "float" in a dialog 
box. Use this control bar to control the currently active layer and D-code. To change 
the active layer or D-code, simply use the drop-down list to select a different layer 
or D-code. 

Coordinate display 

You can dock the coordinate display control bar or allow it to "float" in a dialog 
box. It shows at a glance the current location of the crosshair cursor. The format of 
the display is controlled by the current setting of the Me button within the Settings 
bar or the Metric command on the Options menu and the file format of the active 
layer. 

Color chooser bar 

Birdseye view 

You can dock the color chooser bar or allow it to "float" in a dialog box. It is 
available at all times to change layer colors and visibility. When a layer is on, 
indicated by a red box around the layer number, it is both visible and editable. When 
a layer is off it is neither visible nor editable. When a layer is ref, indicated by a 
black box around the layer number, it is visible but not editable. 

You can dock the birdseye view or allow it to "float" in a dialog box. The black 
rectangle represents the database extents while the red rectangle represents the 
current viewing window. Use it to determine at a glance exactly where your current 
view window is located. 

Split screen pane dividers 

Drawing area 

Crosshair cursor 

By adjusting the pane dividers, you can split the drawing area into up to four 
separate viewing windows. Each window represents a different view of your design. 
You can view and edit your data at multiple zoom levels or locations 
simultaneously. 

The drawing area is the area between the menu bar and the status bar. All database 
items are displayed here. 

While the mouse position is within the drawing area, GerbTool displays the cursor 
as a crosshair. The exact location of the crosshair cursor appears in the Coordinate 
Display toolbar described above. 

14 OreAD Layout for Windows GerbTool User's Guide 



Film box 

Status bar 

Tool tips 

Chapter 4 GerbTool basics 

The film box represents the size of the film on which you will plot, and is a graphic 
display only. It does not become part of your Gerber database(s). 

~ Tip You can control the size and color of the film box using the Options menu's 
Configure command, described in Chapter 7: Command reference. 

GerbTool displays command status and prompts in this area. 

When you hold the mouse cursor over a window feature for a few seconds, a small 
popup window appears with a short description of the feature. 

Design files 

GerbTool uses design files. A design file, as created by GerbTool (or Layout), 
contains information about the Gerber files, and their associated aperture list files, 
that constitute a single PCB. This usually includes filenames for inner and outer 
signal layers, silkscreen layers, soldermask layers, and so on. GerbTool also 
associates an operating environment with each design file. Thus, when you load an 
existing design file, GerbTool restores the environment to the state it was when you 
last saved the design file. This eliminates the need to continually reconfigure 
GerbTool each time you load a design. 

Fb Note The default file extension for design files is configurable and is easily 
changed using the Configure command on the Options menu. Layout uses a .GTD 
extension for these files. 

Aperture list files 

Aperture list files define the characteristics of each Gerber D-Code used in a design. 
For each D-Code the aperture list file defines a shape, size, type, and NC drill tool 
number (see Chapter 7: Command reference). GerbTool stores aperture lists in 
ASCII format. This makes it easy to create and modify aperture lists. It also allows 
easy conversion from most CAD system aperture lists. 

m See For details of the aperture list format, along with an example aperture list, 
see Appendix C: Aperture list file format. 

Fb Note The default file extension for aperture list files is configurable. You can 
change it using the Configure command on the Options menu. Layout uses a .APP 
extension for aperture list files it creates. 

DrCAD Layout for Windows Gerb Tool User's Guide 15 



Chapter 4 GerbTool basics 

Using GerbTool commands 

This section describes the different ways to use GerbTool commands. 

Mouse-button and function-key commands 

GerbTool comes pre-configured with the following mouse button and function key 
assignments. 

Key Assignment 

Left mouse button View Window 

Middle mouse button Zoom In 

Right mouse button None 

Fl Redraw 

F2 View Film Box 

F3 View Previous 

F4 View All 

F5 Layers Edit 

F6 Aperture Edit 

F7 Aperture Report 

F8 Query Highlight 

F9 Query Item 

FlO Measure End to End 

FII Add 

Fl2 Remove 

The assigned mouse and function key commands are available any time GerbTool is 
idle (for example, there is no command prompt in the prompt area). 
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Shortcut Keys 

Chapter 4 GerbTool basics 

Shortcut keys are available anytime GerbTool is idle, or when GerbTool prompts 
you to enter a point. Below is a list of the shortcut keys. GerbTool execute shortcut 
keys immediately without affecting the current command. 

Key 

ENTER 

HOME 

PGUP 

PGDN 

LEFT ARROW 

RIGHT ARROW 

UPARROW 

DOWN ARROW 

+OrI 

- oro 

0-9 

CTRL+0-9 

A 

CTRL+A 

B 

C 

CTRL+C 

D 

CTRL+D 

CTRL+F 

CTRL+G 

H 

Shortcut Keys (page 1 of 2). 

Action 

Enter coordinate at cursor location 

Snap cursor to center of item 

Zoom In 

Zoom Out 

Scroll page left 

Scroll page right 

Scroll page up 

Scroll page down 

Zoom In 

Zoom Out 

Bring a layer to the top (1-10) 

Bring a layer to the top (11-20) 

Tum on all layers 

Turn off all but active layer 

Pop-up floating color box 

Enter absolute coordinates 

Enter relative coordinates 

Increment current D-code 

Decrement current D-code 

Edit configuration flags 

Edit system grid 

Toggle highlights on or off 
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Key 

L 

CTRL+L 

M 

CTRL+M 

P 

CTRL+P 

CTRL+ALT+Q 

R 

CTRL+R 

S 

CTRL+S 

U 

CTRL+U 

v 

CTRL+V 

1-9,0 

CTRL+[1-9,O] 

Shortcut Keys (page 2 of 2). 

Interrupting a drawing process 

Action 

Increment active layer 

Decrement active layer 

Run macro 

Toggle metric mode 

Pan 

Toggle auto pan mode 

Quit immediately without confIrmation 

Redraw 

View All 

Toggle grid snap 

Screen print 

Undo last edit 

Undo all edits 

Toggle composite viewing 

Toggle virtual panel mode 

Bring a layer to the top (1-10) 

Bring a layer to the top (11-20) 

Anytime GerbTool redraws the display or highlights a window of data, you can halt 
the drawing process by pressing the ESC key or clicking the right mouse button. This 
does not affect the operation of the command and in many cases speeds up its 
operation. 

Ending a command 

You can end a command, or end at least one level of a multistep command, by 
pressing the ESC key or right mouse button. 
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Chapter 5 

Performance tips 

This chapter provides tips for obtaining optimal performance from GerbTool. 

Speeding up GerbTool operations 

Using shortcut keys 

Shortcut keys are a powerful feature of GerbTool. These keys are available any time 
GerbTool is waiting for you to enter a coordinate (point) or whenever it is idle (that 
is, when no command has been selected). Using these keys you can snap to the 
center of a database item, change which layers are viewed, undo edits, and so on. 

!Wi See For a complete list of available shortcut keys, see Chapter 4: GerbTool 
basics. 

Interrupting, redrawing, and highlighting 

Undoing edits 

You can speed up any command that redraws the database or highlights a group of 
items by canceling the drawing process. Click the right button or press the ESC key 
to halt the redraw. This doesn't affect the operation of the command; it affects only 
the redraw. Once you're comfortable with the operation of GerbTool commands you 
will fmd that this ability significantly speeds things up. 

The Undo command provides a high level of freedom when making database edits. 
You can experiment and try different edits without fear of data loss. Since undo is 
available as the shortcut key u, you can undo edits immediately without having to 
exit the current command. Undo works for all edits regardless of size, and there is no 
limit to the number of edits you can undo. Remember to enable the undo capability 
with the Configure command (Options menu) before making your edits, then use the 
Edit menu's Undo command or the shortcut key U to undo as necessary. 
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Programming mouse buttons and function keys 

GerbTool's easy-to-use graphical user interface is further enhanced with the 
versatility of programmable mouse buttons and function keys. Using the Configure 
command on the Options menu, you can program the mouse button and function 
keys Fl through F12 with commands that you frequently use. 
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Chapter 6 

Uses for GerbTool 

This chapter provides several examples of uses for GerbTool. 

Layer alignment 

Layer alignment involves lining up all layers so that when you view multiple layers 
simultaneously, they are correctly aligned. Proper layer alignment is also crucial to 
the successful creation of a multilayer netlist. 

First select a master layer with which all other layers should be aligned and select an 
item on that layer to use as a reference point. Choose the Align command from the 
Edit menu and select the item you chose as a reference point. Then, select an item on 
each layer to be aligned that corresponds to the reference point. As you select each 
item, GerbTool aligns the host layer. 

~ Tip You can use the shortcut zoom in, zoom out, and pan keys (see Chapter 4: 
GerbTooZ basics) to locate the reference and corresponding items. 

OrCAD Layout for Windows GerbToo/ User's Guide 21 



Chapter 6 Uses for GerbTool 

Creating NC drill files 

Use the Drill command on the Tools menu to create an NC Drill file from any layer. 
Choose the format for the drill file by choosing the NC Format button within the 
Drill editing dialog box (shown in Chapter 7: Command reference). Usually, the 
layer you choose to create a drill file from represents the pad master for the entire 
design. When creating NC Drill files, GerbTool translates the Gerber flashes (except 
targets and thermals) into drill "hits." The Tool field, in the corresponding aperture 
list for the selected layer, determines the tool call-out for each drill hit. 

Fb Note Use the Report command from the Apertures menu to determine if you 
have a tool assigned to each flash. Edit the aperture list if,required so all flashes are 
assigned a tool. 

GerbTool then optimizes the drill hits, according to your specifications, for fastest 
through-put. 

Perform panelization prior to executing the Tools menu's Drill command. If your 
drilling equipment has a small memory capacity, perform a "virtual" panelization. 
This allows GerbTool to insert the needed step and repeat codes into the output drill 
file. Preferably, if your drilling equipment has enough memory, you should perform 
a normal non-virtual panelization. This results in a fully optimized panel for the 
maximum drilling efficiency. 

Importing drill files 

Use the Drill command from the Import menu to load an NC Drill file into the active 
layer. Layout creates a drill file, THRUHOLE.TAP, that you can import in order to 
automatically include the drill information for your design. 

You can also create a new empty layer first by selecting the Create command from 
the Layers menu. Make sure that the layer you choose is the active layer. 

When loading a NC drill file, GerbTool converts the drill hits into Gerber flashes. 
Each tool called out in the drill file is located in the aperture list for the active layer. 
If GerbTool can't find a tool, it adds an aperture to the list with an "Unknown" 
shape and the correct tool assignment. You can then edit the aperture to correct the 
shape, size, and so on. 

Fb Note Use the Report command (from the Apertures menu) to determine if any 
apertures were added. Those added are highlighted. 
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Panelizing 

Chapter 6 Uses for GerbTool 

With GerbTool, panelizing is a simple, one-step process when using the Auto Panel 
feature. After activating the layers to be panelized (only), select the Panelize 
command from the Tools menu, ensure that the Auto Panel button is selected (shown 
in Chapter 7: Command reference), and enter the minimum image border-to-border 
spacing in the X and y fields. The spacing you specify should be between adjoining 
edges of the intended images. GerbTool automatically calculates the maximum 
number of images that will fit inside the current film box. After asking for 
confirmation, GerbTool completes the panelization process. Depending on the 
setting of the Virtual button, GerbTool either copies the proper number of images 
into the database or notes the number of copies and their location for display 
purposes. 

R:J Note You can use the right mouse button or press the ESC key to stop the drawing 
process anytime during the panelizing process. This usually provides a noticeable 
improvement in the overall time to complete the panelizing process without 
affecting the fmished panel in any way. 

Viewing or printing Gerber 274·0 composite layers 

You can use black and white for layer colors, to provide accurate viewing of 
composite power and ground layers. Setting the negative layer to white on a black 
background and the positive layers to black results in a realistic depiction of the 
final film. 

R:J Note Since the negative layer must be displayed first, it is important that the 
negative layer be before the positive layers . 

To print a composite layer, view your composite layers as described above, then use 
the Print command (from the File menu). The printed image appears on the page 
exactly as it does in the display. 

R:J Note Since the image for printing is created in a high resolution off screen 
bitmap, the film box and display grid may appear on the output page. You can 
disable this by setting the film box color to the background color using the Film box 
command (Options menu) and disabling the display of the grid using the Grid 
command (Options menu), or shortcut key G. 
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Merging designs 

You can merge two or more designs into a single Gerber file so they can be 
photoplotted simultaneously. This reduces manufacturing costs by making full use 
of photo plot film. 

In order to merge designs in this manner, the following conditions must exist: 

• Each file must be in the same Gerber format and have the same m.n values, and 
zero suppression. 

m See For information on Gerber formats, see the discussion of the File menu's 
Format command in Chapter 7: Command reference. 

• Each file must use the same aperture list. That is, the size and shape of each D
code must be the same in each aperture list. 

• The respective layers in each design must be the same. For example, layer I of 
each design must be silkscreen, layer 2 of each design must be the top layer, and 
soon. 

To merge design files 

1 From the File menu choose the Open command and select the .GTD file for the 
first design. GerbTool displays a list of layers in the Layers-Edit dialog box. 

2 Choose the OK button. GerbTool displays the design at coordinates 0:0 in the 

lower left of the Film Box. 

3 From the Edit menu, choose the Scale command. The Scale and/or Offset 
Layers dialog box appears. Choose the desired offset value. 

4 Select All Visible from the Layers drop down list. 

S Choose the OK button. GerbTool responds with an error message: "Command 
cannot be undone. Continue?" 

6 Choose Yes. This shifts the first design. 

7 From the File menu, choose Merge and then choose Design. In the Merge 
Design dialog box, choose the second design. The second file appears in the 
film box. 

RJ Note OrCAD recommends that you merge only Gerber 274-D files. 
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Drawn pads 

Chapter 6 Uses for GerbTool 

Occasionally, CAD systems may output an irregularly shaped or sized pad using 
multiple draws to "fill in" the shape, rather than a more efficient single flash. This 
results in larger Gerber files than necessary and increases processing times. Also, it 
is virtually impossible for high-level CAM tools such as DRC to recognize the 
drawn pads as pads rather than as collections of traces. The difference between a 
typical drawn pad and a comparable flash is shown below. 

Drawn pad Flash 

Drawn pad versus a flash. 

The drawn pad in this example requires 27 separate Gerber commands to accompiish 
what one Gerber flash can accomplish. Thus, if you have 2000 of these drawn 
flashes, you'll have a Gerber file with at least 54,000 lines when flashes could 
accomplish the same thing in only 2000 flashes. 

Using the Pads command from the Convert menu, you can convert all your drawn 
pads to flashes. You do this by identifying one occurrence of a drawn pad and 
allowing GerbTool to find all drawn pads that match. And, to increase GerbTool's 
ability to recognize matching drawn pads, you can specify a tolerance value to 
compensate for some CAD systems' round-off errors. By specifying a tolerance, you 
allow GerbTool to relax its criteria for determining matching drawn pads. 

~ Tip Converting drawn pads to flashes should be the first thing you do to your 
designs. This usually ensures trouble-free conversion. Also, you must convert all 
drawn pads to flashes before generating a netlist or running most other CAM tools. 

Automatic silkscreen clean-up 

GerbTool has the ability to automatically clean up a silkscreen where lines touch or 
are too close to the pads. Using the Fix Silkscreen command from the Tools menu, 
you specify the layer(s) that the silkscreen and pad master are on and the minimum 
spacing that must be maintained between the silkscreen data and the pads. If you 
want, you can use window mode to clean up isolated areas rather than the entire 
silkscreen layer. GerbTool then cleans up all areas where silkscreen lines are too 
close to a pad. Each offending line is moved just enough to eliminate the violation. 

W See also For more information on silkscreen cleanup, and to see before and after 
illustrations, see Chapter 7: Command reference. 
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Creating a soldermask layer 

Transcoding 

Creating a soldermask is a simple and easy process using the Scale command, from 
the D-Code selection on the Edit menu. 

First, create the soldermask layer by copying the pad master layer onto a new layer. 
Use the Copy command to copy the pad master to the new layer. When copying, 
select Create Layer from the Copy to Layer fields drop-down list. This creates a new 
layer for the new soldermask data. 

Now, select the Scale command, enter a scale factor for X and Y and select the 
Fixed Amount field in the D-Code Scale dialog box, then choose the OK button. 
GerbTool adds apertures to the corresponding aperture lists as necessary and 
replaces the D-codes with the new scaled D-codes. The original D-codes within the 
aperture lists are not modified. 

Using the Transcode command (from the D-Code selection on the Edit menu), you 
can transcode (transform D-Code) item by item or by selecting a group. Using 
selection criteria, you can choose exactly which D-Codes are transcoded. For 
example, to transcode only draws with a D-Code of D 18 on layer 4 and within a 
particular window, specify the selection criteria as shown in the following example: 

Restrictive selection criteria. 

After selecting and highlighting the D-codes, GerbTool prompts you for the new D
code and then performs the actual transcoding. 
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Snoman pad and trace filleting 

Snoman is a highly configurable dialog box that specifies a method of optimizing 
pad/trace junction points. This is often referred to as filleting or teardropping (see 
Appendix D: Snoman concepts for a technical description of Snoman). The purpose 
of Snoman is to increase your manufacturing yield by adding more copper in the 
area of the pad/trace junction, thereby eliminating any possible pad/trace separation. 
Snoman is used primarily when dealing with small pads and traces (such as micro 
vias in the 30 mils or less range) but can be used anywhere to prevent pad/trace 
separation. Snoman provides additional versatility by allowing you control of the 
size and location of the generated Snoman pads, along with an integral DRC to 
eliminate any possible spacing violations. 

!Wi See For a complete description of how to use the Snoman tool, see Chapter 7: 
Command reference. 

© Trivia Snoman derives its unusual name from the appearance of a Snoman pad 
placed on top of a host pad, which resembles a "real" snowman. 
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Chapter 7 

Command reference 

File menu 

New fiQ.] 

This chapter provides details for using each GerbTool command. 

The File menu selection displays commands for dealing primarily with files and 
directories. The menu commands are described in the following sections. 

The New command presents the New Design Wizard as shown below. 

New Design Wizard 

There are two modes for the New command: Automatic and Manual. 

Automatic 

When you select Auto mode GerbTool builds a design file for you automatically. 
You specify the source folder and GerbTool determines which files are Gerber or 
aperture lists. The Gerber filenames are sorted first alphabetically and then by layer 
number if one is found. If an aperture list is found that it is not already in GerbTool 
format, GerbTool tries each configured aperture list converter until a match is found. 
Finally, each aperture list is matched to a suitable Gerber filename. GerbTool then 
displays the Edit dialog box where you can make any final adjustments if necessary. 

Fb Note This command is affected by the number of aperture converters configured 
and by the filename extensions that are ignored. In general, fewer aperture list 
converters and more ignored filename extensions result in faster performance. 

Manual 

When you select Manual mode GerbTool creates an empty design file for you, and 
then displays the Edit dialog box for you to enter the Gerber files and aperture lists. 
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Open 

Close 

Save 

Save As 

Save All 

This command displays the file chooser and prompts you for a design file to load. 
You can use a wildcard specification to obtain a list of files from which to choose. 
After you specify a design file to load, GerbTool displays the Edit dialog box where 
you can define or modify the layer structure and, if needed, define or change the 
Gerber input format specification. 

This command closes the current design. 

Select this command to save the current design file and optionally any modified 
layers or aperture lists. This command does not close the current design; you can 
continue to work on it after saving. You must use this command, Save As or Save 
All to save modified layer data. 

Select this command to save the current design file under a different filename and 
optionally any modified layers or aperture lists. This command does not Close the 
current design; you may continue to work on it after saving. 

Select this menu item to save the current design and all modified layers or aperture 
lists. This command does not close the current design; you may continue to work on 
it after saving. 
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Chapter 7 Command reference 

This menu selection has two commands: Gerber and Drill. When you select one of 
these commands, GerbTool displays a format dialog box from which you set the 
global formats for the file type in question. 

Fb Note GerbTool supports both global and local formats. Global formats apply to 
all layers that do not have a local format assigned to them. Use this command to 
edit of the global formats only. See the Layers menu's Edit command in Chapter 7: 
Command reference for more information on local formats. 

Gerber Format 

Typical format dialog box. 

You can specity the correct format for that type of file (in this example, Gerber) by 
editing a format dialog box. The illustration above shows a Gerber Format editing 
dialog box, which includes the following fields: 

Dialect Indicates the specific format of the Gerber language such as RS274D, 
extended Gerber, FIRE9xxx and EIB. Ifin doubt, choose RS274D. 

m.n Coordinate format such as 2.3. This specifies 2 decimal digits before an 
implied decimal point and 3 following. (for example, 12250 represents 12.250 if the 
coordinate format is 2.3). Because of limitations in the representation of arcs in 
Gerber format, it is best to use at least a 3.4 coordinate precision for designs that 
include arcs. 

Terminator Indicates the block terminator (EOB). Use \r to indicate a carriage 
return (ASCII 13) and \n to indicate a line feed (ASCII 10). 

Mode Choose Absolute or Incremental (see Glossary for descriptions of these 
terms). 
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Zero suppression Indicates whether leading zeros or trailing zeros are 
suppressed, or there is no zero suppression. 

"G" commands Indicates whether GerbTool includes "G" commands (for 
example, GO I) when you output Gerber files. 

Special You can enable Modal compression to reduce the size of your files by 
removing all redundant draft codes and coordinates. Or, you can enable Metric mode 
indicating that your files are in metric format. You can also specify whether all 
circular interpolated arcs should be considered 3600 or quadrant, enable the saving 
ofG04 comments, enable the output of User Data information, enable the output of 
Netlist information embedded within the Gerber file(s), and specify that carriage 
returns and line feeds should be honored as block terminators. 

You can toggle between metric and inch format, as well as change m.n formats after 
loading a design. If you change formats after loading, all layers are marked as 
modified. 

Caution If you change formats after loading and do not save all layers, the next 
time you load that design, the saved format may not match that of the unsaved 
Gerber files. 

Selecting the Netlist button tells GerbTool to save netlis,t information within the 
Gerber file. If you have"previously saved a Gerber file with netlist information, you 
can remove it by deselecting the Netlist button and saving. 

Fb Note It is important that you specify the correct format bf!(ore loading a new 
design. The critical format items are m.n, mode, and trailing zeros. If you load a 
design with an incorrect format, GerbTool will display it with unpredictable results. 
If you inadvertently load a design this way, reload the design and click on the 
Format button of the Edit dialog box to correct the format. 
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The Merge command has two modes: Design and Gerber. 

Fb Note All merge commands require that you ensure the critical format items 
(mode, m.n and zero suppression) of the file or files being merged match those of 
the currently loaded design. 

Design 

Selecting this command allows another complete design to be merged layer by layer 
into the current design. Ifa layer from the external design doesn't exist in the current 
design, you will be prompted to create a new layer. 

Gerber 

Use this command to merge a Gerber file into the currently active layer. GerbTool 
prompts you for a filename. You can use a wildcard specification to obtain a list of 
files from which to choose. The specified filename is not added to the list of loaded 
layers. Rather, the contents of the file are read in and appended to the active layer. 
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Import 

The Import command has a number of options: BARCO DPF, HPGL, IPC-D-356, 
and Drill. 

BARCO DPF 

Use this command to import one or more BARCO files into the currently loaded 
design. This command begins importing the specified files into the active layer if it 
is empty. If it is not empty, GerbTool creates a new layer following the active layer. 
GerbTool creates as many layers as necessary to import all the files you specify. 

RJ Note Once a BARCO DPF file is imported into a layer it effectively becomes 
Gerber data and will indeed be saved as Gerber if the layer is subsequently saved. 
To output the layer in BARCO DPF format use the BARCO DPF command from 
the Export menu. 

HPGL 

Use this command to merge an HPGL plot file into the currently active layer. After 
selecting a file to import, GerbTool displays the following HPGL import dialog box. 

HPGL Import dialog box. 

Using this dialog box, you can specify the expected plot size, whether to rotate the 
plot data and which D-codes to use for each HPGL pen. 
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IPC-D-356 

Use this command to import an IPC-D-356 netlist into your design. Since an IPC-D-
356 netlist contains information pertaining to pads and not traces, GerbTool must 
generate an internal netlist prior to importing an IPC-D-356 netlist, to ensure that 
your database contains a full and complete netlist after importing. While this may 
sound redundant, the added benefit of an "automatic netlist comparison" is well 
worth it. The netlist comparison feature produces a report file detailing any 
differences between the internal netlist and the imported netlist, in addition to 
highlighting any differences. Optionally, you can update the database UserData 
fields with the component/net data from the IPC-D-356 fily. Then, you can use 
GerbTool commands, including the Item Info command (on the Query menu), to 
examine and manipulate the true reference designators, pin numbers, and so on. 

Drill 

Use this command to import an NC Drill file into the active layer. 

!=b Note This command requires that you insure the critical format items (mode, m.n 
and trailing zero suppression) for the file, or files, being loaded match those of the 
currently specified drill format. 
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Export 

The Export command includes these format options: IPC-D-350, IPC-D-356, 
BARCO DPF, HPGL and PostScript. 

IPC-D-350 

GerbTool places designs exported to IPC-D-350 format into one file containing all 
layer data specified within the currently loaded design. The specified output file 
contains all data necessary to reproduce your design on any IPC-D-350 compatible 
. device. 

IPC-D-356 

GerbTool places designs exported to IPC-D-356 format into one file containing all 
layer data specified within the currently loaded design. The specified output file 
contains all netlist data associated with the current design. 

BARCO DPF 

GerbTool places designs exported to BARCO DPF format into a separate file for 
each layer. You select which layers to export and specify the output filenames. If 
you enable the Auto Rename button, GerbTool outputs all selected layers, renaming 
each layer automatically using the filename extension specified in the New 
Extention field. 
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HPGL 

When you select this command, GerbTool displays the HPGL Plot Parameters 
dialog box. 

HPGL Plol Paramelers 

HPGL Plot Parameters dialog box. 

Output File Specifies the output file that receives the HPGL plot data. 

Media Size Specifies the page size (in inches) for the plot. By default, GerbTool 
sets these values according to the Plot Size setting, but you can change them as 
desired. 

Offset Specifies the offset (in inches) from the edge of the paper. 

Scale Specifies the scale for the plot. A scale of" I" indicates a I: I 
correspondence between the plot and the design. A scale of "2" indicates a 2: I 
correspondence between the plot and the design, and so on. 

Border Pen Specifies the pen size used to draw the plot border (if any). 

Plot Size Specifies the plot size for the design. The Media Size field is initially 
set according to plot size. 

Mode GerbTool provides three modes of output when plotting on a HPGL 
compatible plotter: Sketch, Outline, and Fill. Sketch mode is the fastest but does not 
show width on draws and some flashes. Outline mode shows true width on all 
objects but they are outlined only. Fill mode shows true width, and all objects are 
completely filled in as they would appear on a photoplot. Fill mode is the slowest 
and is extremely hard on plotter pens. 

Add Border This option adds a border to your plots. 

Rotate This option specifies that GerbTool rotates the plot 90 degrees. 
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Interactive Mode Use Interactive mode to interactively position each layer on 
the output page. To position an image on the page, select the image (using the left 
mouse button) and then drag it to the proper location and release the mouse button. 
During interactive plot positioning, a menu of buttons is provided along with several 
plot-specific shortcut keys. 

Plot Spread -HPGL interactive control dialog box. 

The Plot button saves the page layout and plots the data. The OK button saves the 
page layout and quits the interactive session without plotting. Use the Reset button 
to reset the images to their initial positions for the session (if the dialog box has been 
pinned) or quit the interactive session without saving the page layout or plotting the 
data. 

Shortcut keys are available during an interactive plot session. These are: 

• C for absolute coordinate entry 

• I for page layout initialization 

• L to cycle the current layer forward 

• CTRL +L to cycle the current layer backward 

• s to snap (align) the current layer on top of another layer 

• R to redraw the page layout 

Fb Note There are two files within the GerbTool program directory that affect each 
HPGL plot. The files HPGL.INI and HPGL.DEI are prefixed and appended, 
respectively, to the plot output. If you have special requirements, you can edit these 
files as needed. 

Pads Only This option instructs GerbTool to plot only pad information in the 
plot file. 

Batch Mode This option instructs GerbTool to output each visible layer to a 
separate O1ltpllt file, During hatch mode operation, if the Output File field is empty, 
GerbTool derives the output filenames from the filename associated with each layer 
and the currently configured HPGL filename extension (as explained in the 
Configure command discussion, later in this chapter). If, on the other hand, the 
output file field contains a filename, GerbTool appends a number representing the 
number of the input layer (demo.OOI, demo.002, and so on). 
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PostScript 

GerbTool provides PostScript output, allowing you to plot your data on any device 
that supports PostScript. This includes typesetters capable of producing production 
quality artwork. 

PostScript Plot Parameters 

PostScript Plot Parameters dialog box. 

Output File Specifies the output file that receives the PostScript plot data. 

Scale Specifies the scale for the plot. A scale of" 1" indicates a I: I 
correspondence between the plot and the design. A scale of"2" indicates a 2:1 
correspondence between the plot and the design, and so on. 

Fit to page Specifies that the plot is automatically fitted to the page size. 

Media Size Specifies the page size (in inches) for the plot. By default, GerbTool 
sets these values according to the Plot Size setting, but you can change them as 
desired. 

Offset Specifies the offset (in inches) from the edge of the paper. 

Pads Only This option instructs GerbTool to plot only pad information in the 
plot file. 

Gray Scale This option tells GerbTool to produce accurate black and white 
composites as well as halftone images. When Gray Scale mode is disabled, all colors 
other than the background color are printed as black. When enabled, all colors (other 
than black/white) are converted to a different greyscale. 

Rotate This option specifies that GerbTool rotates the plot 90 degrees. 

Add Border This option adds a border to your plots. 
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Batch Mode This option instructs GerbTool to output each visible layer to a 
separate output file. During batch mode operation, if the Output File field is empty, 
GerbTool derives the output filenames from the filename associated with each layer 
and the currently configured Postscript filename extension (as explained in the 
Configure command discussion, later in this chapter). If, on the other hand, the· 
output file field contains a filename, GerbTool appends a number representing the 
number of the input layer (demo.OOI, demo.002, and so on). 

Mode GerbTool provides two modes of output for PostScript: Outline and Fill. 
Outline mode shows true width on all objects, but with outlines only. This allows 
you to check for overlapping features. Fill mode shows true width, and all objects 
are completely filled in as they would appear on a photoplot. Fill mode may produce 
a larger output file. 
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Use this command to configure how GerbTool will format each page printed by the 
Print command. 

Page Setup £1 

Page Setup dialog box. 

Scale Specifies the scale for the print. A scale of "1 " indicates a 1: 1 
correspondence between the print and the design. A scale of "2" indicates a 2:1 
correspondence between the print and the design, and so on. 

Overlap Indicates the amount of overlap for pages of a multi-page plot to allow 
proper alignment when taping the pages together. 

Add Border This option adds a border to your prints. 

Batch Mode This option instructs GerbTool to output each visible layer to a 
separate output file. During batch mode operation, if the Output File field is empty, 
GerbTool derives the output filenames from the filename associated with each layer 
and the currently configured Postscript filename extension (as explained in the 
Configure command discussion, later in this chapter). If, on the other hand, the 
output file field contains a filename, GerbTool appends a number representing the 
number of the input layer (demo.OO 1, demo.002, and so on). 

Color/Grey Scale If your printer is color-capable, this option tells GerbTool to 
produce a color print. Otherwise, (if your printer is not color-capable) GerbTool 
produces accurate black and white composites as well as halftone images. When this 
option is disabled, all colors other than the background color are printed as black. 
When enabled, all colors (other than black/white) are converted to a different 
greyscale. 

Fit to page Specifies that the plot is automatically fitted to the page size. 

Overlay Specifies that GerbTool prints a third color in areas where two 
differently colored objects are superimposed over each other. This option applies 
only if you have a color-capable printer. 
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Print 

Print Background Specifies that GerbTool prints the color for the design 
background. By default, this option is off. 

Fb Note Printing background colors uses a lot of ink (especially for C-, D-, or E
sized designs. Use this option with discretion. 

Sketch Specifies that GerbTool draws only the outlines for objects in the design, 
rather than filling in those objects. 

Window Specifies that GerbTool prints only that area of the design that falls 
within a user-defined window. 

Select this command when you want to print the viewed layers. Use this command 
to print your design on any printer/plotter supported by Windows. 

Print Preview 

Printer setup 

Exit 

Use this command to view how each page of your design would print before actual 
printing begins. 

Use the Printer Setup command to select and configure the current Windows default 
printer. 

Select this command when you want to exit GerbTool. The current design file can be 
saved, and you will be prompted to confirm that you want to quit if any layers have 
been modified. 
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The Edit menu includes these commands: Undo, Select, Item, Copy, Move, Delete, 
Clip, loin, Rotate, Mirror, Scale, D-Code, Align Layers, Origin, and Purge. 

You can modify the selection criteria for all editing commands that require you to 
modify one or more database items. GerbTool commands are flexible in the 
selection of data to modify. For example, you can select single items, or items within 
a window, group, or complete layer. 

Typical selection criteria. 

With this dialog box, you can control whether flashes, draws, arcs or any 
combination of all three are selected. Further, you can select whether a single item, 
window, group or layer is selected. In Window mode, you can select whether to 
include items that cross the window boundary. And finally, you can select whether 
to restrict the selection to a particular layer or D-code. 

You can end any editing command by choosing the right button, pressing the ESC 

key, or selecting another menu item. 

m See For details on using GerbTool shortcut keys, see Chapter 4: GerbTool 
basics. Shortcut keys are selected with one keystroke and operate immediately, 
even during another command. 
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Undo 
Use this command to 'undo' changes you've made to the currently loaded database. 
Undo information is saved in a 'last in - first out' fashion. This means that you 
'undo' changes in the reverse order in which the changes were made. This allows 
you to undo the most recent changes first. You may also use the shortcut key U to 
invoke the undo command even during another editing command. 

Fb Note Undo must be enabled with the Configure command (Options menu) prior 
to making any edits if you plan to use this command. 

Undo increases the amount of memory GerbTool requires. If you do not require the 
undo capability, you may disable undo with the Configure command (Options 
menu). Disabling undo will release any memory currently associated with undo 
information ~d prevent further undo memory use. 
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Most editing commands (such as Copy, Move, and so on) allow you to work with 
single items, windows of items or groups of items. The commands available in the 
Select menu allow you to manage the grouping of items for use by these editing 
commands. When a command allows group selection mode, it will use the currently 
selected group created and maintained by the different Select commands. Select 
groups are also persistent from one command to another. For example, if you rotate 
the current select group, the rotated data will remain selected ready for another 
command. 

The Select menu contains the following commands for controlling select groups: 

New Group !'?i:f]1 
Use this command to start a new group of selected items. When you choose this 
command, GerbTool prompts you for confirmation to clear the current select group 
(if any). This does not destroy any data. It simply deselects the current select group. 
If you respond affirmatively, GerbTool displays the Group Selection Criteria dialog 
box. 

Group Selection Criteria dialog box. 

Add To illl 
Use this command to select items and place them in the current select group. When 
you choose this command, GerbTool displays the Group Selection Criteria dialog 
box, from which you can choose those items you wish to add to the select group. 
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Remove From 

Use this command to select items and remove them from the current select group. 
When you choose this command, GerbTool displays the Group Selection Criteria 
dialog box, from which you can choose those items you wish to remove from the. 
select group. 

Invert 

Use this command to invert the current select group. That is, all currently selected 
items are deselected and all deselected items become selected. One use of this 
command is to allow you to quickly select all but a few items by first selecting the 
items you don't want and then inverting the select group. 

Use this command to clear the current select group and remove highlighting from 
any highlighted items. This does not destroy any data. It simply deselects the current 
select group. 
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This command displays a floating dialog box you can use to edit pertinent 
information associated with each database item. In addition, there are extensive 
controls for navigating from one item to another including the ability locate an item 
based on its sequential position in the database, D-code, X-Y coordinate, net and 
UserData value. You can also step forWard and backward one item at a time using 
the supplied directional buttons. Lastly, you can use the 'N' hot key to automatically 
advance to the next item in the database. 

Edit Item dialog box. 

The UserData field is of special note as you can use this field to attach textual 
information to individual database items. Any text you associate with your database 
will automatically be saved within your Gerber files the next time you save them. 
This also allows you to pass data to other groups in your organization transparently. 

An obvious use is to associate actual reference designators, pin numbers and net 
names with each pad thereby adding intelligence to your Gerber databases. Besides 
being able to see UserData using the Item command (Query menu), macros also 
have complete read/write access to each UserData field. This allows some powerful 
tools to be built upon GerbTool. 

Other than a 256 character size limit, there are no restrictions on text associated with 
a database item. 

Use this command to copy single items, windows, or groups of items. By specifying 
a valid destination layer in the Copy to Layer field, you can copy all selected items 
to that layer. 

Fb Note If you select data from more than one layer and copy to a destination layer, 
GerbTool merges all into the destination layer. If you do not choose a destination 
layer, GerbTool copies the data into the respective source layers. 
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Move 

r_ 
Delete l. 

Clip II 

You can use this command to move a single item, a window or groups of items. By 
specifying a valid destination layer in the Move to Layer field, you can move all 
selected items to that layer. As with the Copy command, if you select data from 
more than one layer, GerbTool merges all moved data into the destination layer. If 
you do not choose a destination layer, GerbTool moves the data into the respective 
source layers. 

Select this command when you want to delete items from one or more layers. You 
can delete vertices, single items, a window or groups of items. 

Fb Note If Undo is disabled, you will be prompted for confirmation when deleting 
items. 

Use this command to specify a window in which GerbTool deletes all data with 
automatic clipping of draws that pass through the window. If group mode is 
selected, GerbTool deletes only those items within the select group. 

Fb Note The On Boundary selection controls whether flashes that straddle a window 
boundary are deleted. 

48 DrCAD Layout for Windows Gerb Tool User's Guide 



Join 
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Mirror 
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Use this command to join two line segments using several different methods. 

Join Parameters dialog box. 

Using Normal mode, GerbTool extends or trims the two selected line segments as 
needed so that they connect. Naturally, this command will not work for parallel or 
near parallel lines. An option to Normal mode, Trim Second Line to First Only, 
helps when you have a long line in one direction and several lines intersecting the 
long line. With this option, GerbTool modifies only the second line you select. The 
remaining modes, Chamfer and Fillet, use the Size field to determine how far back 
to trim each of the two selected lines before adding the chamfer or fillet. 

Use this command when you need to rotate a window or group of items. You can 
select Window mode or Group mode. You can also supply a pivot point (interactive) 
or allow automatic calculation of the center of the data for the required pivot point. 

RJ Note If you enter a rotation factor of 90° or 270° and the Auto 90° button is 
selected, Rotate automatically compensates for asymmetrical pads, such as 
rectangles, by replacing the D-code with an equivalent D-code with opposite 
dimensions. You can add new D-codes to the appropriate aperture list. 

Use this command if you need to mirror (flip) a group of items either horizontally or 
vertically. You can specify the direction to mirror and whether to prompt for the 
pivot point or automatically calculate it. This command can also be used to flip a 
secondary side layer that was designed as seen from the primary side. 
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Scale 

O-code 

Use this command to apply coordinate offsets and scale to a loaded design. 

The offsets and scale are applied to the selected layers. By applying a scale factor it 
is possible to expand or shrink the size of your database. For example, if you design 
your boards at 2X you can set both the X and Y scale factor to 0.5 to convert your 
files to IX. 

Caution You cannot ''undo'' this command. Make sure you save any important 
edits before running this command. 

The D-code menu item includes these commands: Transcode, Expand, Scale, and 
Polarity. 

Transcode :11 
Use this command to change the D-Code of an individual item, window, group or 
complete layer. By changing the D-Code of an item, you can alter its size and shape. 
Another way to change the size and shape of an item is to edit the aperture list 
directly. 

Expand 

Use this command to expand one or all custom apertures in a design. This command 
is required to plot a design that contains custom apertures when your photoplotter is 
unable to create the apertures you need. 

When you choose this command, GerbTool asks you for the D-code you want to 
find. You may enter a specific D-code or you may enter zero to instruct GerbTool to 
expand all custom apertures. 

Scale 

Use this command to shrink or expand the size of one or more D-codes. One use of 
this command is to create soldermasks automatically. GerbTool adds new apertures 
to the corresponding aperture list as needed based on your specified scale factor. If 
the Fixed Amount check button is enabled, GerbTool adds the scale values to each 
D-code. Otherwise, each D-Code size is multiplied by the scale values specified. 
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Polarity r~ 
Use this command to control the item level polarity ofEIE and BARCO format files 
as well as FlRE9XXX raster fill polygons. When using item level polarity, the 
ordering of the data is crucial. You may find that you need to move data' in place' , 
thereby placing the 'moved' data at the end of the database. 

Fb Note Gerber RS274D does not support polarity at all. Extended Gerber files only 
support polarity at the layer level which is controlled using the Edit command from 
the Layers menu. FlRE9XXX format only supports raster fill polygons at the item 
level. Otherwise layer oriented polarity is assumed. 

Align Layers [~l 

Origin 

Purge 

Use this command to align any misaligned layers. First determine the layer to which 
all other layers should be aligned (the master layer) and select an item to use as a 
reference point. Then select an item, on each layer you want to aligned, that 
corresponds to the reference point. As you select each item, GerbTool automatically 
aligns the entire layer. 

Use this command to relocate the origin (0,0 point) of the database. GerbTool 
prompts you for a point to define the new origin. The film box is moved to the new 
origin. 

Fb Note This command causes GerbTool to mark all layers as modified. 

Use this command to compact the currently loaded database for more efficient use of 
memory. Since GerbTool doesn't actually remove data from memory during edits, 
memory may become fragmented and less efficient. Therefore, occasional purging 
can help GerbTool perform optimally. 

Fb Note Purging destroys any "undo" information that currently exists. Do not use 
this command unless you are sure you don't need to undo any previous edits. 
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View menu 

Window 

Zoom In 

Zoom out 

Pan 

All 

Film box 

The View menu includes commands to control viewing window location and size. 

Use this command to select a new viewing window. Two points are required to 
define a window. These points defme a rectangle that encompass the area that is to 
become the new viewing window. Use this command when you want precise control 
over the viewing window. 

This menu item halves the size of the current viewing window using a center point 
that you supply. This command provides a closer look at the displayed data. 

Doubles the size of the current viewing window using a center point you supply. Use 
this command to increase the size of the viewing window. 

Moves the current viewing window to a new location. The new location is centered 
about a point you supply. This command does not change the size of the viewing 
window. 

This command adjusts the size of the viewing window to encompass all of the 
currently displayed layer(s). If you have deleted data from any displayed layers, you 
may need to use the Extents command (Query menu) to calculate the current 
extremes of the database. 

Select this command to adjust the size of the viewing window to display the contents 
of the currently specified film box. This command does not check to see that all data 
lies within the film box borders. Therefore, depending on the film box size, not all 
data may be displayed. 
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Sketch ~ 

Il~1 
Overlay ~ 

Grid 
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This command redraws the current viewing window. 

This command toggles sketch mode viewing on and off. When sketch mode is 
enabled, pads are shown with an outline only, and traces are displayed as a single 
thin line. Besides speeding up redraw times considerably, this mode can also help 
you identify stacked pads. 

This command toggles overlay viewing mode on and off. When overlay mode is 
enabled, items become transparent when drawn atop each other. When disabled, 
items obscure whatever is drawn previously. Overlay mode makes it easier to spot 
stacked pads. 

This command toggles the grid display on and off. 

R:J Note Grid is also available as a shortcut key by pressing CTRL +G. 

Composites ··~~lJ 

Virtual Panel 

Clear Highlights 

Highlights 

Enables the correct viewing of composite layers. When this button is enabled the 
polarity of each layer, specified by the Polarity field within the Edit dialog box, will 
be honored. If a layer is specified 'Clear,' all data in that layer is displayed with the 
current background color. 

Virtual panel mode (and hence the display of virtual panels) may be toggled on and 
off using this command. You can also use the CTRL+V shortcut key. 

This command clears any and all highlights that currently exist. Use this command 
after a command such as Highlight (Query menu) or Drill (Tools menu). 

This command toggles the display of normal highlights on and off. Normal 
highlights are all highlights not indicating a select group or DRC error. 
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Selections 

Errors 

Save 

Recall 

Previous 

Toolbars 

Split 

This command toggles the display of select group highlighting. This does not change 
the actual select group. Only the highlight display is changed by this command. 

Use this command to view errors after performing a DRC. If DRC errors exist, the 
DRC View Errors dialog box appears. 

DRC View Errors. 

Use this command to save the current viewing window for later recall. There are 
eight positions available, 1-8, for saving. The current viewing window is saved in 
the position that you indicate. Use the Recall command (View menu) to recall any of 
the saved viewing windows. 

Use this command to recall a previously saved viewing window. If any of the eight 
possible positions does not have a viewing window associated with it, the 
corresponding positions in the menu are disabled. 

This command recalls the last viewing window. This allows you to toggle between 
two viewing locations. 

This selection presents a menu listing all of the available toolbars. You may toggle 
each toolbar on and off as desired. 

This command splits the drawing area into multiple panes. By dragging the pane 
dividers to the desired location you can have up to four separate viewing panes. 
Each pane may have a different zoom level and/or location allowing you to view and 
edit multiple views of your design simultaneously. 
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The Add menu includes commands you can use to enter various types of new 
database items. This menu includes the Flash, Draw, Rectangle, Vertex, Circle, Arc 
Ctr, Arc 3 Pt, Polygon, and Text commands. 

Note GerbTool creates all circles and arcs using circular interpolation or multiple 
line segments depending on the style indicated by the Configure command (Options 
menu). Use circular interpolation with care as not all photoplotters support circular 
interpolation. Segmented circles and arcs use the chord angle specified using the 
Configure command. 

Flash il;jl 
Use this command to add a flash to the active layer. GerbTool prompts for a point at 
which to add the flash. As you move the cursor about the screen an outline shape of 
the current D-code appears. Choose the left mouse button to add a flash at that 
location. 

Draw 

Use this command to draw line segments in the active layer. GerbTool prompts you 
for a starting point and subsequent points to form continuous traces. Choose the right 
mouse button or press the [Esc] key to start a new trace. 

Rectangle 

Use this command to draw line segments in the shape of a rectangle to the active 
layer. GerbTool prompts you for a starting comer point and an opposite comer point. 

Vertex i~l:;(l 
Use this command to add (and move by dragging the mouse) a vertex anywhere on 
an existing line segment. 

Circle 

Use this command to draw a circle by entering a center point and a point on the 
radius. The circle is drawn on the active layer, using the current D-code, in a 
counter-clockwise direction. 
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Arc Ctr 

Use this command to define an arc by entering a center point, a point defining the 
radius and starting angle, and a point defining the ending angle. The arc is drawn on 
the active layer, using the current D-code, in a counter-clockwise direction. 

Arc 3 Pt 

Use this command to define an arc by entering its end points and a point on the arc's 
circumference. The arc is drawn on the active layer, using the current D-code, in a 
counter-clockwise direction. 

Fb Note To create 90° arcs easily and quickly, press the '9' key. This automatically 
constructs a 90° degree arc. 

Polygon 

Use this command to select or enter a closed polygon. GerbTool fills or pours the 
interior of the polygon using either a raster fill or vector fill method. This command 
is commonly used to create ground plane areas. 

Fb Note Raster filling is not supported in RS274D format Gerber files. 

When entering a polygon you can automatically close the polygon by pressing the 
[End] key. You can also close the polygon manually by entering a point at the point 
which began the polygon. Regardless of the method, GerbTool then outlines the 
polygon with the current D-code, as displayed in the status bar, and fills the interior 
of the polygon. In Flood Fill mode, GerbTool fills the interior of the polygon with 
increasing aperture sizes. As it fills toward the center of the polygon the aperture 
sizes become larger. In Pour Around mode, GerbTool fills the interior of the 
polygon, as above, while maintaining clearance, as specified by the Draw Clearance 
and Flash Clearance fields, around all circuitry. 
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Polygon edit dialog box. 

Since you can generate many smaller polygons to effectively "pour" around the 
circuitry, you can use the Min Area parameter to specify the minimum size area. 
GerbTool eliminates any filled areas that would be smaller than the specified Min 
Area. 

The Pour Around option also supports three additional modes: Outline, Solid and 
Hatch mode. 

If you select Outline mode, GerbTool does not fill the resultant polygons. You can 
use this type of output to drive PCB prototyping equipment. 

If you select Solid mode, GerbTool completely fills the resultant polygons using the 
same methods described for the Fill command above. 

If you select Hatched mode, GerbTool fills the resultant polygons with a cross 
hatched pattern as specified in the Hatch Parameters section of the Edit dialog box. 
Up to three lines may be used with different sizes and angles for each line. 
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Text 

Use the Text command to insert text into the database as a sequence ofline 
segments. Therefore, you can control the line thickness of the inserted text by 
changing the current D-code. You can rotate or slant text. You can also specify the 
height and width of the text and the intercharacter and line spacing. GerbTool 
provides a text editing window where you can enter as many lines of text as needed. 
You have full editing and scrolling capabilities. You can even load and save text 
files. The Text command presents the Edit dialog box shown below: 

Opti~ization: X sort, Swath width 0.1 

Tool 
~ 

2 
3 

Size 
0.00000 
0.00000 
0.00000 

Count 
99 

526 
43 

--------------------------------------_. 

Text Parameters dialog box. 
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The Layers menu includes commands for managing the individual layers within 
your design. The menu selections include Edit, Colors, and Create. 

Use the Edit command to edit layers in your design with the Layers dialog box. The 
effects of editing certain fields within the dialog box differ, depending on whether 
you are loading a design or editing after loading. 

Within the Layers dialog box you specify: 

• The path used to locate the Gerber and aperture list files 

• Gerber files 

• Aperture list files 

• Layer names 

• Layer visibility 

• Flash/draw colors 

• Layer type 

• File format 

• Extended Gerber compositing instructions 
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Layers dialog box. 

While loading, edit the Path field to tell GerbTool where to find the specified files if 
they do not contain a path as part of the filename. Entering a wildcard specification 
(for example, *.GBR) in the Filename field displays the file chooser. You can 
choose more than one filename in which case all selected filenames are entered in 
one step. You can also enter a wildcard in an Aperture List field to obtain the file 
chooser. If you select a filename, GerbTool enters it in the current field. 

RJ Note You do not need to fill in the Aperture list field for each specified Gerber 
file. If an Aperture List field is left blank, it assumes the contents of the previous 
Aperture List field. If the Aperture List field for the first specified layer is blank 
then it assumes the currently configured default aperture list file. 

If you change the Path field after loading, GerbTool to marks all Gerber and aperture 
list files as modified. Then, you can save them in a location other than the location 
from which you loaded them. Changing the contents of a Filename field after a 
design is loaded causes that layer to be marked as modified. Then, you can save a 
layer under a new filename. If you enter a filename into a previously empty 
Filename field, GerbTool attempts to load the newly specified Gerber file. If it does 
not exist, you can create it. Changing the contents of an Aperture List field causes 
GerbTool to load the specified aperture list, if it is not already loaded, and link it to 
the corresponding Gerber file. 
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Regardless of whether you are loading or not, the Visibility button controls the 
visibility of the specified layer, the Flash and Draw color buttons control the color of 
flashes and draws respectively and the Layer Type button displays a menu of layer 
types from which you can choose. 

RJ Note It is important to specify the Layer type for each layer, as several GerbTool 
commands check this field for the proper type before processing each layer. For 
example, the Pad Removal command (Tools menu) only operates on Inner-type 
layers. 

The following is a description of each field within the Edit dialog box (from the 
Layers menu). 

Path Specifies the path to the directory containing the Gerber and aperture list 
files. 

Cut, paste above, and paste below Use these to re-order the layer structure 
both before and after a design is loaded. In addition, if you cut a layer from a loaded 
design without pasting the layer, GerbTool prompts you to unload that layer from 
memory. Then, you can free memory if your resources become low. 

Layer Specifies the current layer. To make a layer current, click on the layer 
within the scrollable layer list. 

Filename Specifies the name ofa Gerber file loaded into the current layer. If you 
do not include an explicit path, GerbTool uses the contents of the Path field to locate 
the file. 

Aperture list Specifies the aperture list file to associate with the current layer. 

RJ Note If the specified aperture list is not already in GerbTool format, it is 
converted automatically. 

You do not need to fill in the Aperture list field for each specified Gerber file. If an 
Aperture List field is left blank, it assumes the contents of the previous Aperture 
List field. If the Aperture List field for the first specified layer is blank then it 
assumes the currently configured default aperture list file. 

Layer name Specifies a composite layer name used by the extended Gerber 
format files. This is not a file name. 

Visibility Controls the visibility of the specified layer. Options are On, Off or Ref. 

Flash/Draw Control the color of flashes and draws, respectively. 

Layer (Type) Specifies a layer type of Top, Inner, Bottom, Plane, Composite, or 
Other. 

RJ Note It is important to specify a type for each layer, as several GerbTool 
commands check this field for the proper type before processing each layer. For 
example, the Pad Removal command (Tools menu) only operates on Inner layers. 
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Polarity Specifies the polarity of layers to form composites. Select either Dark or 
Clear. This field is only valid for extended Gerber and FIRE9000 layers. 

Link Links layers together to form composites. Enter a numeric value. GerbTool 
links together layers with identical link numbers to form a composite. This field is 
only valid for extended Gerber and FIRE9000 layers. 

File format Specifies the correct data format before loading begins. With these 
buttons, you edit the selected layers format, whether global or local, add or remove 
local formats, and automatically detect the format of one or more layers. 

Edit Use this button to edit the file format of the selected layer. If that layer has a 
local format added (the File Format Edit button will have Local to its left), the 
format GerbTool displays for editing is specific to the selected layer. Otherwise, 
GerbTool uses the global format. (See the File menu's Format command in Chapter 
7: Command reference for more information on editing file formats.) 

Add Local Adds a local format to the currently selected layer, which you can use 
to specify that the layer has a different format than other layers of the same file type. 
By default, each layer references a global format common to all layers of a particular 
type (for example, Gerber). You can use local formats to load different file types 
into the same design. Then you can simultaneously view and edit any files in the 
same design regardless of their file type. 

Del Local Removes a local format. 

Detect Detects the file format of the selected layer and updates the format 
associated with that layer. 

The effects of editing certain fields within the Edit dialog box differ depending on 
whether you are loading a design or editing after loading. 
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Create 
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The Colors command displays the Layers Color dialog box. Use this dialog box to 
specify: 

• Visibility; ON, OFF or REF. 

• Draw and Flash Color. 

Layers Color dialog box. 

When a layer is on, indicated by a red box around the layer number, it is both visible 
and editable. When a layer is off, it is neither visible nor editable. A black box 
around the layer number, indicates that it is the reference layer, in which case it is 
visible but not editable. 

R:J Note If you find that you don't use the reference visibility setting, you may 
disable the availability of the reference status with the Configure command 
(Options menu). 

This command is not available if the ColorBar is visible on the window. 

This command creates a new empty layer with the filename TEMP<####>.<ext>, 
where <####> is the layer number and <ext> is the currently configured extension 
for Gerber files. If you later decide to save the contents of this layer you may use the 
Edit command (Layers menu) or the Save command (File menu), using the 'Save 
As' option, to change the filename to something more meaningful. 
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Apertures menu 

Edit lrI 

The Apertures command displays the Edit, Report, Load, Unload, Merge, Compact, 
Convert, and Save commands. 

Use this command to edit a previously loaded aperture list. A list of currently loaded 
aperture lists, if such exists, appears for you to choose from. GerbTool displays the 
selected aperture list for you to edit. 

Aperture editing dialog box. 

If, after editing an aperture list, you want to discard the changes you've made, you 
can choose the Cancel button. To keep your changes, at least temporarily, choose the 
OK button. GerbTool updates the in-memory copy of the aperture list. To save an 
aperture list, you must use the Save command (Apertures menu). 
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The Aperture editing dialog box contains two sections; a list for selecting apertures 
to edit and the actual editable fields. The Position field is for reference only and is 
not editable. The nine remaining fields are: 

Field 

D-Code 

Shape 

Size X 

Size Y 

Filename 

Type 

Tool 

Tool Size 

Legend 

Possible values 

10 - 4095 

Round, Square, Rectangle, Oblong, 
Donut, Diamond, Octagon, Thermal, 
Therm45, Target, Complex, Custom 

0.0 - 9.9999 

0.0 - 9.9999 

Custom aperture filename or aperture 
macro 

Surface-mount or through-hole 

0-999 

0.0 - 9.9999 

0-4095 

O-Code Normally, you select a D-code from the apertures list, but you can change 
this field to add new apertures. 

Shape Choose a shape for your aperture. If you choose Custom, the Filename 
field becomes available for you to specify the filename of the custom aperture (see 
Chapter II: Using custom apertures). GerbTool automatically adds the required 
.CUS extension, if needed, when loading the custom aperture. If you choose 
Complex, the Filename field becomes available for you to specify a valid aperture 
macro name. 

Size XlSize Y When editing the Size X field, the Size Y field, if currently set to 
0.0 also assumes the value of the X field. 

Filename If the current aperture shape is Custom, enter the filename of a custom 
aperture file. You can use a wildcard to invoke the file chooser. If the current 
aperture shape is Complex, enter a valid aperture macro name. 

Type Specifies whether the D-code represents a surface mount or through-hole 
pad. This information is needed when building multilayer netIists (see Chapter 7: 
Command reference). 

Tool Edit this field if you intend to extract NC Drill information from a layer, or 
merge a NC Drill file into a layer, using this aperture list. 

Size Specifies the size of the tool indicated in the Tool field. 
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Legend Used when creating a drill drawing using the Drawing command from the 
Drill menu. You can enter a D-code to represent this tool in a drill legend. 

Speed edit Specifies that GerbTool change the operation of this dialog box to 
make it easier to enter aperture lists manually. Normally, when editing an aperture 
list, pressing the ENTER key updates the current aperture and advances to the next 
aperture. When you reach the end of the aperture list, new apertures are added 

. automatically. Moving from field to field is accomplished using the TAB key or 
mouse. The Speed edit option activates only the Shape and XfY size fields. 
Furthermore, the ENTER key moves from field to field except for the Y size field. 
While editing the Y size field, the ENTER key advances to the next record, as usual, 
before moving to the Shape field. This change in operation allows fast aperture list 
creation using only the ENTER key to move from field to field and to advance to the 
next record. 

Edit AD and Edit AM These buttons are only active if the shape is Complex. Use 
them to edit the extended Gerber aperture definition (AD) and the aperture macro 
(AM) respectively. For FlRE9xxx aperture lists, use the Edit AD button to edit an 
aperture defmition in native FlRE9xxx format. 

Search Use this to search for an aperture that contains the text string you specify. 
You can search for any text appearing in the scrollable aperture list. For example, 
you could enter D2 0 0 to find that particular D-code or you could enter rect to find 
the next occurrence of a Rectangular aperture. You could also enter . 05 to find the 
next occurrence of a 50-mils aperture. 
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Select this command to generate an Aperture Report. An aperture report details the 
D-codes, along with their definitions, used on a per layer basis. Included in the 
report are use counts for both flashes and draws. 

Note If an aperture has an unknown shape, or is zero in size, GerbTool highlights 
it for easy recognition. 

ApertUle Report Ei 

Aperture Use Report: ~xl.map 

Layer 1: apertest.Z74 

Shape Width x Height Tool Flashes 
Round 0.0100 x 0.0100 0 0 
Round 0.0200 x 0.0200 
Round 0.1000 x 0.1000 0 8 
Complex 0.2000 x 0.2000 0 1 

0 

Single Layer Aperture Use Report. 

Combined Layer Aperture Use Report. 

Draws 
1896 

376 
0 
0 
0 

Generate Displays a report for the layer specified in the Layer field. Entering 'all' 
or '0' in the Layer field instructs GerbTool to generate a Combined Aperture Report 
for all loaded layers. Use the scroll bar to view all of the report if it does not fit 
entirely within the window. You can edit the report. 

Save Saves the report to a file. 

Print Prints the report to the default Windows printer. 
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Load 

Unload 

Merge 

Compact 

Convert 

Save 

Select this menu item when you need to load or create an aperture list. GerbTool 
prompts you to specify a file. You can use a wild card specification to obtain a list of 
files from which to choose. If the specified aperture list doesn't exist, you can create 
a new one. GerbTool creates an aperture list, using default values, then loads it. If 
you specify an existing aperture list, GerbTool simply loads the specified aperture 
list. 

Fb Note You may load and edit aperture lists independent of a design. 

Use this command to remove a previously loaded aperture list. GerbTool removes 
the aperture list you select, if it is not required by the currently loaded design. If you 
have modified the aperture but have not saved the changes, GerbTool prompts you 
to do so. 

Use this command to merge two or more loaded aperture lists. GerbTool merges all 
aperture lists associated with the currently viewed layers into a new aperture list. 
Each layer is then associated with the new aperture list. GerbTool remaps the D
codes of each layer accordingly. 

Fb Note Save the new aperture list if any remapped layers are saved. 

Use this command to remove unused and redundant apertures within an aperture list. 
Select an aperture list to compact. Each layer associated with the selected aperture 
list is then re-associated with the new aperture list and the D-codes remapped 
accordingly. 

Fb Note It is important that the new aperture list be saved if any of the remapped 
layers are saved. 

GerbTool has the ability to convert most CAD and photo plotter aperture list formats 
directly into GerbTool format. (See Chapter 3: Quick start for a complete list.) 

You can specify an input filename and select the appropriate converter using the 
pull-down list. 

I 
Use this command to optionally save any modified aperture lists. 
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The Query command displays the Item, Net, UserData, Highlight, Measure, Copper, 
and Extents commands, which are described in the following sections. 

Item information nul 
Use the Item Info command to obtain information on individual items within the 
database. The information appears in a dialog box as shown below. 

Query Item display. 

As you select items, GerbTool highlights each item and its D-Code definition, along 
with the X-Y location and other information. You can select items with the mouse or 
using the N key to automatically advance to the next sequential item in the database. 
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Net II 
Use this command to highlight true multi-layer nets using a variety of colors. 
Selected nets remain highlighted until you specifically clear them. 

Query Net dialog box. 

Query by Mouse, Net or UserData You can select it net at anytime by pressing 
the left mouse button anywhere on a line segment or flash. You can also search for 
nets by their GerbTool net number or their UserData. 

Search For Specifies the net or UserData value for which to search. 

Find Choose this button to have GerbTool find and highlight the net that contains 
the value in the Search For field. 

Clear Highlights Choose this button to clear any nets currently highlighted. This 
does not change the net, it merely removes the highlighting. 

Color This changes the color of subsequent nets selections when you select a new 
color. Previous selections are not altered. 

Add UserData Once you have a net selected you may globally add a UserData 
value to all items in the selected net. This provides an easy way of assigning 
meaningful net 'names' to your nets. 

RJ Note This command relies on the netlist information supplied by a previous 
invocation of the Generate command. Ifa netlist does not exist, GerbTool prompts 
you to create one. 
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Measure 
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Use this command to highlight all items that contain a specific UserData value. Each 
selected item remains highlighted until you specifically clear the highlighting. 

Query UserData dialog box. 

Search For Specifies the net or UserData value for which to search. 

Find Choose this button to have GerbTool find and highlight the net that contains 
the value in the Search For field. 

Fb Note For a successful match, the search value can be located anywhere within an 
item's UserData value. This means that a search value "DATA" would match both 
"DATA32" and 'MYDATA'. The comparison is not case-sensitive. 

Clear Highlights Choose this button to clear highlighting. This does not change 
any items, it merely clears the highlighting. 

Color Changes the color of subsequent nets selections when you select a new 
color. Previous selections are not altered. 

The Measure command displays the Point to Point and Edge to Edge commands, 
which are described in the following sections. 

Point to point 

Use this command to obtain accurate measurements of your data. GerbTool first 
prompts for a base point from which to measure. As you move the cursor away from 
the base point, GerbTool displays the distance in X and Y and true length in the 
prompt area. Choosing the left mouse button changes the base point to the current 
cursor position. 

Edge to edge 

This command measures the actual minimum distance between two Gerber data 
items. GerbTool first prompts you to select a base item. As you select additional 
items, GerbTool displays the actual minimum distance between items in X and Y as 
well as true length in the prompt area. 
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Highlight 

Copper 

Extents 

Use this command to highlight all occurrences ofa specified D-code. You can 
restrict your selection to flashes or draws or you can select both. You can also 
specify a particular layer. The selected D-codes remain highlighted until you tum off 
the highlight with the Highlights command (View menu) or 'H' shortcut key or 
when you select another group of items with this command. 

This command accurately calculates the amount of copper used on a layer using a 
high resolution bitmap method. GerbTool scans all visible layers. 

Use this command to determine the data extents of all loaded layers. In addition to 
displaying the extents information, GerbTool also updates its internal data extent 
information. This allows the All command (View menu) to correctly center the data 
after you've made edits to the database. 
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The Options command displays the Grid Snap, Ortho Line Snap, Arcs 360, Metric, 
and Configure commands. 

Use this command to toggle grid snapping on or off. See the Configure command 
(Options menu) for information on changing the appearance of the grid. 

"Fb Nole This command is also available as a shortcut key, CTRL +S. 

Ortho Line Snap·~"1 
Use this command to toggle orthogonal snap mode on or off. When enabled, 
GerbTool forces all lines drawn interactively to the specified angle. See the 
Configure command (Options menu) for information on changing the snap angle. 

Fb Nole You can temporarily override the current setting by holding down the CTRL 

key. 

Arcs 360 ..:iI 

Metric 

Use this command to toggle interpolated arcs on or off. This setting affects the 
method of creating arcs used by the Arc Ctr, Arc 3 Pt, and Circle commands (Add 
menu). If enabled, GerbTool creates all arcs using 3600 circular interpolation. If 
disabled, GerbTool creates all arcs using arcs of90 or fewer degreesef. This does not 
affect the way Gerber data is read from a file. It only pertains to adding new arcs 
with the above mentioned commands. 

Fb Nole Not all photoplotters support circular interpolation. 

This menu item toggles metric mode on or off. When metric mode is enabled, 
GerbTool displays all information and editing fields that represent sizes and 
distances (for example, coordinates) in metric format. 
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Configure 

Use this command to change GerbTool's configuration and many ofthe default 
startup settings. When you choose this command, GerbTool displays a tabbed dialog 
box that contains the following topics: General, Display, Function Key/Mouse, Ap 
List Converters, Paths-Files-Extensions, Macro Files, User Menu. 

General 

This tab displays a dialog box showing the current values of various general 
program settings. 

General Program settings. 

The New Design Wizard should ignore files with these extensions 
Enter any filename extensions that you know are not used for Gerber or aperture list 
files. The more extensions that GerbTool is able to ignore, the faster the New Design 
Wizard builds a new design file. 

Print Border Text Specifies the text that appears in the border of check plots 
generated when printing and exporting to HPGL and PostScript. GerbTool looks for 
the key words $DATE, $TIME, $DESIGN and $PROG. If any of these keywords 
are found, GerbTool replaces them with the appropriate text. All other text specified 
appears in the border verbatim. 

Text Editor Specifies the text editor that GerbTool starts when you are presented 
with a file to view or edit. 
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Max Layers Controls the number oflayers that GerbTool can handle. The valid 
range of values is 12-999. Use the minimum value that satisfies your requirements in 
order to conserve memory. 

Fb Note This parameter will not become effective until the next time you start 
GerbTool. 

Max Aperture Size Specifies the maximum aperture size that GerbTool creates 
for filled polygons. 

Plane Resolution Specifies the "Dots Per Inch" resolution of the bitmap created 
when processing a pwr/gnd plane during netlist generation. To allow maximum 
speed, keep this value to a minimum. Default is 150 DPL 

Chord Angle Specifies the chord angle used when creating segmented arcs using 
editing commands. For example, a chord angle of 5° would result in a 18 separate 
line segments for a 90° arc. 

Line Snap Angle Specifies the angle to which lines are forced if Ortho Line 
Snap is enabled. 

Flags Use this field to control some aspects of GerbTool's low level operations in 
the field. Typically you would be instructed by GerbTool Technical Support 
personnel on how to modify this parameter. The value is entered as a hexadecimal 
number. 

Undo Specifies whether or note GerbTool retains "undo" information. If you 
disable this option, any current "undo" information is destroyed. 

Layer Ref Determines whether or not 'ref layer status is available. If you find 
that you don't use ref status you may disable it by deselecting this box. 

OrCAD Layout for Windows GerbTool User's Guide 75 



Chapter 7 Command reference 

Display 

This tab displays a dialog box showing the current settings that affect the GerbTool 
window. 

Display Parameters dialog box. 

Grid Specifies the grid size. You may select a pre-defined grid size or enter a 
value in the size XIY fields. 

Film Box Specifies the film box size and color. Change the current film box size 
by editing the size XIY fields. Change the film box color by choosing the Color 
button. 

Zoom, Limit or End Cap Use the Limit field to limit how far GerbTool can 
zoom in. On certain combinations of screen resolution and file format the display of 
items at extreme magnification can appear distorted. Use this setting to prevent this 
from occurring. The End Cap field specifies when GerbTool should stop attempting 
to draw end caps on drawn lines. If the thickness of a line (in pixels) is less than or 
equal to this parameter, no end caps wili be drawn. Higher values provide decreased 
redraw times at minimum zoom levels. 

Fb Note The End Cap parameter only affects redraw speed and has no affect on your 
database. 

Highlight Colors Use these buttons to control the colors used when highlighting 
database items. 

Cross Hair The X and Y fields provide control over the size of the drawing area 
cross hair cursor. Enter 0,0 for a full screen cursor. 
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Background Color Use this button to change the Drawing Area background 
color. As with all color buttons within GerbTool, simply click on the button for a list 
of available colors. 

Minimize Redraws This check box controls whether or not GerbTool minimizes 
the amount of redrawing it does. If you are an experienced user you may be 
comfortable redrawing the screen only when you want. 

Note Regardless of this setting, you may always interrupt a redraw, without 
affecting the current command, by pressing the [Esc] key. 

Function Key I Mouse 

This tab displays a dialog box showing the current function key/mouse command 
assignments. 

Configuratron E3J 

Function key/mouse assignment dialog box. 

You can change any of the commands assigned to the mouse and function keys by 
selecting from the drop down lists. Any changes you make become effective 
immediately after choosing the OK button. This also saves the current key 
assignments so they are available the next time you start GerbTool. 

Note In addition to command names, you can also program function keys with 
GerbTool Macros allowing virtually all of GerbTool's power to be within one 
keystroke. 
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Ap List Converters 

This tab displays a list dialog box where you select the aperture list converters you 
require. 

Cads!ar 1.0 
GIRepI1.0 
Ivex 1.0 
Masslek 1.0 
Menlor 1.0 
Dread 1.0 
Pads 1.0 
Pcad7_81.0 
pcadrpl1.0 
Prance 1.0 
Scicard2 1.0 
Scicards 1.0 

1.0 

ALLEG R D.ACR 
CSTAR2.ACR 
GTREP.ACR 
IVEX.ACR 
MASSTEK.ACR 
MENTDR.ACR 
DRCAD.ACR 
PADS.ACR 
PCAD7 _B.ACR 
PCADRPT.ACR 
PRANCE.ACR 
SCICARD2.ACR 
SCICARDS.ACR 
TANGDPRD.ACR 

Aperture list converters. 

This list shows all aperture list converters found in the GerbTool program folder. 
The current converters are at the top of the list with a check mark by them. You can 
select or deselect converters as required. As a general rule, less is better. You can 
also change the title of a converter by clicking on an item in the list and then clicking 
on the title. You can then type in a new name. The use counts associated with each 
converter allows GerbTool to try the most popular converters first during automatic 
aperture list conversion. This can speed up the process considerably. 

Note To add additional ACR files to GerbTool, simply copy them into the folder 
specified by the Source Folder field. 
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Paths, Files, Extensions 

This tab displays a dialog box containing edit fields for various program default 
values regarding paths, files, and extensions. 

Configuration rn 

Paths, files, and extensions. 

Aperture Lists This field tells GerbTool to look for all aperture list files, that 
don't have an explicit path, in this directory. This field replaces the GTMAPDIR 
environment variable used in previous versions of GerbTool. 

Custom Apertures This field tells GerbTool to always look for custom aperture 
files (.cus) in this directory. 

Normal This field specifies the default aperture list file that GerbToolloads if no 
other aperture list is specified. 

Custom This field specifies the aperture list used by all custom aperture files 
(.cus) loaded. 

Default Extensions This group of edit fields specify the default filename 
extensions for the indicated file types. 
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Macro Files 

This tab displays a list where you select which Macro files you want to load the next 
time you start GerbTool. 

Macro files. 
(, 

This list shows all Macro files found in the GerbTool program folder. You may 
select or deselect Macro files as required. 

R:J Note To add additional Macro files to GerbTool, simply copy them into the 
folder specified by the Source Folder field. 
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User Menu 

This tab displays the current user menu configuration so you can make changes as 
desired. 

User Menu setup. 

Label Use this field to type the menu item label text. A character prefixed with 
the ampersand (&) is considered the menu item hot key. 

Command Use this list to select either a macro name or command name. 

Add Choose this button to add a new item to the User menu. GerbTool uses the 
current value in the Label and Command fields to construct the menu item. 

Remove Choose an existing menu item in the list, then choose this button to 
remove the item. If you add an item and then want to change it, you must remove it 
and add it again. 
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Macro menu 

Run 

Load 

Edit 

The Macro menu includes the Run, Load, and Edit commands. 

This command prompts you to select a macro to run. All macros loaded at program 
startup and through the Load command are available for execution. 

Use this command to load additional macro files into GerbTool. You can include 
any macros present in the specified file in GerbTool's list of available macros. 

RJ Note To have GerbTool automatically load a Macro file at startup, see the 
Configure command described earlier in this chapter. 

This command prompts you to select a macro file to edit. GerbTool then loads the 
selected macro file into the currently configured text editor and displays it on the 
screen for you to edit. 
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The Tools command displays the Panelize, DRC, Snoman, Teardrops, Netlist, Test 
Points, Pad Removal, NC Drill, Vent, Convert, Lyr Spread, Fix SS, and Macros 
commands. 

Fb Note The Test Points tool is not available with OrCAD Layout for Windows. 

Panelize :r33?1 

The Panelize command creates multiple copies of a design in one film box. This 
allows multiple copies of the design to be manufactured as one panel. When you 
choose the Panelize command, GerbTool displays the Panelize editing dialog box. 

Paneli2eNent Parameters 

Panelize editing dialog box. 
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To perform automatic panelization 

Automatic panelization provides automatic placement of the maximum number of 
copies on a single panel. 

The Edge-to-Edge values set the minimum distance between adjoining edges of the 
image copies in the X- and Y-axes. The Minimum Border Spacing values set the 
minimum distance between the edges of the iimage copies and the edge of the panel. 

RJ Note Although GerbTool copies only visible layers, all layers of the original 
image remain aligned after panelization. 

Follow these steps to perform automatic panelization: 

1 Activate those layers you want to include in the panelization. 

2 Select the Panelize command from the Tools menu. GerbTool displays the 
Panelize editing dialog box. 

3 Select the Auto Panel button. 

4 Enter the Edge to Edge and Minimum Border Spacing values. 

5 Choose the OK button. 

GerbTool automatically calculates the maximum number of images that fit inside the 
current film box, then previews the panel layout. After asking for confirmation, 
GerbTool completes the panelization process. Depending on the setting of the 
Virtual button, GerbTool either copies the proper number images into the database 
or notes the, number of copies and their location for display purposes. 
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To perform manual panelization 

Use manual panelization to control the layout of the copies on the panel. The Copy 
values set the number of copies in the X- and Y-axes. The Point to Point values set 
the minimum distance between adjoining edges of the image copies in the X- and Y
axes. The Minimum Border Spacing values set the minimum distance between the 
edges of the image copies and the edge of the panel. 

Fb Note The Point-to-Point option appears only when Auto Panel is deselected. 

To perform manual panelization, follow these steps: 

1 Activate those layers you want to include in the panelization. 

2 Select the' Panelize command from the Tools menu. GerbTool displays the 
Panelize editing dialog box. 

3 Deselect the Auto Panel button. 

4 Enter the number of rows and columns in the Copy fields. 

5 Enter the Edge to Edge and Minimum Border Spacing values. 

6 Choose the OK button. 

7 Draw a selection box around the area you want to copy. 

GerbTool previews the panel layout. After asking for confirmation, GerbTool 
completes the panelization process. Depending on the setting of the Virtual button, 
GerbTool either copies the proper number images into the database or notes the 
number of copies and their location for display purposes. 
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To perform automatic venting 

Automatic venting defmes the shape and placement of flashes on the panel outside 
the image areas. GerbTool adds the pattern spacing and aperture selection to the 
database. 

Automatic venting can occur during panelization, regardless of whether or not the 
panelization is automatic. Venting may be targeted to any layers in the Gerber file. 

The Vent to Image Spacing field sets the spacing between the image copies and the 
venting area. The Pattern Spacing field sets the spacing between the flashes in the 
vent pattern. 

The D-Code field sets the size and shape of the flashes. In both automatic and 
manual venting, the style of vent pattern is customized using custom apertures. For 
example, you can create a hatch or cross-hatch pattern using a diagonal or cross 
shape custom aperture. Be sure to set the height and width of the overall size of the 
custom aperture in the aperture list. 

To perform automatic venting, follow these steps: 

1 Check the Auto Vent button within the Panelize editing dialog box. 

2 Enter the Vent to Image Spacing values and the Pattern Spacing values. 

3 Enter the D-Code values. 

After panelization, GerbTool fills the specified area with the defined pattern of 
flashes. 
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To perform virtual panelization 

Virtual Panelization allows GerbTool to panelize your design without actually 
duplicating layer data in the database. Virtual panelization provides many benefits 
including automatic updating of all images during edits and drastically reduced file 
sizes. Furthermore, if you want to plot your design on an extended Gerber or 
FIRE9xxx compatible plotter, GerbTool automatically inserts the proper step and 
repeat codes into your Gerber data. 

Fb Note Although no data is duplicated during virtual panelization, the data origin is 
modified to center the images within the panel. Therefore, it is still necessary to 
save your design after panelization. 

If your designs are plotted on a plotter that does not support step-and-repeat codes, 
you must execute the Panelize command without the Virtual button selected and 
save your panelized Gerber files before you send them to the plotter. 

To perform virtual panelization, follow these steps: 

1 Activate those layers you want to include in the panelization. 

2 Select the Panelize command from the Tools menu. GerbTool displays the 
Panelization editing dialog box. 

3 Select the Virtual Layers button. GerbTool displays a dialog box listing the 
loaded layers. 

4 Select those layers you want to include in the virtual panelization and choose 
the OK button. 

5 Proceed with either automatic or manual panelization. 

GerbTool modifies the database with the number of copies and their location for 
display purposes. Virtual panel mode (and hence the display of virtual panels) may 
be toggled on or off using the CTRL+V shortcut key. 

GerbTool also inserts step and repeat codes into NC Drill output data if you select 
the Virtual button. This may be necessary to drill large panels if your NC equipment 
is memory limited. 
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DRe 
The DRC command checks to see that your design meets minimum item to item 
spacing requirements. When you select DRC from the Tools menu GerbTool 
displays the DRC Parameters dialog box. 

DRe Parameters dialog box. 

Report File This is the file to which all errors are logged. Enter a valid filename 
to set the filename for the DRC error file. 

Layer This is the target layer for the DRC. By default, GerbTool uses the current 
active layer in the Layer field. You may override this by entering a different layer. 

Fb Note If you enter 'all' or '0' in this field, GerbTool processes all viewed layers. 

Highlight Layer Specifies an optional layer in which GerbTool copies all 
database items that are part of a DRC error. That way, you can easily see the whole 
picture and print all errors at once. To disable this feature enter 'none' or '0' in this 
field, 

Border Layer Specifies the layer that contains the design border. If you have a 
layer with just the border on it you may specify this layer here. To disable border 
spacing checks enter 'none' or '0' in this field. 

Pad/Pad Specifies the minimum spacing allowed between pads. 

Pad/Trace Specifies the minimum spacing allowed between pads and traces. 

Trace/Trace Specifies the minimum spacing allowed between traces. 
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Border Specifies the minimum spacing allowed between any item and the border 
specified in the Border Layer field. 

Flash Specifies the minimum pad size. 

Trace Specifies the minimum trace size. 

Min Ring Specifies the minimum annular ring required. The Annular Ring option 
compares the diameter of the flash on the DRC layer to the diameter of the flash on 
the drill layer with the assumption that the drill layer normally contains a flash at 
each pad location using a smaller size than the DRC layer. The Min Ring value is the 
difference in diameters. Select whether the size of the drill layer flashes are taken 
from the D-code size or the Tool size. Through-hole pads that do not have a 
corresponding drill flash are reported as "missing" drills. If either the Min Ring 
value or drill layer are 0, GerbTool does not perform the annular ring. 

~ Tip You can also use the annular ring check to verify a soldermask layer. Use the 
soldermask layer as the active layer; use the copper layer on which the pads are 
defined as the drill layer. 

Drill Layer Specifies the drill layer used in the annular ring check. A '0' disables 
annular ring checking. 

Use Size Of Specifies whether the size of the drill layer flashes are taken from 
the D-code size or the Tool size field within the aperture list when performing 
annular ring checking. 

Well Behaved The DRC command supports two separate modes; "well 
behaved" and normal. In "well behaved" mode, GerbTool assumes that legal 
pad/trace or trace/trace connections have common X-Y locations (see the Netlist 
command in Chapter 7 for a description of "well behaved" Gerber files). This 
means that any actual contact between items that don't share a common X-Y 
location, and are in different nets, is considered a violation. Conversely, in normal 
mode, any actual contact between items is not considered a violation. Only items 
that are not in contact but are within the minimum spacing rules are considered in 
violation. "Well behaved" mode is preferred if your Gerber files were produced 
accordingly as it provides much faster processing and more accurate results. 

R:J Note If a valid netlist does not already exist, GerbTool prompts you to generate 
one. While a netlist is not a prerequisite to DRC, a netlist increases the usefulness 
and accuracy ofDRC. 

Window Specifies that GerbTool runs the DRC on a particular window of data, 
rather than on the complete layer. 

Find Stubs Allows GerbTool to locate and highlight all trace stubs. A trace stub 
is any trace that touches a pad or trace on only one end. 
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Max Errors Sets a limit to the number of errors DRC produces. This prevents 
DRC from generating a huge report file if you enter the incorrect spacing rules for a 
given design. 

Don't check items in select group Tells DRC to ignore all items that are in 
the current select group. For example, if you have blocks oftext that you want to 
exclude from the check, you can use the Add command to create a select group with 
these blocks of text. DRC then ignores the text, thereby producing a much cleaner 
report. 

After performing the DRC, GerbTool enables DRC error viewing and displays the 
DRC View Errors dialog box as show below: 

ORe view errors. 

You can use this dialog box to examine and document any or all DRC errors found. 

Next Jump forward to the next non-fixed error. 

Prey Jump back to the next non-fixed error. 

GoTo Jump to the current error fixed or not. 

Print Print the currently selected error on the default Windows printer. The error 
report includes a screen capture of the error and all related information about the 
error and items involved. 

Print All Prints a separate error report for each error in the list. 

Fixed Toggles the status of an error. By setting the status to fixed you can tell at a 
glance which errors have already been corrected. 

Highlights Toggles the display of the current error highlights. Use this button to 
temporarily turn off highlights to allow easy correction of the error. 

Use the Errors command to toggle the display of the DRC View Errors dialog box. 

R:J Note GerbTool updates the DRC report file generated by the last run of the DRC 
command with the fixed status of each error. Therefore, you should not remove or 
substantially alter this file if you intend to view DRC errors again using this file. 
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This menu selection starts the Snoman tool. The Snoman tool creates a maximum 
material condition at the point of trace entry into a pad. See Appendix D: Snoman 
concepts for a more technical description. 

Snoman editing dialog box. 

Enter a valid filename in the Rep File field; GerbToollogs any errors to this file. 
You must specify a layer to operate on (From Layer) as well as an output layer 
(To Layer) for the generated Snoman pads. 

Fb Note If you enter a zero in the From Layer field, GerbTool processes all viewed 
layers, with the resultant Snoman pads being added to their respective layers. 

You can restrict the generation of Snoman pads to a particular D-code by entering its 
identifier in the D-Code field. A D-code of zero matches all. Edit the spacing 
parameters to specify the design rules to which Snoman must adhere. The 
Host Offset field contains the offset maintained between the host pad centroid and 
the edge of the generated Snoman pad. This value may be negative. If Snoman 
detects a spacing rule violation while placing a Snoman pad, it reduces the size of 
the Snoman pad to avoid such errors. You can control the percentage of the host pad 
size that Snoman can reduce the size of the Snoman pad. Use the Min Percent field 
to specify this value. Use the Max Percent field to control the maximum size of the 
generated Snoman pad as a percentage of the host pad size. You can also indicate 
whether Snoman should operate on a window of data versus a complete layer. 

Fb Note If a valid netlist does not already exist, GerbTool prompts you to generate 
one. A netlist is required for the Snoman tool to work properly. 

Use the Errors command (View menu) to view potential rule violation errors, if any, 
after executing this command. 
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Teardrops 

The Teardrop tool creates a maximum material condition at the point of trace entry 
into a pad, or at T junctions for traces. That is, when you use the Teardrops 
command, GerbTool adds copper at the point in question to insure that the 
connection is maintained. 

Teardrop dialog box. 

Report File Specifies the file to which GerbTool writes any errors for the 
Teardrops command. 

Layer Specifies the layer that receives the teardrops. 

Fb Note If you enter a '0' in the Layer field, GerbTool processes all viewed layers. 

D-Code Specifies that GerbTool add teardrops only to those pads that use the 
specified D-Code. A D-Code of '0' matches all. 

Percent of host Specifies the relative size of the teardrop "tail." GerbTool 
calculates this length as a percentage of the diameter of the host pad. The value you 
enter can be greater than 100%. 

PadlTrace Specifies the pad to trace sp!!.cing parameters for teardrops. 

TracelTrace Specifies the trace to trace spacing parameters for teardrops. 

Length Multiple Specifies the "T" junction tail length. GerbTool calculates this 
value in multiples of the host trace diameter. The value you enter can be fractional. 

Width Multiple Specifies the "T" junction tail width. GerbTool calculates this 
value in multiples of the host trace diameter. The value you enter can be fractional. 

Window When you select this option, GerbTool creates teardrops for pads and 
"T" junctions only within a particular window, not for the entire design. 
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Delete Existing Teardrops When you select this option, GerbTool removes 
existing teardrops from the design (or window within the design) before creating the 
new teardrops. 

Fb Note If a valid netlist does not already exist, you will be prompted to generate 
one now. A netlist is required for the Teardrop tool to work properly. 

All pad locations for which GerbTool could not generate a Teardrop are highlighted 
and their locations are specified in the generated report file. 

~ Note You can remove teardrops using the Undo command. 
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Netlist 

The Netlist item displays the Generate and Save commands. 

Generate 

The Generate command processes all viewed layers and creates a single multi-layer 
netlist that becomes part of the internal database. The netlist may then be used by 
other GerbTool Test Points commands that require a netlist such as DRC and 
Snoman (Tools menu). 

You can indicate whether your database is "Well Behaved" or not. A well behaved 
Gerber file is defined as a file where all items that are to be considered connected 
share a common X-Y location as shown below: 

Trace ends share same X-Y location. 

Pad and trace end share same X-Y location. 

Example of a "weI/-behaved" Gerber file. 

The following is an example of a Gerber file that is not well-behaved: 

Trace ends don't share common X-Y locations. 

Trace ends don't match pad X-Y locations. 

Example of a Gerber file that is not "well-behaved. " 
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If you determine that your Gerber files are indeed "well-behaved," choose this mode 
when generating a netlist, as there is a dramatic increase in processing speed due to 
the well-behaved nature of the Gerber files. 

Since so many of GerbTool's features require a netlist to perform properly, you can 
save the generated netlist within your Gerber files for later use. If netlist saving is 
enabled (see Chapter 7: Command reference), and a netlist is present, GerbTool 
saves it when the layer is saved. To remove a netlist from a Gerber file, load the 
layer (or layers), disable netlist saving using the Format command (Files menu) and 
then save the necessary layers. 

Fb Note GerbTool uses the G04 command to embed a netlist within a Gerber file. 
This causes the Gerber file to increase slightly in size. Remove netlists as described 
above before submitting your files to be photoplotted, due to their increased size 
and the possibility of the photoplot equipment not properly recognizing the G04 
command. 

Save 

This command generates an ASCII netlist file consisting of net numbers, or names 
using UserData, and pad X-Y coordinates. See Appendix C, Sample Netlist File. This 
command uses all viewed layers in generating the netlist file. 

Netfist editing dialog box. 

Filename Specifies the desired output filename. Use the Browse button to locate 
the desired output file. 

M.N Specifies the coordinate format. 

Renumber Sequentially Instructs GerbTool to renumber the net numbers if 
needed to make sure that they are output in order and with no gaps in the net 
numbers. 

Label Net Using Provides a means of determining how GerbToollabels nets. If 
your nets have UserData assigned to them you may choose to have your netlist 
labeled with the UserData instead of net numbers. 

Fb Note If a valid netlist does not already exist, GerbTool prompts you to generate 
one. A netlist is required for this command to work properly. 
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Fix SilkScreen 
This command automatically moves silkscreen data away from pads. 

Fix silkscreen editing dialog box. 

You specify the layer that contains the pads (Pad Layer) and the layer that contains 
the silkscreen data (SilkScreen Layer) as well as a minimum spacing to be 
maintained and finally whether you desire window mode. GerbTool then moves line 
segments that violate the minimum spacing requirement as shown in the following 
before and after sequence: 

C30 __ .----. -• -
Before running the Fix SilkScreen command. 

ISl·D~ -:·n_c:~.~gJ:-~- -~- -~- -:::l_ _:::lei· _:::l_ _ - --. - - -- --l- - -. - • - - ·1- _. --. -- - -. -. .- - .-
After running the Fix SilkScreen command. 
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The Pad Removal command displays the Isolated and Stacked commands. 

Isolated 

Selecting this command removes any unused pads (isolated/floating pads) from 
inner layers. 

RJ Note GerbTool considers only Inner-type layers. Use the Edit command (Layers 
menu) to change this if necessary for a particular layer. 

GerbTool does not remove targets or thermal pads. You specify the layer from 
which to remove the pads and whether GerbTool processes a window or the entire 
layer. 

Stacked 

Selecting this command removes any unnecessary pads that are identical and stacked 
exactly one on top of another on the same layer. You specify the layer from which to 
remove the pads and whether GerbTool processes a window or the entire layer. 

The NC Drill command displays the Drawing and Save commands. 

Drawing 

This command creates a drill drawing using the Legend field associated with each D
code in an aperture list. 

Create Drill Drawing dialog box. 

For each D-code in the From Layer field, GerbTool adds the D-Code specified by 
the corresponding Legend field to the layer specified in the To Layer field. Use the 
Copy All option to copy D-Codes with invalid Legends. If you select the Copy All 
option, you can use the Sub D-Code field to specify a particular D-Code to use as a 
substitute for invalid Legend D-Codes. If Sub D-Code is '0', all D-Codes with an 
invalid Legend D-Code use the original D-Code value in the. To Layer field. 
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Save 

The Drill command creates an ASCII output file containing X-Ypad locations in the 
selected NC format. GerbTool optimizes the output and removes duplicate hits 
within a single tool. 

Drill editing dialog box. 

This command relies on the Tool assignments within the aperture list for the selected 
input layer. Optimization is controlled by the Swath Width value and by whether an 
X or Y sort is performed. The report file contains an approximate distance that the 
drill head will travel. Therefore, by adjusting the swath width and examining the 
report file you can achieve the fastest drilling throughput. 

RJ Note Perform image panelization prior to executing this command. If you 
perform virtual panelization the output of this command contains step and repeat 
codes. Use these codes if your drilling equipment has limited memory capacity. 
Otherwise, a fully optimized non-virtual panel results in more efficient drilling. 

Occasionally there may be items that you don't want optimized, but that you want to 
include in the same drill file, such as test coupons and mounting holes. Place these 
items on a layer in the exact order that you want them drilled. GerbTool enters these 
layers into the Merge Layer Pre and Post fields. GerbTool inserts these layers into 
the drill file without optimization before and after inserting the optimized 
information from the layer specified in the Drill Layer field. This is done on a tool 
by tool basis. Therefore, GerbTool outputs information for tool #1 on the Pre merge 
layer first, then optimizes and outputs the drill layer, followed by the tool # 1 
information from the post merge layer. GerbTool then repeats the process for tool 
#2, and so on. This also works for Virtual panels when you want to include non
panelized drill data. 

Sort Tools By - Number or Size Indicates how GerbTool orders the tools in 
the output file. 

Pre-drill holes larger than Indicates the maxim~pl size for holes that will not 
be pre-drilled. 
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The Convert menu item presents a sub-menu with the Drawn Pads and Arcs 
commands. 

Drawn Pads 

Use this command to convert pads created with Gerber draws into flashes. Use this 
command prior to attempting any other editing or data extraction such as NC Drill. 
This command can significantly decrease the size of your database if it contains 
drawn pads. 

Drawn Pad Conversion dialog box. 

This command prompts you to enter a window around the drawn pad you want to 
convert. 

If you select the Create D-Codes check button, GerbTool creates new D-Codes as 
necessary to match the dimensions of the drawn pads selected for conversion. If you 
don't select the Create D-Codes check button, GerbTool informs you of the 
calculated size of the pad as shown below: 

Drawn Pad Replacement D-Code dialog box. 
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Find or create a corresponding flash in the aperture list for this layer. Enter the 
appropriate D-Code in the D-Code field and a tolerance value, if needed, in the 
Tolerance field. 

Fb Note The tolerance value allows GerbTool to increase its match frequency when 
the CAD system that generated the drawn pads exhibits round off errors. Usually a 
value of 0.002 (inches) will suffice. 

GerbToollocates and highlights all occurrences of any matching drawn pads and 
prompts you on whether or not to continue. 

Arcs 

This command converts circular interpolated circles into segmented circles, 
individually or by window. Use this command if your photoplotter can't handle 
circular interpolated arcs. 
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Use the Layer Spread command to reduce your film costs by automatically copying 
and spreading all viewed layers onto one layer (and thus one sheet of film). 

Layer Spread editing dialog box. 

You can select automatic or manual mode using the Layer Spread editing dialog box 
as shown above. If you select Auto Mode, GerbTool automatically calculates the 
number or images that will fit in the film box as well as the position of each image. 
In auto mode the X and Y spacing fields specify the opposing border-to-border 
minimum spacing requirements. In manual mode, you must specify the number of 
rows and columns and the center to center spacing in the X and Y spacing fields. In 
either case, you can select either row major or column major placement. While the 
To Layer field may specify one of the layers to be spread, it usually is an empty 
layer created to accept the properly spread out images. 

When you choose the OK button, GerbTool prompts you to select the order in which 
the layers are spread. You must click on each layer to define the proper order. After 
doing so, GerbTool shows the placement of all layers for your approval. If you 
respond affirmatively, GerbTool copies and spreads the layers as shown. 

Use this command to manually add Venting/Thieving patterns to your database. 
GerbTool displays the Vent Parameters edit dialog box where you can edit the 
venting parameters such as pattern spacing and aperture selection. 

Vent Parameters Edit dialog box. 

You can then define a rectangular area by entering two coordinate points. After 
confirmation, GerbTool fills the specified area with a pattern of flashes as specified. 
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GerbTool provides a powerful macro command language that you can use to create 
new commands to accomplish everything from simplifying repetitive tasks to 
implementing entirely new functions. The macro language provides the ability to 
make decisions, repetitively execute a group of commands, scan the database, 
prompt the user for data and more. This chapter details the command language used 
in creating a GerbTool macro. 

Creating a macro 

You create macros using any text editor that supports plain ASCII text. 

Fb Note If you use a word processor you may have to specifically save your macro 
file in ASCII text fonnat. 

A macro file can contain multiple macros, each with a name up to sixteen characters 
long. If a macro is defined more than once, only the last occurrence of the macro is 
visible to GerbTool. While any number of macro files can be loaded, GerbTool 
allows a maximum of 1024 total macros to be defined. 

Each macro consists of a MACRO statement followed by one or more macro 
language commands or statements and tenninated by an END statement as shown 
below: 

MACRO testmacro 

ENDMACRO 
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Using variables 

You can define macro variables with names up to 32 characters. You can use a 
variable anywhere a number or text string is expected within a macro. To use a 
variable, prefix a symbolic name with a $, as shown in the following example: 

GETPOINT 
CALC 
ADD FLASH 

"Enter New Coord", $XCOORD,$YCOORD 
$XCOORD = $YCOORD * 2.0 
$XCOORD,$YCOORD + 0.5 

GerbTool automatically defines many system level variables that provide basic 
program information, such as the number of layers configured, and variables that 
contain the specific results of certain macro commands after they have been 
executed. All system level variables are defined with an additional leading dollar 
sign ($) character, such as $$STATUS. 

Fb Note The system variable $$STATUS is set by most commands, indicating the 
success or failure of the command. Positive values indicate success; negative 
failure. In some cases the value may indicate a count, such as in the Copy command 
(Edit menu). 

A list of system level variables is shown below. 

$$ACTIVELAYER $$GROUPMODE $ $ PLATFORM 

$$CALLDEPTH $$ITEMMODE $$RECTANGLE 

$ $ COMPLEX $$LAYERMODE $ $ ROUND 

$$CURRENTDCODE $$MAXLAYERS $$SELGRPCNT 

$ $ CUSTOM $$MODEL $ $ SQUARE 

$$DIAMOND $$NO $$STATUS 

$ $ DONUT $ $ OBLONG $$TARGET 

$ $ DRAW $ $ OCTAGON $ $ THERMAL 

$$DRILLCOUNT $$PANELCOLS $$THERM45 

$$DRILLEFTRAVEL $$PANELROWS $ $ TRUE 

$$DRILLTRAVEL $$PANELXOFF $$VERSION 

$$DSNNAME $$PANELXSPACING $$WINDOWMODE 

$$FALSE $$PANELYOFF $$YES 

$ $ FLASH $$PANELYSPACING 
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You can also create arrays of variables using the ARRAY and STRARRAY functions. 
An array is a list of variables referenced through a single variable name and an 
index. Array indexes can be any expression including another array variable. For 
example: 

STRARRY $names(3) 
STRCPY $names(l), "Bob" 
STRCPY $names(2), "Betty" 
STRCPY $names(3), "Jessie" 

For added ease of use, you can specify a range of array indexes when using numeric 
arrays in coordinate lists submitted to a macro command. For example, ADDFLASH 
$xy ( 1 , 4) would be equivalent to ADDFLASH 
$xy ( 1) , $xy (2) , $xy (3) , $xy (4) . This is especially useful when using 
variables as indexes. 

Coordinate lists also support both absolute and relative coordinate modes. The 
default coordinate mode is absolute. To change to relative mode, prefix a coordinate 
with an R. Once activated this way, all coordinates following are relative to the 
previous coordinate. You can tum relative mode off by prefixing a coordinate with 
an A. The specified mode only applies to the command in which it was used. 

For example: 

ADDDRAW $xs,$ys,RO.l,O,O,O.l,-O.l,O,A$xs,$ys 

In the above example the ADDDRAW command is provided an initial absolute 
coordinate followed by three relative coordinates and finally a absolute coordinate. 

Repeating blocks of commands 

Macros allow you to repeat a series of commands until an event occurs that 
terminates the loop. An example of the REPEAT statement is shown below. 

REPEAT $cnt > 0 
... will be executed as long as $cnt > 0 ... 

END 

The above example repeatedly executes the commands between the REPEAT and 
END statements until the variable $ cnt is less than or equal to zero. You can nest 
REPEAT blocks. 
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Making decisions 

Macros also have conditional capabilities, using the IF statement: 

IF $shape -- $ $ RECTANGLE 
... will be executed if above test is TRUE •.• 

END 
IF $ shape -- $$RECTANGLE 

... will be executed if above test is TRUE ... 

ELSE 
... will be executed if above test is FALSE .•• 

END 

Combining IF statements within REPEAT blocks provides virtually unlimited macro 
programming possibilities. 

Loading macros· 

You can load a macro file using the Load command (from the Macro menu item on 
the Tools menu). Use this command to load a macro file after GerbTool is up and 
running. 

Running macros 

There are several methods of running a macro: 

• The first method is to use the normal menu and select the Run command (Macro 
menu). Use this command to choose a previously loaded macro for execution. 

• The second method is to use the M shortcut key. 

• Another method is to assign a macro to a function key using the KeyCmds 
command from the Options menu. This allows you to run a macro with a single 
keystroke. 
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Macro language reference 

This section describes each macro command and statement, and the parameters 
expected for each. 

Conventions used 

[x, y] 

<alb> 

literal 

variable 

numvar 

strvar 

operator 

exp 

yesno 

\ 

# 

Three dots (an ellipsis) indicate that additional similar 
parameters are allowed. 

Items inside square brackets indicate optional parameters. 

Angle brackets and vertical bars indicate a choice among two or 
more items. 

A literal numeric or string value, such as 14 . 125 or Yes. 

A numeric or string value stored in a variable, such as $XCOORD 
or $REFDES. 

A numeric variable. 

A string variable. 

One of the following mathematical or comparison operators: 

+ addition 
subtraction 

/ division 

* multiplication 
equal 

!= not equal 
< less than 
> greater than 
<= less than or equal 
>= greater than or equal 

Numeric expression of the form: 

<literal I numvar> [operator <literal I numvar>] 

<"Yes" I "No" I $$YES I $$NO> 

Use the back slash as the last character on a line to indicate that 
a long command is to continue on the next line. 

This character initiates a comment. 
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Add functions 

ADD3PTARC 

Purpose 

Menu command 

Syntax 

Parameters 

xl 

y1 

x2 

y2 

x3 

y3 

Description 

Example 

See also 

Allows the user to enter arcs by specifying two end points 
and a point on its circumference. 

Arc 3 Pt (Add item on the Edit menu) 

ADD3PTARC [xl, y1, x2, y2, x3, y3] ... 

The x coordinate of the first end point of the arc. 

The y coordinate of the first end point of the arc. 

The x coordinate of the second end point of the arc. 

The y coordinate of the second end point of the arc. 

The x coordinate of a point on the circumference of the arc. 

The y coordinate of a point on the circumference of the arc. 

This command adds three-point arcs into your Gerber 
layer. GerbTool draws the arc on the active layer using the 
current D-code in a counter-clockwise direction. The arc is 
created either as a 3600 interpolated circle or with multiple 
line segments, depending on the style that is currently 
active. Note that you can use this command to draw 
multiple arcs with a single call by passing all of the 
coordinates for all of the· arcs to the command. 

The following example adds an arc to layer 1 using 
D-Code 10, whose end points are at (0,0) and (1, 0) and 
passes through (0.5, 0.5). 

ACTIVELAYER 1 
CURRENTDCODE 10 
ADD3PTARC 0,0, 1,0, 0.5, 0.5 

ADDARC, ADDCIRCLE 
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ADDARC 

Purpose 

Menu command 

Syntax 

Parameters 

xl 

y1 

x2 

y2 

x3 

y3 

Description 

Example 

See also 

Chapter 8 Macros 

Allows you to enter arcs by specifying the center, and two 
points defining the starting and ending angles. 

Arc Ctr (Add item on the Edit menu) 

ADDARC [xl, y1, x2, y2, x3, y3] ... 

The x coordinate of the center of the arc. 

The y coordinate of the center of the arc. 

The x coordinate of the starting point of the arc. 

The y coordinate of the starting point of the arc. 

The x coordinate of the ending point of the arc. 

The y coordinate of the ending point of the arc. 

Use this command to add an arc to your Gerber layer. 
GerbTool draws this arc on the active layer using the 
current D-code in a counter-clockwise direction. The arc is 
created either as a 3600 interpolated circle or with multiple 
line segments, depending on the style that is currently 
active. Note that you can use this command to draw 
multiple arcs with a single call by passing all of the 
coordinates for all of the arcs to the command. 

The following example adds an arc to layer 1 using D-code 
10, with a center at 0,0 and end points at -1,0 and 1,0. 

ACT IVELAYER 1 
CURRENTDCODE 10 
ADDARC 0,0, -1,0, 1,0 

ADD3PT ARC, ADDCIRCLE 
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ADDCIRCLE 

Purpose 

Menu command 

Syntax 

Parameters 

xl 

y1 

x2 

y2 

Description 

Example 

See also 

Allows you to draw a circle by specifying its center, and a 
point defining its radius. 

Circle (Add item on the Edit menu) 

ADDCIRCLE [xl, y1, x2, y2] ... 

The x coordinate of the center of the circle. 

The y coordinate of the center of the circle. 

The x coordinate of a point on the radius of the circle. 

The y coordinate of a point on the radius of the circle. 

Use this command to add a circle to your Gerber layer. 
GerbTool draws this circle on the active layer using the 
current D-code in a counter-clockwise direction. The arc is 
created either as a 3600 interpolated circle or with multiple 
line segments, depending on the style that is currently 
active. Note that you can use this command to draw 
multiple circles with a single call by passing all of the 
coordinates for all of the circles to the command. 

The following example adds a circle to layer 1 using 
D-code 10, with a center at 0,0 and a radius of 3 inches. 

ACTlVELAYER 
CURRENTDCODE 
ADDCIRCLE 

1 

10 
0,0, 3,0 

ADD3PTARC, ADDARC 
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ADDDRAW 

Purpose 

Menu command 

Syntax 

Parameters 

xl 

yl 

x2 

y2 

Description 

Example 

Chapter 8 Macros 

Allows you to draw a line by specifying its end points. 

Draw (Add item on the Edit menu) . 

ADDDRAW [xl, yl, x2, y2] ... 

The x coordinate of the starting point of the line. 

The y coordinate of the starting point of the line 

The x coordinate of the ending point of the line. 

The y coordinate of the ending point of the line. 

Use this command to add a line or trace into your Gerber 
layer. GerbTool draws this line on the active layer using 
the current D-code. Note that you can use this command to 
draw multiple lines with a single call by passing all of the 
coordinates for all of the lines to the command. When 
drawing more than one line, you only need to pass the 
ending points of subsequent lines. GerbTool automatically 
starts each line at the endpoint of the previous line. 

The following example creates a I inch box out of 4 lines, 
whose lower left comer is at the 0,0 coordinate. Note how 
only the changed coordinates need to be entered. 

ACTIVELAYER 1 

CURRENTDCODE 10 
ADDDRAW 0,0, 0,1, 1,1, 1,0, 0,0 
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ADDFILL 

Purpose 

Menu command 

Syntax 

Parameters 

x 

y 

Description 

Example 

Allows you to perform a polyfill. 

Fill (Add item on the Edit menu)l 

ADDFILL [x, y] ... 

The x coordinate of a point on the fill border. 

The y coordinate of a point on the fill border. 

Use this command to enter a closed polygon and GerbTool 
fills the interior of the polygon. This command is 
commonly used to create ground plane areas. To use this 
command, enter at least 3 x, y coordinate pairs to specify 
the outline to fill. If you enter fewer, GerbTool stops and 
prompts you for the missing coordinates. GerbTool then 
outlines the polygon with the current D-code, and begins 
filling the interior of the polygon with increasing aperture 
sizes as long as it can continue to find an aperture that is 
twice the size of the current aperture being used. As it fills 
toward the center of the polygon the aperture sizes become 
larger and larger. This allows the polygon to be filled with 
the least amount of data thereby keeping the database size 
as small as possible. If an aperture twice the size of the last 
aperture used cannot be located GerbTool fills the 
remainder of the polygon with the last aperture found. 

The following example creates a I-inch filled box, with a 
lower left corner at the 0,0 co~rdinate. 

ACTlVELAYER 1 

CURRENTDCODE 10 
ADDFILL 0,0, 0,1, 1,1, 1,0, 0,0 
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ADDFLASH 

Purpose 

Menu command 

Syntax 

Parameters 

x 

y 

Description 

Example 

Chapter 8 Macros 

Allows you to add a flash at a specified location. 

Flash (Add item on the Edit menu) 

ADDFLASH [x, y] ... 

The x coordinate of the location to add a flash. 

The y coordinate of the location to add a flash. 

Use this command to add a flash to your Gerber data. The 
flash is created on the active layer using the current D
code. If you want, you can use mUltiple coordinates with 
this command: GerbTool places a flash at each location. 

The following example adds four flashes forming the 
comers of a 1 inch box, with a lower left comer at the 0,0 
coordinate. 

ACT I VELAYER 1 
CURRENTDCODE 10 
ADD FLASH 0,0, 0,1, 1,1, 1,0, 0,0 

DrCAD Layout for Windows Gerb Tool User's Guide 113 



Chapter 8 Macros 

ADDPOUR 

Purpose 

Menu command 

Syntax 

Parameters 

x 

y 

Description 

Example 

See also 

Allows you to perform a polypour. 

Pour (Add item on the Edit menu) 

ADD POUR [x, y] ... 

The x coordinate of a point on the pour border. 

The y coordinate of a point on the pour border. 

Use this command to enter a closed polygon and GerbTool 
fills the interior of the polygon using an intelligent 
polypour. This command is commonly used to create 
ground plane areas. To use this command, enter at least 3 
x, y coordinate pairs to specify the outline you want filled. 
If you enter fewer, GerbTool stops and prompts you to 
enter more. This command uses the pour settings set up in 
the menu command or from the POUR command. 

The following example creates a I-inch filled box, with a 
lower left comer at the 0,0 coordinate. 

ACTIVELAYER 1 
CURRENTDCODE 
ADDPOUR 

POUR 

10 
0,0, 0,1, 1,1, 1,0, 0,0 
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ADDTEXT 

Purpose 

Menu command 

Syntax 

Parameters 

string 

x 

y 

Description 

Example 

See also 

Chapter 8 Macros 

Allows you to add a string of text to the database. 

Text (Add item on the Edit menu)! 

ADDTEXT string [x, y] ... 

A string containing the text to be added. 

The x coordinate of the location to add the text. 

The y coordinate of the location to add the text. 

Use this command to add text to a Gerber layer. The text is 
drawn using the current D-code on the active layer using 
the settings that were set up in the menu command or from 
the TEXT command. 

The following example adds the text string "Hello World" 
starting at coordinate 0,0. 

ACTlVELAYER 
CURRENTDCODE 
ADD TEXT 

TEXT 

1 

10 
"Hello World" 0,0 
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ADDVERTEX 

Purpose 

Menu command 

Syntax 

Parameters 

x 

y 

Description 

Example 

Allows you to add a vertex to a line. 

Vertex (Add item on the Edit menu) 

ADDVERTEX [x, y] ... 

The x coordinate of the vertex to add. 

The y coordinate of the vertex to add. 

Use this command to add a vertex to an existing trace, 
creating two traces from the original. The coordinate 
specified is the location of the new vertex and must be 
located on an existing trace. 

The following example adds a vertex to the center of an 
existing line, whose end points are located in the variables 
$xl, $yl anP $ux, $uy. 

CALC $ptx $ux - $lx 
CALC $ptx $ptx / 2.0 
CALC $ptx $ptx + $lx 
CALC $pty $uy - Sly 
CALC $pty $pty / 2.0 
CALC $pty $pty + Sly 

ADDVERTEX $ptx, $pty 
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Aperture functions 

APREPORT 

Purpose 

Menu command 

Syntax 

Parameters 

REPFILE 

LAYER 

SORTBY 

Description 

Example 

Produces an aperture usage report. 

Report (Apertures menu) 

APREPORT 

END 

REPFILEstring 
LAYERexp 
SORTBYstring 
GO 

Chapter 8 Macros 

The name of the report file the command produces. 

Specifies the layer on which to report. A value of '0' 
indicates that all layers are included in the report. 

Must be either D-Code or List. You this to specify the 
ordering of the report for reports that target multiple layers. 

Use this command to produce an aperture usage report. 
The format of this report is the same as that produced by 
the Report command from the Aperturues menu. This 
report details the D-Codes (and their their definitions) that 
are being used on a per layer basis. Included in the report 
are use counts for both flashes and draws. 

The following example produces an aperture report for all 
visible layers sorted by aperture list and places the result in 
the file OUTPUT.RPT. 

APREPORT 

END 

REPFILE "output.rpt" 
LAYER 0 #output rep based on all lyrs 
SORTBY "List" 
GO 
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GETAPINFO 

Purpose Use this command to obtain information about an aperture in 
an aperture list. 

Menu command Edit (Apertures menu) 

Syntax GETAPINFO [layer, deode, shape, xsize, 
ysize, type, tool, toolsize, legend] 

Parameters 

layer 

de ode 

shape 

xsize 

ysize 

type 

tool 

An expression specifying the layer with the aperture list to be 
used. 

An expression specifying the D-Code to get information on. 

A numeric variable that returns the shape of the aperture. 

A numeric variable that returns the width of the aperture. 

A numeric variable that returns the height of the aperture. 

A numeric variable that returns the type of the aperture. 

A numeric variable that returns the tool number of the 
aperture. 

toolsize A numeric variable that returns the toolsize for the aperture. 

legend A numeric variable that returns the legend value for the 
aperture. 

Description 

Example 

See also 

Specify the number of a layer that uses the aperture list and 
the aperture D-Code. GerbTool places the appropriate 
information into the other variables passed il1to the 
command. You must include all of the variables listed with 
this command at least once within a macro, even if they are 
not going to be used by the macro. Subsequent calls can 
specify the first two parameters (layer, dcode) or can omit all 
parameters. Those variables used in the last complete call are 
remembered and used again. 

The example gets the aperture information used by layer 1 of 
a design, and writes its toolsize and D-code out to a file. 

IF $deode !.= 0 

END 

GETAPINFO 1, $deode, $shp, $xs, $ys, \ 
$type, $tool, $toolsize, $legend 

FILEWRITE $fd,lI%n %n",$toolsize,$deode 

PUTAPINFO 
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PUTAPINFO 

Purpose 

Menu command 

Syntax 

Parameters 

Description 

Example 

See also 

Chapter 8 Macros 

To update the information about a specific aperture in an 
aperture list. 

Edit (Apertures menu) 

PUTAPINFO [layer, dcode, shape, xsize, 
ysize, type, tool, toolsize, legend] 

See the parameter list for the GET APINFO command. The 
PUT APINFO and GET APINFO parameter lists are 
identical and are shared between the two commands. For 
this reason, you need only specify the parameter list for 
one command, and the other command automatically uses 
the same variables. 

Use this command to update information about an aperture. 
You specify the number of a layer that uses the aperture list 
and the aperture D-code. GerbTool then places the 
appropriate information from the other variables passed 
into the command into the actual aperture list. All of the 
variables listed with this command must be included at 
least once within a macro, even if they are not going to be 
used by the macro. Subsequent calls can specify the first 
two parameters (layer, dcode) or can omit all parameters. 
Those variables used in the last complete call are 
remembered and used again. 

The following example gets the aperture information for an 
aperture used by layer 1 of a design, changes the size and 
updates the aperture list. 

IF $dcode != 0 

END 

GETAPINFO $lyr,$dcode,$shp,$xs,$Ys, \ 
$type, $tool, $toolsize, $legend 

CALC $xs = $xs * 1.2 
CALC $ys = $ys * 1.2 
PUTAPINFO 

GETAPINFO 
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Control statements 

CALLMACRO 

Purpose 

Menu command 

Syntax 

Parameters 

Use this command to execute a macro within another 
macro. 

None 

CALLMACRO maeroname, parameterO-9 

maeroname A string indicating which macro to execute. 

parameterO - 9 From 0 to 9 variables, literals, or expressions. 

Description Allows a macro to "call" another macro. A system 
variable $$CALLDEPTH detects if a macro is being 
called: the parameters passed are visible to the called 
macro as parameters $1- $ 9. Any changes to these 
variables are reflected in the "caller" macro. The 
system variable $$STATUS is passed back to the 
calling macro. Note: If you pass in a literal value such 
as four, it is not updated when the called macro 
returns. 

Example Within the called macro "maxes," $ top_layer and 
$top_deode are automatically defined as $1 and 
$2. When maxes ends, $top_layer and 
$ top _ de ode are updated with values of $1 and $ 2. 

MACRO test1 

END 

CALLMACRO "maxes", $top_layer, 
$top_dcode 
STRWRITE $msg,"Max:lyr=%n\ndcode=%n",\ 

$top_layer, $top_dcode 
MESSAGEBOX "MAX Info", $msg, a 

MACRO maxes 

END 

# $1 is synonym for $top_layer 
SET $1 = $$MAXLAYERS + 1 
REPEAT $$STATUS == $$FALSE 

END 

CALC $1 = $1 - 1 
ACTIVELAYER $1 

# $2 is synonym for $top_dcode 
CALLMACRO "maxuseddcode", $2 
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DEBUG 

Purpose 

Menu command 

Syntax 

Parameters 

exp 

Description 

Example 

To tum macro debug mode on/off. 

None 

DEBUG exp I strlit 

Chapter 8 Macros 

An expression where O=OFF and I=ON, or a string literal 
of "Y" or "N". 

Use this function to toggle debug mode on or off. When 
debug mode is on, debug information is output to a file 
named MACRO .DER - -

The following example turns debug mode on and off. 

DEBUG 1 
CALLMACRO 
DEBUG 0 

# on 
"NewMac" 
# off 
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IF 

Purpose 

Menu command 

Syntax 

Parameters 

numvar 

exp 

Description 

Example 

To conditionally execute blocks of macro commands. 

None 

IF [numvar ] exp 

An optional numeric variable that receives the result of the 
expression on the right side of the equal sign. 

An expression indicating whether the macro statements 
between the IF and the corresponding ELSE or END 
statement will be executed. 

This function is used when you need to execute a block of 
macro statements only when a certain condition exists. 

The following example shows two IF statements, one 
IF /ELSE/END trio and a nested IF/END pair. 

GETSTRING "Enter your name", $name 
STRLEN $name 
IF $$STATUS == 0 

#this block only executed if the 
#variable $$STATUS is equal to 0 
STOP "Bad Username" 

ELSE 

#this block only executed if the 
#variable $$STATUS is NOT equal to 0 
GETSTRING "Enter your passwd", $passwd 
STRCMP $passwd, "dilbert" 
IF $$STATUS 1= 0 

END 

END 

#this block only executed if the 
#variable $$STATUS NOT equal to 0 
STOP "Bad Passwd" 
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REPEAT 

Purpose 

Menu command 

Syntax 

Parameters 

numvar 

exp 

Description 

Example 

Chapter 8 Macros 

Repeats a series of macro commands until the test 
condition becomes false. 

None 

REPEAT [numvar ] exp 

An optional numeric variable that receives the result of the 
expression on the right hand side of the equal sign. 

An expression indicating whether the macro statements 
between the REPEAT and the corresponding END 
statement will be executed. 

This function executes a block of macro statements 
repeatedly while a certain condition exists. As long as the 
test condition is not zero, the commands between the 
REPEAT and END are executed repeatedly. 

The following macro continues to prompt you for a text 
string as long as a blank string isn't entered. 

SET $cnt = 1 
GETSTRING "Enter a component", $comp 
STRLEN $name 
REPEAT $$STATUS 1= 0 

END 

FILEWRITE $fid, \ 
"COMP%.On: %8", \ 
$cnt, $comp 

CALC $cnt = $cnt + 1 
GETSTRING "Enter a component", Scamp 
STRLEN $name 
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STOP 

Purpose 

Menu command 

Syntax 

Parameters 

message 

Description 

Example 

Causes the macro to stop. 

None 

STOP [message] 

An optional string variable or string literal giving a 
message that is presented to you when the macro is 
stopped. 

This command causes the macro to stop. 

The following example stops a macro if you enter "no." 

GETYESNO "Qui t? ", $val ue 
IF $value == $$YES 

STOP 

END 
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Database functions 

COPYITEM 

Purpose 

Menu command 

Syntax 

Parameters 

layer 

seqno 

dx 

dy 

Description 

Example 

See also 

Chapter 8 Macros 

Use this command to copy an item in a Gerber database. 

Copy (Edit menu) 

COPYITEM layer, seqno, dx, dy 

An expression representing the layer containing the item to 
copy. 

An expression representing the sequence number of the 
item to copy. 

An expression representing the offset to apply to the x 
coordinate of the object. 

An expression representing the offset to apply to the y 
coordinate of the object. 

Use this function to copy Gerber items in a layer. It takes 
the layer and sequence number of the object you want to 
copy. The sequence number used is the same as that 
returned by the menu command Item Info or the macro 
command GETFIRSTITEM. This function returns 
$$TRUE in the $$ST ATUS variable it the command was 
successful and $$F ALSE if it was not. 

The following example scans a layer and copies all flashes 
1 inch to the left. 

GETFIRSTITEM $layer, $seqno, $net, \ 
$dcode,$type, $x, $y, \ 
$x2, $y2,$dia,$cw 

REPEAT $$STATUS != $$FALSE 

END 

IF $type == $$FLASH 

END 

COPYITEM $layer, $seqno, -1.0, a 
GETNEXTITEM 

GETFIRSTITEM, GETNEXTITEM 
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DELETEITEM 

Purpose Use this command to delete an item from a Gerber database. 

Menu command Erase (Edit menu) 

Syntax DELETEITEM layer, seqno 

Parmpeters 

layer 

seqno 

Description 

Example 

See also 

An expression representing the layer containing the item to 
delete. 

An expression representing the sequence number of the item 
to delete. 

Use this function to delete Gerber items from a layer. It takes 
the layer and sequence number of the object you want to 
delete. The sequence number used is the same as that 
returned by the menu command Item Info or the macro 
command GETFIRSTITEM. This function returns $$TRUE 
in the $$ST ATUS variable it the deletion was successful and 
$$F ALSE if it was not. 

The following example scans a layer and removes all flashes. 

GETFIRSTITEM $layer,$seqno,$net,$deode, \ 

$type, $x, $y, $x2, $y2, \ 
$dia, $ew 

REPEAT $$STATUS ! = $$FALSE 

IF $type == $$FLASH 
DELETEITEM Slayer, $seqno 

END 
GETNEXTITEM 

END 

GETFIRSTITEM, GETNEXTITEM 
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GETEXTENTS 

Purpose 

Menu command 

Syntax 

Parameters 

layer 

lx 

ly 

ux 

uy 

Description 

Example 

Chapter 8 Macros 

Use this command to calculate and return the extents of the 
Gerber data on anyone or all loaded layers. 

Extents (Query menu) 

GETEXTENTS layer, lx, ly, ux, uy 

An expression indicating the layer or layers you want the 
extents of 

A numeric variable that retu:r;ns the x coordinate of the 
lower left extent of the data on the requested layer(s). 

A numeric variable that returns the y coordinate of the 
lower left extent of the data on the requested layer(s). 

A numeric variable that returns the x coordinate of the 
upper right extent of the data ,on the requested layer(s). 

A numeric variable that returns the y coordinate of the 
upper right extent of the data on the requested layer(s). 

This calculates the extents of the requested layer or layers. 
If layer contains a value greater than zero, the command 
determines the extent for that layer. If the value is zero, the 
extent for all visible layers is calculated, and if -1 is used, 
the extents of all layers regardless of their visibility is 
returned. The coordinates calculated by this command are 
returned in the other four variables. 

The following example gets the extents of all the layers in 
a design and draws a box around it. 

GETEXTENTS 
ADDDRAW 

-1, $lx, $ly, $ux, $uy 
$lx,$ly,$lx,$uy,$ux,$uy, \ 
$ux,$ly, $lx, $ly 
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GETFILMBOX 

Purpose 

Menu command 

Syntax 

Parameters 

xsize 

ysize 

Description 

Example 

Use this command to return the size of the film box. 

Filmbox (Options menu) 

GETFILMBOX xsize, ysize 

A numeric variable that returns the horizontal size of the 
film box. 

A numeric variable that returns the vertical size of the film 
box. 

This function returns the size of the current film box. Since 
the lower left comer of the film box is always at coordinate 
0,0, These values can be used to determine the proper 
positioning of any Gerber information. 

The following example gets the size of the film box and 
draws a box on the active layer in the same location. 

GETFILMBOX $xs, $ys 
ADDDRAW O,O,O,$ys,xs,$ys,$xs,O,O,o 
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GETFIRSTITEM 

Purpose Use this command to retrieve information about an object in 
a Gerber layer. This function also sets up the variables 
needed for the GETNEXTITEM function. 

Menu command Item Info (Query menu) 

Syntax GETFIRSTITEM layer, seqno, net, dcode, 
type, x, y, x2, y2, dia, cw, flags 

Parameters 

layer 

seqno 

net 

dcode 

type 

x 

y 

x2 

A variable containing .the layer to scan for information. If the 
layer specified by this variable is not a valid layer, all layers 
are scanned, and the original contents of this variable is 
replaced with the layer of the item being returned. 

A variable that returns the sequence number of the item being 
scanned. An item's sequence number is its relative location in 
the Gerber file. This is the same number as that displayed in 
the command Item Info. 

A variable that returns the net id number associated with this 
item. If the item does not have a net associated with it, 
GerbTool returns -1. 

A variable that returns the D-code of the scanned item. 

A variable that returns the type of the item being scanned. 
Valid return values are $ $ FLASH and $ $ DRAW. 

A variable that returns an x coordinate for the item being 
scanned. If the object in question is of type $$FLASH, this 
value represents the coordinate of the center of the flash. If 
the variable is of type $$DRA W, it represents the x 
coordinate of one of its end points. 

A variable that returns an y coordinate for the item being 
scanned. If the object in question is of type $$FLASH, this 
value represents the coordinate of the center of the flash. If 
the variable is of type $$DRA W, it represents the y 
coordinate of one of its end points. 

A variable that returns the x coordinate of the second end 
point for lines. These are Gerber items that return a type of 
$ $DRAW. If the type of an item is $ $ FLASH, this variable is 
not used. 
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y2 A variable that returns the y coordinate of the second end 
point for lines. These are Gerber items that return a type of 
$$DRAW. If the type of an item is $ $ FLASH, this variable is 
not used. 

dia A variable that returns the diameter of a Gerber arc. If the 
object being scanned is not an arc, the value 0.0 is returned. 

ew 

flags 

Description 

Example 

See also 

A variable that returns $$TRUE if the item being scanned is 
drawn in a clockwise direction, and $$FALSE if it is drawn 
in a counter-clockwise direction. If the item being scanned is 
not an arc, this variable is not used. 

A variable that returns the flags value for the current item. 
This parameter is currently used to indicate TOP (2048) or 
BOTTOM (4096) of the test point layer items. This 
parameter may have more uses in the future. 

Use this function to scan loaded Gerber files for information. 
When called, it examines the layer and seqno parameters for 
valid data. If they are valid, the specified items are loaded 
into the variables described above. If not, the first item in the 
first loaded layer is returned. To move to the next item, use 
the GETNEXTITEM command, which uses the variables 
initialized by this command. If this command is unable to 
fmd a Gerber item on this layer, a status of $ $ FALSE is 
returned, otherwise $$TRUE is returned. 

The following example uses the GETFIRSTITEM and 
GETNEXTITEM commands to loop through all of the items 
on the layer represented by $layer. When there are no more 
items left on the layer, $$STATUS will return $$FALSE 
and the repeat loop will stop. 

GETFIRSTITEM $layer,$seqno,$net,$deode, \ 
$type, $x, $y, $x2, $y2, $dia, $ew 

REPEAT $$STATUS != $$FALSE 
... process data here ... 

GETNEXTITEM 

END 

GETNEXTITEM 

) 
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GETLAYER 

Purpose 

Menu command 

Syntax 

Parameters 

layer 

fn 

ln 

an 

vis 

fe 

de 

type 

polarity 

key 

ft 

Chapter 8 Macros 

Use this command to obtain information about a GerbTool 
layer (Gerber file). 

Edit (Layers menu) 

GETLAYER layer, fn, ln, an, vis, fe, 
dc, type, polarity, key, ft, lx, ly, 
ux, uy, netid 

A numeric variable containing the layer to obtain the 
information for. Note: A variable must be used. 

A string variable that returns the Gerber filename 
associated with this layer. 

A string variable that returns the layer name associated 
with this layer. This variable is only used on extended 
Gerber files. 

A string variable that returns the name of the aperture list 
associated with this layer. 

A numeric variable that returns the visibility of the layer. 
The possible values are: O=OFF, l=ON, 2=REF. 

A string variable that returns the color of the flashes on this 
layer. 

A string variable that returns the color of the draws on this 
layer. 

A numeric variable that returns the layer type of this layer. 
The possible values are: O=TOP, I =INNER, 2=BOTTOM, 
3=PLANE, 4=COMPOSITE, 5=OTHER. 

A numeric variable returning the polarity of this layer. The 
possible values are O=ciear, 1 =dark. This variable is only 
used on extended Gerber files. 

A numeric variable that returns the key value associated 
with this layer. This variable is only used on extended 
Gerber files. 

A numeric variable that returns the type of file loaded on 
this layer. This value is currently not used. 
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lx 

ly 

ux 

uy 

netid 

Description 

Example 

A numeric variable that returns the x coordinate of the 
lower left most extent of the data on this layer. 

A numeric variable that returns the y coordinate of the 
lower left most extent of the data on this layer. 

A numeric variable that returns the x coordinate of the 
upper right most extent of the data on this layer. 

A numeric variable that returns the y coordinate of the 
upper right most extent of the data on this layer. 

A numeric variable that returns the netid value that is 
associated with this layer. 

Use this command to retrieve information about a given 
Gerber layer. This information is returned in the variables 
described above. Note that all of the variables must be 
included with this command even if they are not used. 

The following example retrieves information regarding the 
layer whose number is stored in $layer. 

GETLAYER $layer,$fn,$ln,$an,$vis, \ 
$fc,$dc,$type,$polarity, \ 
$key,$ft,$lx,$ly,$ux, $uy,$netid 
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GETNEXTITEM 

Purpose Use this command to retrieve information about an object in 
a Gerber layer. This function is used in conjunction with the 
GETFIRSTITEM function. 

Menu command Item Info (Query menu) 

Syntax GETNEXTITEM 

Parameters None 

Description Use this function along with GETFIRSTITEM to scan loaded 
Gerber files for information. GETFIRSTITEM must be 
called first in order to setup the variables and retrieve the first 
item. When GETNEXTITEM is called, the information for the 
next Gerber object on the layer is placed into the same 
variables that were created and used by the GETFIRSTITEM 

command, and the $$STATUS variable is set to $$TRUE. 

When there are no more objects to process, a status of 
$$FALSE will be returned. 

Example 

See also 

The following example uses the GETFIRSTITEM and 
GETNEXTITEM commands to loop through all of the items 
on the layer represented by $layer. When there are no more 
items left on the layer, $ $ STATUS will return $$FALSE and 
the repeat loop will stop. 

GETFIRSTITEM $layer,$seqno,$net,$dcode, \ 
$type, $x, $y, $x2, $y2, $dia, $cw 

REPEAT $$STATUS != $$FALSE 
... process data here ... 

GETNEXTITEM 

END 

GETFIRSTITEM 
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GETUSERDATA 

Purpose Use this command to obtain the UserData field for a specific 
database item. 

Menu command Item Info (Query menu) or Item (Edit menu) 

Syntax GETUSERDATA [layer, seqno userdatal 

Parameters 

layer A numeric variable indicating the layer. 

seqno A numeric variable indicating the sequence number of the 
item. 

userdata A string variable that will receive the UserData from the 
specified database item. 

Description Use this function to locate the specified item and copy its 
UserData field to the specified string variable. Specify the 
parameters for this function on the first call to 
GETUSERDATA. You can omit them thereafter. The 
variables used for the layer and seqno parameters are 
usually those used in a GETFIRSTITEM/GETNEXTITEM 
loop. 

Example 

See also 

The following example scans the active layer allowing you to 
edit the UserData field of each item. 

MACRO getuserdata 

SET $lyr = $$ACTIVELAYER 
SET $seqno = 0 
STRSET $user, "" 

GETUSERDATA $lyr, $seqno, $user 
GETFIRSTITEM $lyr,$seqno,$net,$dcode,\ 

$type, $x, $y, $x2, $y2, $d 
REPEAT $$STATUS 

GETUSERDATA 

END 

GETSTRING "Edit UserData:", $user 
GETNEXTITEM 

ENDMACRO 

PUTUSERDATA, GETFIRSTITEM, GETNEXTITEM 
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GETVIEWEXTENTS 

Purpose 

Menu command 

Syntax 

Parameters 

lowerx 

lowery 

upperx 

uppery 

Description 

Example 

Use this command to obtain the extents of the current 
viewing window. 

None 

GETVIEWEXTENTS lowerx, lowery, upperx, 
uppery 

A numeric variable that receives the lower left X limit. 

A numeric variable that receives the lower left Y limit. 

A numeric variable that receives the upper right Y limit. 

A numeric variable that receives the upper right Y limit. 

This function returns the extents of the current viewing 
window in the four numeric variables specified. 

The following example gets the size extents of the current 
view window and then zooms in at its center. 

GETVIEWEXTENTS $lx, $ly, $ux, $uy 
CALC $tx $ux - $lx 
CALC $ty $uy - $ly 
CALC $tx $tx / 2 
CALC $ty $ty / 2 
CALC $tx $lx + $tx 
CALC $ty $ly + $ty 
ZOOMIN $tx, $ty 
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MOVEITEM 

Purpose Use this command to move a selected item in a Gerber 
database. 

Menu command Move (Edit menu) 

Synmx MOVEITEM layer, seqno, dx, dy 

Parameters 

layer 

seqno 

dx 

dy 

Description 

Example 

See also 

An expression representing the layer containing the item to 
move. 

An expression representing the sequence number of the item 
to move. 

An expression representing the amount of offset to apply to 
the x coordinate of the object. 

An expression representing the amount of offset to apply to 
the y coordinate of the object. 

Use this function to move Gerber items in a layer. It takes the 
layer and sequence number of the object you want to move. 
The sequence number used it the same as that returned by the 
Item Info command on the Query menu or the macro 
command GETFIRSTITEM. This function returns $$TRUE 
in the $$STATUS variable if the move was successful and 
$$FALSE if it was not. 

The following example scans a layer and moves all flashes 1 
inch to the right. 

GETFIRSTITEM $layer,$seqno,$net,$dcode, \ 
$type, $x, $y, $x2, $y2, $dia, $cw 

REPEAT $$STATUS !=$$FALSE 

END 

IF $type == $$FLASH 
MOVEITEM $layer, $seqno, 1.0, a 

END 
GETNEXTITEM 

GETFIRSTITEM 
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PUTUSERDATA 

Purpose Use this command to update the UserData field for a specific 
database item. 

Menu command Item (Edit menu) 

Syntax PUTUSERDATA [layer, seqno, userdata] 

Parameters 

layer 

seqno 

A numeric variable indicating the layer. 

A numeric variable indicating the sequence number of the 
item. 

userdata A string variable that will be used to update the UserData in 
the specified ~atabase item. 

Description This function locates the specified item and copies the string 
from the userdata parameter into its UserData field. The 
above parameters should be specified on the- first call to 
GETUSERDATA but can thereafter be omitted. The variables 
used for the layer and seqno parameters are usually those 
used in a GETFIRSTITEM/GETNEXTITEM loop. 

Example 

See also 

The following example scans the active layer initializing the 
UserData field of each item. 

MACRO putuserdata 

SET $lyr = $$ACTIVELAYER 
SET $seqno = 0 
SET Sent = 0 
STRSET $user, "" 

GETUSERDATA $lyr, $seqno, $user 
GETFIRSTITEM $lyr,$seqno,$net,$deode,\ 

$type, $x, $y, $x2, $y2, $d 

REPEAT $$STATUS 

CALC Sent = Sent + 1 
STRWRITE $user, "U%.On", Sent 
PUTUSERDATA 
GETNEXTITEM 

END 

ENDMACRO 

GETUSERDATA, GETFIRSTITEM, GETNEXTITEM 
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Editing functions 

ALIGNLAYERS 

Purpose 

Menu command 

Syntax 

Parameters 

x, y 

Description 

Example 

Usd this command to align Gerber layers based on 
common items. 

Align (Edit menu) 

ALIGNLAYERS [x, y ... ] 

A variable number of parameters specifying the 
coordinates of common objects to align. 

Use this function to align Gerber layers that no longer 
share a common origin. The first coordinate represents the 
location on a reference layer of an item to which you want 
to align all of the other layers. The remainder of the 
coordinates represent the locations of objects on other 
layers that you want to align to the first specified object. 

The following example performs a layer alignment of two 
layers. The location of the reference object is at 0,0. The 
location of the object on the second layer has been 
calculated, and is located in the variables $x, $y. 

ALIGNLAYERS 0, 0, $x, $y 
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CLIP 

Purpose 

Menu command 

Syntax 

Parameters 

BY 

BOUNDARY 

DCODE 

LAYER 

GO 

Description 

Chapter 8 Macros 

This command allows a macro to erase items, allowing. 
clipping of lines. 

Clip (Edit menu) 

CLIP 

END 

BY 
BOUNDARY 
FLASHES 
DRAWS 
ARCS 
DCODE 
LAYER 
GO 

exp 
yesno 
yesno 
yesno 
yesno 
exp 
exp 
[xl, yl, x2, y2 ... J 

An expression indicating how to perform the clipping. 
Valid values are: l=window,2=group. 

Controls erasure of flashes straddling the window boundary. 

Indicates a D-Code filter to use for the command. If zero is 
used, all D-Codes may be affected by the command. 

Indicates a layer filter to use for the command. If zero is 
used, all visible layers may be affected by the command. 

A variable number of coordinates used by the system. 

Use this function to erase a selection of items with 
automatic clipping of lines that cross the window 
boundary. 
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Example 

See also 

The following example clips all arcs using window mode. 

CLIP 

END 

By 
Boundary 
Flashes 
Draws 
Arcs 
Layer 0 
Dcode 0 

$$WINDOWMODE 
$$NO # no flashes 

$$NO 
$$NO 
$$YES 
#Erase from all visible lyrs 
#Erase all D-Codes 

GetWindow"Enter Clip Window", \ 

$lx, $ly, $ux, $uy 
GO $lx,$ly,$ux,$uy 

ERASE 
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COpy 

Purpose 

Menu command 

Syntax 

Parameters 

BY 

DCODE 

LAYER 

TOLAYER 

[Xl,yl,x2, 
y2 ... ] 

Description 

Chapter 8 Macros 

This command allows a macro to perform a copy. 

Copy (Copy menu) 

COPY 

BY exp 
BOUNDARY yesno 

FLASHES yesno 
DRAWS yesno 

ARCS yesno 
DCODE exp 

LAYER exp 
TO LAYER exp 
GO [xl, yl, x2, y2 ... ] 

END 

An expression indicating how to perform the copy. Valid 
values are: O=item, I =window, 2=group. 

An expression indicating a D-Code filter to use for the 
copy. If zero is used, all D-Codes may be affected by the 
command. 

An expression indicating a layer filter to use for the copy. 
If zero is used, all visible layers may be affected by the 
command. 

An expression indicating the layer to copy all of the 
selected objects to. Ifzero is used, the objects will be kept 
on their original layers. 

A variable number of coordinates used by the system to 
complete the command. 

Use this function to perform a copy of a number of items. 
If window mode is selected the first 2 x, y coordinate pairs 
given are used to specify the window, if item mode is used, 
the first pair is used to select the item to copy, and in group 
mode the select group i.s used and none of the coordinate 
pairs are used to select the items. The next coordinate is 
used to specify the starting location for the copy, and all 
subsequent coordinate pairs are used to specify to locations 
where the copied data is to be placed. 
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Example The following example obtains a window, obtains from 
and to locations from the user, and performs a copy. 

COPY 

END 

By 
Boundary 
Flashes 
Draws 
Arcs 
Layer 
Dcode 

$$WINDOWMODE 
$$YES 
$$YES 
$$YES 
$$YES 
o # Copy from all visible 
o # Copy all D-Codes 

GetWindow"Enter Copy Window", \ 
$lx, $ly, $ux, $uy 

GetPoint "Enter from location", \ 
$fx,$fy 

GetPoint "Enter to location", \ 
$tx,$ty 

GO $lx,$ly,$ux,$uy, \ 
$fx,$fy, $tx, $ty 
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DCEXPAND 

Purpose 

Menu command 

Syntax 

Parameters 

DCODE 

LAYER 

Description 

Example 

Chapter 8 Macros 

Use this command to expand a custom aperture into normal 
Gerber entities. 

Expand (Dcode item on the Edit menu) 

DCEXPAND 

DCODE exp 
LAYER exp 
GO 

END 

An expression indicating a D-Code filter to use when 
transcoding. If zero is used, all D-Codes may be affected 
by the command. 

An expression indicating a layer filter to use for 
transcoding. If zero is used, all visible layers may be 
affected by the command. 

This function is used to expand custom apertures into their 
basic Gerber constructs. 

The following example expands all of the custom apertures 
on all visible layers. 

DCEXPAND 

END 

LAYER 0 # Change all visible layers 
DCODE 0 # Change all D-Codes 
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DCODESCALE 

Purpose This command allows a macro to scale D-Codes in a design. 

Menu command Scale (Dc ode item on the Edit menu) 

Syntax DCODESCALE 

Parameters 

SCALE 

BY 

DCODE 

LAYER 

Description 

FIXED yesno 
SCALE exp, exp 
BY exp 
BOUNDARY yesno 
FLASHES yesno 
DRAWS yesno 
ARCS yesno 
DCODE exp 
LAYER exp 
GO [xl, yl, x2, y2 ... ] 

END 

A pair of expressions indicating the X-Y scaling factors. 

An expression indicating how to select the items to change. 
Valid values are: O=item, l=window, 2=group. 

An expression indicating a D-Code filter to use for the 
command. If zero is used, all D-Codes may be affected by the 
command. 

An expression indicating a layer filter to use for the 
command. If zero is used, all visible layers may be affected 
by the command. [xl, yl , x2, y2 ... ] . A variable 
number of coordinates used by the system to complete the 
command. 

Use this function to scale the D-codes of a number of 
selected items. If window mode is selected the first 2 x, y 
coordinate pairs given are used to specify the window, if item 
mode is used. the first pair is used to select the item to copy, 
and in group mode the select group is used and no 
coordinates need to be specified. If fixed is chosen, the values 
specified for the scale are added to the sizes of the apertures 
in question. If fixed is given the value of $ $NO, the sizes of 
the apertures are mUltiplied by the scale values. 
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The following example obtains a window's from and to 
locations from the user, and scales all of the flashes in this 
area up by 5 percent. 

DCODESCALE 

END 

FIXED 
SCALE 
BY 

BOUNDARY 

FLASHES 
DRAWS 
ARCS 

$$NO 
1.05, 1.05 

$$WINDOWMODE 
$$YES 
$$YES 
$$NO 
$$NO 

LAYER 0 #Copy from all visible layers 
DCODE 0 #Copy all D-Codes 
GETWINDOW"Enter Window", \ 

$lx,$ly,$ux,$uy 
GO $lx,$ly,$ux,$uy 
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ERASE 

Purpose 

Menu command 

Syntax 

Parameters 

BY 

DCODE 

LAYER 

GO 

Description 

This command allows a macro to erase items. 

Erase (Edit menu) 

ERASE 

BY 
BOUNDARY 
FLASHES 
DRAWS 
ARCS 
DCODE 
LAYER 
GO 

END 

exp 
yesno 
yesno 
yesno 
yesno 
exp 
exp 
[xl, yl, x2, y2 ... ] 

An expression indicating how to perform the erasure. Valid 
values are: O=item, 1 =window, 2=group. 

An expression indicating a D-Code filter to use for the 
command. If zero is used, all D-Codes may be affected by 
the command. 

An expression indicating a layer filter to use for the 
command. If zero is used, all visible layers may be affected 
by the command. 

A variable number of coordinates used by the system to 
complete the command. 

Use this function to erase a selection of items. Ifwindow 
mode is selected the first 2 x, y coordinate pairs given are 
used to specify the window, if item mode is used, the first 
pair is used to select the item to delete, and in group mode 
the select group is used and no coordinates need to be 
specified. 
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Example 

See also 
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The following example obtains a window and erases all 
arcs and draws in it. 

ERASE 

END 

CLIP 

By 
Boundary 
Flashes 
Draws 
Arcs 
Layer 0 
Dcode 0 

$$WINDOWMODE 
$$YES 
$$NO 
$$YES 
$$YES 
#Erase from all visible lyrs 
#Erase all D-Codes 

GetWindow"Enter Erase Window", \ 

$lx, $ly, $ux, $uy 
GO $lx,$ly,$ux,$uy 
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MIRROR 

Purpose 

Menu command 

Syntax 

Parameters 

This command allows a macro to mirror objects. 

Mirror (Edit menu) 

MIRROR 

DIRECTION <exp I "H" I "V"> 
CENTERED yesno 
BY byexp 
BOUNDARY , yesno 
FLASHES yesno 
DRAWS yesno 
ARCS yesno 
DCODE dcrexp 
LAYER lyrexp 
GO [xl, yl, x2, y2 ... ] 

END 

DIRECTION An expression indicating the direction of the mirroring. 

BY 

DCODE 

LAYER 

GO 

Description 

Valid values are: O=horizontal and l=vertical. Also 
acceptable are the text characters H and v. 

An expression indicating how to perform the mirror. Valid 
values are O=item, l=window,2=group. 

An expression indicating a D-Code filter to use mirroring. 
If zero is used, all D-Codes may be affected by the 
command. 

An expression indicating a layer filter to use for mirroring. 
If zero is used, all visible layers may be affected by the 
command. 

A variable number of coordinates used by the system to 
complete the command. 

Use this function to mirror a selection of items. Ifwindow 
mode is selected the first 2 x, y coordinate pairs given are 
used to specify the window, if item mode is used, the first 
pair is used to select the item to copy, and in group mode 
the select group is used and none of the coordinate pairs 
are used to select the items. If centered is set to $ $NO, the 
next coordinate specifies the center o'f rotation, otherWise 
GerbTool uses the center of the selected items. 
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The following example obtains a window from the user and 
mirrors all of the items in it. 

MIRROR 

DIRECTION 
CENTERED 
By 
Boundary 
Flashes 
Draws 
Arcs 
Layer 0 
Dcode 0 
GetWindow 

GO 

END 

o # horz 
$$YES 
$$WINDOWMODE 
$$YES 
$$YES 
$$YES 
$$YES 
# Mirror all visible layers 
# Mirror all D-Codes 
"Enter Mirror Window", \ 
$lx, Sly, $ux, $uy 
$lx, $ly, $ux, $uy 
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MOVE 

Purpose 

Menu command 

Syntax 

Parameters 

BY 

DeODE 

LAYER 

TOLAYER 

GO 

Description 

This command allows a macro to perform a move. 

Move (Edit menu) 

MOVE 

BY exp 
BOUNDARY yesno 
FLASHES yesno 
DRAWS yesno 
AReS yesno 
DeODE exp 
LAYER exp 
TOLAYER exp 
GO [xl, yl, x2, y2 ... ] 

END 

An expression indicating how to perform the move. Valid 
values are: O=item, I =window, 2=group. 

An expression indicating a D-Code filter to use for the 
move. If zero is used, all D-Codes may be affected by the 
command. 

An expression indicating a layer filter to use for the move. 
If zero is used, all visible layers may be affected by the 
command. 

An expression indicating the layer to move all of the 
selected objects to. If zero is used, the objects will be kept 
on their original layers. 

A variable number of coordinates used by the system to 
complete the command. 

Use this function to perform a move on a selection of 
items. If you select window mode, the first 2 x, y 
coordinate pairs given specify the window. If you select 
item mode, the first pair indicates the item to copy. In 
group mode, the select group is used and none of the 
coordinate pairs are used to select the items. The next 
coordinate is used to specify the starting location for the 
move, and all subsequent coordinate pairs are used to 
specify to locations where the moved data is to be placed. 
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The following example obtains a window, from and to locations 
from the user and performs a move. 

MOVE 

END 

By 
Boundary 
Flashes 
Draws 
Arcs 
Layer 0 
Dcode 0 

$$WINDOWMODE 
$$YES 
$$YES 
$$YES 
$$YES 
#Move from all visible layers 
#Move all D-Codes 

GetWindow"Enter Move Window", \ 
$lx, $ly, $ux, $uy 

GetPoint "Enter from location",$fx,$fy 
GetPoint "Enter to location", $tx, $ty 
GO $lx,$ly,$ux,$uy, $fx,$fy,$tx,$ty 

DrCAD Layout for Windows GerbTool User's Guide 151 



Chapter 8 Macros 

ORIGIN 

Purpose 

Menu command 

Syntax 

Parameters 

x, y 

Description 

Example 

Use this command to enable a macro to change the origin 
used by GerbTool. 

Origin (Edit menu) 

ORIGIN [x, y ... ] 

A variable number of coordinates representing new origins. 

Use this function to change the origin used by GerbTool. 
The origin is the 0,0 coordinate of the Gerber files and is 
always located at the lower left comer of the film box. 

The following example calculates the center of the extents 
of all visible Gerber files and moves the origin to that 
point. 

GETEXTENTS -1, $lx, $ly, $ux, $uy 
CALC $x $ux - $lx 
CALC $x $x / 2 
CALC $x $x + $lx 
CALC $y $uy - $ly 
CALC $y $y / 2 
CALC $y $y + $ly 
ORIGIN $x, $y 
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POUR 

Purpose 

Menu command 

Syntax 

Parameters 

Chapter 8 Macros 

This command allows a macro to perform a polypour. 

Pour (Add item on the Edit menu) 

POUR 

DRAWCLR exp 
FLASHCLR exp 
MINAREA exp 
TYPE exp 
LAYER exp 
HATCHLINE line, dcode, step, angle 
DCODE exp 
GO [xl, yl, x2, y2 ... ] 

END 

DRAWCLR An expression indicating the clearance that the pour must 
maintain from drawn objects. 

FLASHCLR An expression indicating the clearance the pour is to 
maintain from flashes. 

MINAREA An expression that indicates the minimum area to be filled 
by a pour. 

TYPE An expression giving the type of pour to perform. Valid 
values are: 1 =outline, 2=solid, 3=hatch. 

LAYER An expression indicating the layer to place the resulting 
polypour onto. 

DCODE An expression that represents D-Code to be used for this 
particular hatch line. 

HATCHLINE A quad of expressions indicating describing one of the 
three possible hatch lines. The first expression is a line 
number of 1-3. The remaining parameters describe the 
dcode, step size and angle of the selected hatch line. This 
parameter can be used multiple times in a single pour 
command for more complicated pour patterns. 

GO A variable number of coordinates the outline of the area to 
perform the polypour. The starting coordinate should also 
be specified at the end ofthe coordinate list in order to 
close the polygon and complete the pour. 

Description Use this function to perform a polypour. 
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Example The following example draws a doubly-nested rectangle in 
such a way that it can be filled with the cross hatch pattern set 
up for this pour. 

POUR 

END 

DRAWCLR ° . 02 
FLASHCLR 0.02 
TYPE 2 # ° OUTLINE, 

# 1 SOLID, 
# 2 HATCHED 

HATCHLINE 1, $$CURRENTDCODE, 0.35, 45 
HATCHLINE 2, $$CURRENTDCODE, 0.35, 135 
HATCHLINE 3,0,0.0,0 #only use 2 lines 
GO $olx,$oly, $olx,$ouy, $oux,$ouy, \ 

$oux,$oly, $iux,$ily, $iux,$iuy, \ 
$ilx,$iuy, $ilx,$ily, $iux,$ily, \ 
$oux,$oly, $olx,$oly 
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PURGE 

Purpose 

Menu command 

Syntax 

Parameters 

Description 

Example 

Chapter 8 Macros 

Use this command to compact the Gerber databases and 
purge the undo queue. 

Purge (Edit menu) 

PURGE 

None 

This function compacts the Gerber files that are loaded into 
GerbTool. GerbTool doesn't actually erase data from 
memory during edits, and therefore memory may become 
fragmented and less efficient. The purge command deleted 
these items from the Gerber database and removes the 
contents of the undo queue. 

The following is an example of using the undo command. 

GETYESNO "Purge?", $value 
IF $value == $$YES 

PURGE 

END 
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ROTATE 

Purpose 

Menu command 

Syntax 

Parameters 

DEGREES 

BY 

DCODE 

LAYER 

GO 

Description 

Use this function to rotate items. 

Rotate (Edit menu) 

ROTATE 

DEGREES exp 

CENTERED yesno 

BY exp 

BOUNDARY yesno 

FLASHES yesno 

DRAWS yesno 

ARCS yesno 

DCODE exp 

LAYER exp 

GO [xl, 

END 

yl, x2, y2 ... ] 

An expression indicating the number of degrees to rotate 
the selected objects in a counter clockwise direction. 

An expression indicating how to perform the rotation. 
Valid values are: O=item, 2=group. 

An expression indicating a D-Code filter to use for the 
command. If zero is used, all D-Codes may be affected by 
the command. 

An expression indicating a layer filter to use for the 
command. If zero is used, all visible layers may be affected 
by the command. 

A variable number of coordinates used by the system to 
complete the command. 

Use this function to rotate a selection of items. Ifwindow 
mode is selected the first 2 x, y coordinate pairs given are 
used to specify the window, and in group mode the select 
group is used. If CENTERED is set to $ $NO, the next 
coordinate is used to specify a pivot point. 
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The following example obtains a window and rotates all 
arcs and draws but not the flashes. 

ROTATE 

END 

DEGREES 90.0 
CENTERED $$YES 
BY $$WINDOWMODE 
BOUNDARY $$YES 
FLASHES $$NO 
DRAWS $$YES 
ARCS $$YES 
LAYER 0 
DCODE 0 
GETWINDOW"Enter Window to rotate", \ 

$lx, $ly, $ux, $uy 
GO $lx,$ly,$ux,$uy 
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SELECTCRITERIA 

Purpose 

Menu command 

Syntax 

Parameters 

BY 

DCODE 

LAYER 

Description 

Example 

This command allows a macro to modify the selection 
criteria that is used by many of the editing commands. 

All editing commands. 

SELECTCRITERA 

BY exp 
BOUNDARY yesno 
FLASHES yesno 
DRAWS yesno 
ARCS yesno 
DCODE exp 
LAYER exp 

END 

An expression that describes which items are to be 
selected. Valid values are: O=item, l=window, 2=group, 
3=layer, 4=net. 

An expression that describes the D-Code you are interested 
in operating on. Use a value of zero to enable selection of 
all D-Codes. 

An expression that describes the layer you select objects 
from. Use a value of zero to select from all visible layers. 

Use this function to set the selection criteria that is shared 
by most GerbTool editing commands. Note that since this 
is a block command, only the variables that you want to 
change need to be given when using the command. 

The following example sets the selection criteria to window 
mode, includes items that cross the window boundary, 
includes flashes, excludes draws and arcs, sets the layer to 
the value of the $layer variable, and sets the D-code to zero. 

SELECTCRITERA 

END 

BY $$WINDOWMODE 
BOUNDARY $$YES 
FLASHES $$TRUE 
DRAWS $$FALSE 
ARCS $ $ FALSE 
LAYER 
DCODE 

$layer 
o 
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SELECTGROUP 

Purpose 

Menu command 

Syntax 

Parameters 

BY 

DCODE 

LAYER 

MODE 

GO 

Description 

Chapter 8 Macros 

This commadn allows a macro to manipulate the select 
groups used in GerbTool. 

Select (Edit menu) 

SELECTGROUP 

BY exp 
BOUNDARY yesno 
FLASHES yesno 
DRAWS yesno 
ARCS yesno 
DCODE exp 
LAYER exp 
MODE exp 
GO [lx, ly, ux, uy ... ] 

END 

An expression that describes how to perform the selection. 
Valid values are: O=item, l=window, 4=net. 

An expression that describes the D-Code you are interested 
in operating on. Use a value of zero to enable selection of 
all D-Codes. 

An expression that describes the layer you select objects 
from. Use a value of zero to select from all visible layers. 

An expression that describes which action to perform on 
the select set. Valid values are: O=reset, 1 =add, 2=remove, 
3=invert. 

A variable number of variables that are used to pass 
coordinates to this command. If you are selecting by item or 
net, each pair of x, y coordinates will be used to select an 
item. If you are selecting by window, each two pair of 
coordinates will be used to determine the window the 
command will use. If you are resetting or inverting the select 
group, no coordinates need to be passed into this command. 

This function is the macro interface into the Select Group 
command of GerbTool. Note that since this is a block 
command, only the variables that you want to c:hange need 
to be given when using the command. The system variable 
$$SELGRPCNT is used to return the current number of 
items in the select group. 
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Example The following example performs a selection by window of 
all the flashes on a given layer. Note how this example also 
shows both, how only the variables to be changed need to 
be mentioned, but also how they can be called multiple 
times in the same block. 

SELECTGROUP 

By 
Flashes 
Draws 
Arcs 
Layer 

END 

REPEAT 

$$WINDOWMODE 
$ $ TRUE 
$ $ FALSE 
$$FALSE 
$layer 

$ $ TRUE 

GetWindow "Enter Component Window", \ 
$lx,$ly, $ux,$uy 

END 

SELECTGROUP 

END 

#reset the select set MODE 0 
GO 
MODE 1 #select by window 

$lx, $ly, $ux, $uy 'c GO 

160 DreAD Layout for Windows GerbTool User's Guide 



Chapter 8 Macros 

TEXT 

Purpose This command allows a macro insert text. 

Menu command Text (Add item on the Edit menu) 

Syntax TEXT 

HEIGHT exp 
WIDTH exp 
ROTATE yesno 
SLANT exp 
MIRROR yesno 
FILE string 
LINES PACE exp 
CHARS PACE exp 
GO [x, y, ... ] 

END 

Parameters 

HEIGHT An expression that describes the height of the characters in 
the text to be added. 

WIDTH An expression that describes the width of the characters in 
the text to be added. 

SLANT An expression that describes the amount of slant, in 
degrees, you want to apply to each individual character. 

FILE A string that gives the name of the file that contains the 
text to be added. 

LINESPACE An expression that gives the spacing between lines of text, 
where 1.0 represents single-spaced text, 2.0 represents 
double-spaced, and so on. 

CHARS PACE An expression that represents the spacing between 
characters in the added text, where 1.0 gives normal 
character spacing, 2.0 gives double spaces between 
characters, and so on. 

GO A variable number of coordinates specifying where to add 
the text. If more than one set of coordinates are given, the 
same text will be added to each location. 

Description This function adds text to a Gerber file. The text to be 
added is in read in from a file whose name is specified in 
the FILE variable. 
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Example The following example places a logo one-half inch in from 
the lower left comer of the board. 

GETEXTENTS -1, $lx, Sly, $ux, $uy 
CALC $lx = $lx + 0.5 
CALC $ly= $ly+ 0.5 
TEXT 

END 

HEIGHT 0.25 
WIDTH 0.25 
FILE "logo. txt" 
GO $lx, Sly 
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TRANSCODE 

Purpose 

Menu command 

Syntax 

Parameters 

NEWDCODE 

BY 

DCODE 

LAYER 

GO 

Description 

Chapter 8 Macros 

This command allows a macro to change the D-Codes of 
selected items. 

Transcode (Dcode item on the Edit menu) 

TRANS CODE 

NEWDCODE exp 
BY exp 
BOUNDARY yesno 
FLASHES yesno 
DRAWS yesno 
ARCS yesno 
DCODE exp 
LAYER exp 
GO [xl, yl, x2, y2 

END 

... ] 

An expression indicating the new D-Code that you want all 
selected items changed to. 

An expression indicating how to perform the transcode. 
Valid values are: O=item, l=window, 2=group. 

An expression indicating a D-Code filter to use when 
transcoding. If zero is used, all D-Codes may be affected 
by the command. 

An expression indicating a layer filter to use for 
trans coding. If zero is used, all visible layers may be 
affected by the command. 

A variable number of coordinates used by the system to 
complete the command. 

This function changes the apertures or trans codes a 
selection of items. If you select window mode, the first two 
x, y coordinate pairs given specify the window. If you 
select item mode, the first pair selects the item to copy. In 
group mode, the select group is used and none of the 
coordinate pairs are used to select the items. 
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Example The following example obtains a window and changes all 
of the D 1 0 flashes in the window to D 15. 

TRANS CODE 

END 

NEWDCODE 15 
By $$WINDOWMODE 
BOUNDARY $$YES 
FLASHES $$YES 
DRAWS $$NO 
ARCS $$NO 
LAYER 0 # Change all visible layers 
DCODE 0 # Change all D-Codes 

GETWINDOW"Enter Window to change", \ 
$lx, $ly, $ux, $uy 

GO $lx,$ly,$ux,$uy 
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Environment functions 

ACTIVE LAYER 

Purpose 

Menu command 

Syntax 

Parameters 

layer 

Description 

Example 

Chapter 8 Macros 

This command allows you to set the active layer. 

Active (Layers menu) 

ACTIVELAYER layer 

An expression indicating the layer to make active. 

Use this function to change the active layer inside a macro. 
The active layer is the layer where any newly created 
objects are placed. If the macro attempts to set the active 
layer to a layer that doesn't exist, the function returns 
$$FALSE, otherwise it returns $$TRUE. 

The following example loops through a number of layers, 
and adds a flash to each layer by changing the active layer 
to the value of the loop. 

SET Slayer = 0 
REPEAT Slayer <= $$MAXLAYERS 

ACTIVELAYER Slayer 
IF $$STATUS 

ADDFLASH $lx/$ly 
END 
CALC Slayer = Slayer + 1 

END 

OrCAD Layout for Windows Gerb Tool User's Guide 165 



Chapter 8 Macros 

BKCOLOR 

Purpose 

Menu command 

Syntax 

Parameters 

color 

Description 

Example 

This command allows you to set the background color on 
the screen. 

Bg Color (Options menu) 

BKCOLOR color 

A text string representing the color to set the background 
to. 

Use this function to change the color of the background 
screen. The color string can be any of the colors given in 
the color file COLORRGB, even if these colors are not 
available in GerbTool's color chooser. 

The following example sets the background color in 
GerbTool to a rather unusable color. 

MACRO TESTCOLOR 

BKCOLOR "PapayaWhip" 

ENDMACRO 
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CURRENTDCODE 

Purpose 

Menu command 

Syntax 

Parameters 

dcode 

Description 

Example 

Chapter 8 Macros 

This command allows you to set the current D-code. 

Change (Apertures menu) 

CURRENTDCODE dcode 

An expression indicating the D-code to make current. 

Use this function to change the current D-code inside a 
macro. The current D-code is the aperture with which any 
newly created objects are created. If the macro attempts to 
set the current D-code to an aperture that doesn't exist, the 
function returns $$FALSE, otherwise it returns $$TRUE. 

The following example loops through a number of layers, 
and adds a different flash to each layer by changing the 
active layer to the value of the loop, and incrementing the 
current D-code. 

REPEAT Slayer <= $$MAXLAYERS 

END 

ACT IVELAYER Slayer 
CURRENTDCODE$dcode 
IF $ $ STATUS 

ADD FLASH $lx,$ly 
END 
CALC 
CALC 

Slayer 
$dcode 

Slayer + 1 
$dcode + 1 
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EXTENSIONS 

Purpose 

Menu command 

Syntax 

Description 

Example 

Use this command to change the default file extensions 
associated with the different file types supported by 
GerbTool. 

Defaults (Options menu) 

EXTENSIONS 

END 

GERBER 
APLISTS 
DESIGNS 
DRILL 
HPGL 
POSTSCRIPT 
TOOL 
LASERJET 

string 
string 
string 
string 
string 
string 
string 
string 

Use this command to control the default file extensions that 
GerbTool will use when searching for files of a particular 
type. 

The following example modifies the default extensions. 

EXTENSIONS 

END 

GERBER 
APLISTS 
DESIGNS 
HPGL 

"Igr" 
"apr" 
"job" 
"pIt" 
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FILESPATH 

Purpose 

Menu command 

Syntax 

Parameters 

string 

Description 

Example 

Chapter 8 Macros 

Use this command to change the location where GerbTool 
looks for files. 

Defaults (Options menu) 

FILESPATH string 

A text string defining the new path. 

This function accepts a character string and uses it to 
change the path GerbTool uses to find the Gerber files it is 
working on. This can be used to change the location where 
files are to be saved or loaded from. 

The following example changes the current directory to a 
temporary one so the files can be saved there and not 
overwrite the original ones. 

FILESPATH "C:\temp\gerbers" 
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FILMBOX 

Purpose 

Menu command 

Syntax 

Parameters 

xsize 

ysize 

color 

Description 

Example 

Use this command to adjust the size and color of the film 
box. 

Film Box (Options menu) 

FILMBOX xsize, ysize, color 

An expression giving the width of the film box. 

An expression giving the height of the film box. 

A string giving the color that the film box is to be drawn 
with. 

Use this command to change the size and color of the film 
box that GerbTool displays. Since the lower left comer of 
the film box is always at the 0,0 coordinate, only the width 
and height need to be given. The color string can be any of 
the colors given in the color file COLOR.RGB, even if 
these colors are not available in GerbTool's color chooser. 

The following example sets the film box to 8.5 by 11 and 
the color of the film box to a particular color. 

FILMBOX 8.5, 11.0, "8eaGreen" 
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FLAGS 

Purpose 

Menu command 

Syntax 

Parameters 

exp 

Description 

Example 

Chapter 8 Macros 

Use this command to modifY the flags variable associated 
with a design. 

There are no menu commands to affect this setting: the 
CTRL +F shortcut key can be used, however. 

FLAGS exp 

An expression describing the value to assign to the flags 
field. 

This function modifies the system's environment flags. The 
flags field controls GerbTool settings that are either too 
infrequently used or too recently added to the system to 
have a more conventional menu access. This command is 
intended for use by software developers. The values used 
by the flags may change at any time, and improper usage 
may have unpredictable results. 

No example is provided for this function. 
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FORMAT 

Purpose 

Menu command 

Syntax 

Parameters 

FORMAT 

DIALECT 

M.N 

MODE 

Use this command to change the file format 
parameters for a specific file type. 

Format (File menu) or Edit (Layers menu) 

FORMAT string 

DIALECT string 
M.N exp, exp 
MODE string 
ZEROSUPPRESSION string 
TERMINATOR string 
CHARSET string 
METRIC yesno 
MODEL yesno 
NETS yesno 
USERDATA yesno 
GCMDS yesno 
ARCS360 yesno 
ARCSMODAL yesno 
HONORCRLF yesno 
COMMENTS yesno 

END 

The selected file type: Gerber, or Drill. 

A supported dialect such as Excellon or RS247X. 

A pair of expressions specifying the m.n of the 
specified format. 

A (Absolute) or I (Incremental). 

ZEROSUPPRESSION L (Leading), T (Trailing), or N (None). 

TERMINATOR 

CHARSET 

Description 

A string indicating which characters should be output 
at the end of every line of output when writing a file 
of this type. 

ASCII, EBCDIC, or EIA. 

Use this command to control the format of the 
specified file type. Normally, this command operates 
on a global format. To operate on a local format you 
can use this command from within a LAYERN block. 
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Example 

Chapter 8 Macros 

The following example modifies the format associated 
with the layer specified in the $lyrno variable 
regardless if it is a local or global format. 

LAYERN $lyrno 

END 

FORMAT "Gerber" 

END 

NETS $$YES 

METRIC $$NO 

MODAL $$YES 

MODE "A" 

TERMINATOR "*\r\n" 
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GRIDSIZE 

Purpose 

Menu command 

Syntax 

Parameters 

xsize 

ysize 

Description 

Example 

Using this function, you can change the size of the display 
grid. 

Options/Grid 

GRIDSIZE xsize, ysize 

An expression specifying the horizontal spacing of the 
grid. 

An expression specifying the vertical spacing of the grid. 

You can change the grid that is displayed in GerbTool. 
Note that the macros themselves do not make use of the 
grid. 

The following macro changes the grid 0.1 inches 
horizontally and 0.15 inches vertically. 

GRIDSIZE 0.1, 0.15 
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GRIDSNAP 

Purpose 

Menu command 

Syntax 

Parameters 

yesno 

Description 

Example 

Chapter 8 Macros 

Use this command to change the grid snap settings. 

Grid (Options menu) 

GRIDSNAP yesno 

Your choice of the values $$YES and $$NO. 

You can change the grid snap settings used in GerbTool. 
Note that the macros themselves do not make use of the 
grid. 

The following macro turns on grid snap. 

GRIDSNAP $$YES 
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GRIDVISIBLE 

Purpose 

Menu command 

Syntax 

Parameters 

yesno 

Description 

Example 

Use this command to to change the visibility of the 
GerbTool grid. 

Grid (Options menu) 

GRIDVISIBLE yesno 

Your choice of the values $$YES and $$NO. 

You can change the grid visibility settings used in 
GerbTool. Note that the macros themselves do not make 
use of the grid. 

The following macro turns on grid visibility. 

GRIDVISIBLE $$YES 
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HILICOLORS 

Purpose 

Menu command 

Syntax 

Parameters 

QUERY 

SELECT 

DRC 

Description 

Example 

Chapter 8 Macros 

Use this command to change the highlight colors used by 
the system. 

Defaults (Options menu) 

HILI COLORS 

END 

QUERY 
SELECT 
DRC 

color 
color 
color 

A text string indicating the color to use when highlighting 
items while using the Item Info command (Query menu). 

A text string indicating the color to use when highlighting 
items while using the Select command (Edit menu). 

A text string indicating the color to use when performing a 
DRC. 

Use this function to change the highlight colors that are 
used by the system. The color string can be any of the 
colors given in the color file COLORRGB, even if these 
colors are not available in GerbTool's color chooser. Since 
this is a block command, only the variables that you want 
to change need to be used. 

The following macro sets the color used to display DRC 
errors and select groups. 

HILI COLORS 

END 

SELECT 
DRC 

$selectColor 
"vga16magenta" 
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LAVERN 

Purpose 

Menu command 

Syntax 

Parameters 

LAYERN 

FILE 

LYRNAME 

APLIST 

Use this commadn to change the settings of a particular 
Gerber layer. 

Edit (Layers menu) 

LAYERN layer 
FILE string 
LYRNAME string 
APLIST string 
VISIBILITY exp 
FLASH COLOR string 
DRAWCOLOR string 
TYPE string 
POLARITY string 
KEY exp 
FTYPE string 
EXTENTS lx, ly, ux, uy 
NETID exp 
VIRTUAL exp 

END 

An expression indicating the layer to process. 

A text string indicating the filename to associate with this 
layer. 

A text string indicating the layer name to associate with 
this layer. 

A text string indicating the aperture list name to associate 
with this layer. 

VISIBILITY An expression used to control the visibility of this layer. 
Valid values are: 0 (off), 1 (on), and 2(ref). 

FLASHCOLOR A text string indicating the color to use when displaying 
flashes from this layer. 

DRAWCOLOR A text string indicating the color to use when displaying 
draws from this layer. 

TYPE A text string indicating the type for this layer. Valid values 
are Top, Bottom, Inner, Plane, Composite. 

POLARITY A text string indicating the polarity of this layer in 
composite formats such as extended Gerber. Valid settings 
are dark and clear. 
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KEY 

FTYPE 

EXTENTS 

NETID 

VIRTUAL 

Description 

Example 

Chapter 8 Macros 

An expression used to indicate the key field used for this 
layer in composite formats such as extended Gerber. 

A text string used to indicate the file type for this layer. 
This variable is for future expansion and as such the only 
valid value currently is Gerber. 

A quad of expressions used to set the extents of this layer. 
Note that these settings are only temporary, and can be 
changed when another function is called. 

An expression used to indicate the net id for this layer. This 
value is used to determine layer to layer netlist accuracy, 
and should not generally be modified. 

An expression used to indicate whether the layer should be 
included in a virtual panelization and step and repeat 
patterns. 

Use this function to set many of the parameters concerning 
individual layers in GerbTool. Since this is a block 
command, only the variables that you want to change need 
to be used. 

The following example obtains the visibility of a layer, 
stores it in the layers net id and then turns the visibility of 
the layer off. The stored information can then be used later 
to restore the layers visibility to its original condition. Note 
how only the variables for the information we want to 
change are included in the command. 

GetLayer $Layer,$fn,$ln,$an,$vis,$fc, \ 
$dc,$type,$pol,$key,$ft, \ 
$lx,$ly,$ux,$uy, $netid 

LAYERN $Layer #Set this layers info 

END 

Netid $vis 
Visibility 

#save true visibility 
o #turn the layers vis off 
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MAPPATH 

Purpose 

Menu command 

Syntax 

Parameters 

path 

Description 

Example 

Use this command to change the location that GerbTool 
uses to fmd aperture lists. 

None 

MAP PATH path 

A string defining the new path. 

This function accepts a character string and uses it to 
change the path GerbTool uses to find its aperture lists. 
This can be used to change the location where files are to 
be saved or loaded from. 

The following example changes directory where GerbTool 
looks for aperture lists to a temporary one. 

MA,PPATH "C:\temp\aperturs" 
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NETID 

Purpose 

Menu 
command 

Syntax 

Parameters 

exp 

Description 

Example 

Chapter 8 Macros 

Use this command to change the net id number for a layer. 

None 

NETID exp 

An expression representing the new value to set the netid to. 

Use this function to set the net ID value for the currently active 
layer. Since these values are only used internally to keep the 
layer to layer net lists in sync, there are few instances where 
you should attempt to modify this value. One thing this 
function can be used for in a macro is for storing information 
with a layer, that can be retrieved and used later. Doing this 
destroys the layer to layer netlist information however, and the 
macro writer should be sure to warn you of this fact. 

The following example obtains the visibility of a layer, stores it 
in the layers net id and then turns the visibility of the layer off. 
The stored information can then be used later to restore the 
layer's visibility to its original condition. 

GetLayer $Layer,$fn,$ln,$an,$vis,$fc,$dc, \ 
$type,$pol,$key,$ft, $lx,$ly,$ux, \ 
$uy $netid 

LAYERN $Layer # Chg settings for this lyr 

END 

Netid $vis 
Visibility 0 

# save true visibility 
# turn lyr visibility off 
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OFFSETS 

Purpose 

Menu command 

Syntax 

Parameters 

xoff 

yoff 

Description 

Example 

Use this command to change the offsets applied to files 
loaded and merged into the system. 

Offsets (File menu) 

OFFSETS xoff, yoff 

An expression describing the offset to be applied to the x 
coordinates of objects. 

An expression describing the offset to be applied to the y 
coordinates of objects. 

Use this function to apply an offset to any files loaded or 
merged into the system. 

The following example merges in a Gerber file 2 inches to 
the left and 3 inches up from where it would normally be 
located. 

OFFSETS -2.0, 3.0 
MERGEGERBER II infile. gbr" 

# reset the offsets so they will 
# not affect future merging. 

OFFSETS 0,0 
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OVERLAYMODE 

Purpose 

Menu command 

Syntax 

Parameters 

yesno 

Description 

Example 

Chapter 8 Macros 

Use this command 0 change the state of the overlay mode 
setting. 

Overlay (Options menu) 

OVERLAYMODE yesno 

Your choice of the values $$YES and $$NO. 

Use this function to change the state of the overlay mode 
that GerbTool is currently using. 

The following example turns overlay mode off. 

OVERLAYMODE $$YES 
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PREVIOUSVIEW 

Purpose 

Menu command 

Syntax 

Parameters 

Ix 

ly 

ux 

uy 

Description 

Example 

This command allows a macro to redefine the previous. 
view. 

Previous (View menu) 

PREVIOUSVIEW lx, ly, ux, uy 

An expression defining the x coordinate of the lower left 
comer of the view you are defining. 

An expression defining the y coordinate of the lower left 
comer of the view you are defining. 

An expression defining the x coordinate of the upper right 
comer of the view you are defining. 

An expression defining the y coordinate of the upper right 
comer of the view you are defining. 

This function allows a macro to redefine the previous view 
that is held internally by GerbTool. Normally this value is 
updated automatically whenever the user performs any of 
the View commands. One use of this command is to restore 
a view that was saved when first starting a macro. This 
way, once the macro has finished, the users viewing ability 
will not be changed. 

The following example sets the previous view to pre
calculated values. 

PREVIOUSVIEW $lx, $ly, $ux, $uy 
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SCALE 

Purpose 

Menu command 

Syntax 

Parameters 

xscale 

yscale 

Description 

Example 

Chapter 8 Macros 

Use this command to allow a macro to change the scale of 
a file that is loaded or merged into GerbTool. 

Offsets (File menu) 

SCALE xscale, yscale 

An expression giving the scale factor to be applied in the x 
dimension. 

An expression giving the scale factor to be applied in the y 
dimension. 

Use this command to change the scale of files that are 
loaded or merged into GerbTool. Note that this only effects 
the coordinates of the Gerber file. If you want to modify 
the sizes of apertures, you should use the DCODESCALE 
command. 

The following example merges in a Gerber file and 
increases the scale of the file by 0.5 percent in the x 
dimension. Small changes like this are often used to make 
allowances for shrinkage. 

SCALE 1.005, 0.0 
MERGEGERBER "infile.gbr" 
OFFSETS 0, a #reset the offsets so 

# they will not affect 
# future merging. 
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SHOWERRORS 

Purpose 

Menu command 

Syntax 

Parameters 

yesno 

Description 

Example 

This command controls the state of the show errors option 
in GerbTool. 

Show Errs (Options menu) 

SHOWERRORS yesno 

Your choice of the values $$YES and $$NO. 

This function controls the state of the Show errors setting 
in GerbTool. 

The following example turns on the show errors setting. 

SHOWERRORS $$YES 
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SKETCHMODE 

Purpose 

Menu command 

Syntax 

Parameters 

yesno 

Description 

Example 

Chapter 8 Macros 

Use this command to change the state of the sketch mode 
setting. 

Sketch (Options menu) 

SKETCHMODE yesno 

Your choice of the values $$YES and $$NO. 

Use this function to change the state of the sketch mode 
that GerbTool is currently using. 

The following example turns sketch mode off. 

SKETCHMODE $$NO 
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UNDO 

Purpose 

Menu command 

Syntax 

Parameters 

yesno 

Description 

Example 

This function controls the state of the system undo. 

Undo (Options menu) 

UNDO yesno 

Your choice of the values $$YES and $$NO. 

Use this function to toggle the state of the undo queue 
inside a GerbTool macro. Note that turning offundo 
destroys all of the current undo information. 

The following example disables the undo queue and 
destroys any existing undo information. 

UNDO.$$NO 
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VIEWCOMPOSITES 

Purpose 

Menu command 

Syntax 

Parameters 

yesno 

Description 

Example 

Use this command to change the setting that determines 
how Composite extended Gerber files are viewed. 

Edit (Layers menu, View composites button) 

VIEWCOMPOSITES yesno 

Your choice of the values $ $YES and $ $NO. 

Use this function to change the state of the View 
Composites setting that GerbTool is currently using. This 
setting only affects the viewing of composited extended 
Gerber files. 

The following example turns composite viewing on. 

VIEWCOMPOSITES $$YES 
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VIEWMETRIC 

Purpose 

Menu command 

Syntax 

Parameters 

yesno 

Description 

Example 

Use this command to control whether files are viewed in 
Metric or Inch units. 

Metric (Options menu) 

VIEWMETRIC yesno 

Your choice of the values $$YES and $$NO. 

This command controls whether the coordinates used to 
display the Gerber files are presented in Metric or Inch 
units. 

The following macro turns off metric mode so the files will 
be displayed in inches. 

VIEWMETRIC $$NO 
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File handling functions 

FILECLOSE 

Purpose 

Menu command 

Syntax 

Parameters 

fid 

Description 

Example 

See also 

Chapter 8 Macros 

Use this command to close a previously opened disk file. 

None 

FILECLOSE fid 

A file id returned by a previous call to FILEOPEN. 

This function closes a file that was previously opened by a 
call to FILEOPEN. 

See FILEOPEN for a example of closing a file. 

FILEOPEN, FILEREAD, FILEWRITE 
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FILEOPEN 

Purpose 

Menu command 

Syntax 

Parameters 

fid 

filename 

mode 

Description 

Example 

See also 

Use this command to open a disk file for reading or 
writing. 

None 

~ILEOPEN fid, filename, mode 

A numeric variable that will receive a file identification 
number. 

A string containing the filename of a disk file to open. 

A string containing a mode string of r for reading, w for 
writing, and a: for append. 

This function attempts to open the specified disk file in the 
mode indicated by the mode parameter. The value returned 
in the fid parameter can be used in subsequent calls to 
FILEREAD, FILEWRITE and FILECLOSE. 

WARNING: Opening a existing file in write mode will 
destroy any data that previously existed in the file. 

The following example opens a file for writing, processes 
the file, and then closes it. 

FILEOPEN $fid, "MYCMO.LOG", "w" 
.. . file processing ... 
FILECLOSE $fid 

FILECLOSE, FILEREAD, FILEWRITE 
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FILEREAD 

Purpose 

Menu command 

Syntax 

Parameters 

fid 

format 

output_ 
variables 

Description 

Example 

See also 

Chapter 8 Macros 

Use this command to read a line of data from a disk file. 

None 

FILEREAD fid,format, output_variables 

A file id returned by a previous call to FILEOPEN. 

A string describing the fields in the input line. 

A list of variables that will receive the data from the input 
line. 

This function reads a line from the input file and converts 
the data into individual string and numeric variables. The 
first parameter is the file id created by a previous call to 
FILEOPEN. The remaining parameters are exactly like 
those in the STRREAD command. 

The following example reads a line from a file and parses it 
into a string variable and two numeric variables. 

FILEREAD $fid, "%s %n %n", $ref, $x, $y 

FILEOPEN, FILE CLOSE, FILEWRITE 
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FILEWRITE 

Purpose 

Menu command 

Syntax 

Parameters 

fid 

format 

input_ 
variables 

Description 

Example 

See also 

Use this command to output a formatted string to a disk 
file. 

None 

FILEWRITE fid, format, input_variables 

A file id returned by a previous call to FILEOPEN. 

A string describing the variables that will used to construct 
the output line. 

A list of variables that will provide the data for the output 
line. . 

This function writes to the output file converting the input 
data. The first parameter is a file id created by a previous 
call to the FILEOPEN command. The remaining 
parameters are exactly like those of the STRWRITE 

command. 

The following example outputs a line to a file consisting of 
a string and two numbers. 

FILEWRITE $fid, "%s %n %n", $ref, \ 
$x + 10.5, $y 

FILEOPEN, FILECLOSE, FILEREAD 
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File merging functions 

MERGEDRILL 

Purpose 

Menu command 

Syntax 

Parameters 

filename 

Description 

Example 

See also 

Chapter 8 Macros 

Use this command to merge (import) a drill file into the 
active layer. 

Drill (Import item, File menu) 

MERGEDRILL filename 

A string defining the disk file to import. 

This function imports a NC Drill file into the currently 
active layer using the current Drill format setup. All drill 
hits become Gerber flashes appended to the active layer. 

The following example changes the active layer and then 
imports a NC Drill file. 

ACTlVELAYER $drilllayer 
MERGEDRILL $drillfile 

FORMAT,MERGEGERBER,MERGEHPGL 
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MERGEGERBER 

Purpose 

Menu command 

Syntax 

Parameters 

filename 

Description 

Example 

See also 

Use this command to merge a Gerber file into the active 
layer. 

Gerber (Merge item, File menu) 

MERGEGERBER filename 

A string defining the disk file to merge. 

This function merges a Gerber file into the currently active 
layer using the current Gerber format associated with the 
active layer. 

The following example changes the active layer and then 
merges in a NC Gerber file. 

ACTIVELAYER $mergelayer 
MERGEGERBER $newfile 

FORMAT, MERGEDRILL, MERGEHPGL 
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MERGEHPGL 

Purpose 

Menu command 

Syntax 

Parameters 

filename 

PLOTSIZE 

PEN 

GO 

Description 

Example 

See also 

Chapter 8 Macros 

To merge (import) a HPGL plot file into the active layer. 

HPGL (Import item, File menu) 

MERGEHPGL 

PLOTSIZE 
ROTATE 
PEN 
GO 

END 

filename 

string 
yesno 
exp, exp 
string 

A string defining the disk file to import. 

A string defining the expected size of the plotter that the 
input file was generated for. Use S (small) for A/B plotters 
and L (large) for c/DIE plotters. 

A pair of expressions matching a pen number to aD-Code. 

A string indicating the filename of the file to import. 

This function imports an HPGL file into the currently 
active layer using the current HPGL format setup. All data 
becomes Gerber flashes/draws on the active layer. 

The following example changes the active layer and then 
imports a HPGL file. 

ACTIVELAYER $hpgllayer 
MERGEHPGL $hpglfile 

FORMAT, MERGEDRILL, MERGEGERBER 
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Mathematical functions 

ABS 

Purpose 

Menu command 

Syntax 

Parameters 

numvar 

exp 

Description 

Example 

This function calculates the absolute value of a given 
value. 

None 

ABS numvar exp 

A numeric variable that is assigned the absolute value of 
the expression on the right hand side of the equal sign. 

The expression to take the absolute value of. 

You can calculate the absolute value of a number. This is a 
number with the negative sign removed if one exists. The 
resulting value is assigned to numvar. While the object on 
the right hand side of the equal sign can be any numeric 
expression, the value on the left of the equal sign must be a 
numeric variable. 

The following example takes the absolute value of -7.0 and 
assigns its value (7.0) to the variable $answer. 

ABS $answer = -7.0 * $zaxis 
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ARRAY 

Purpose 

Menu command 

Syntax 

Parameters 

name 

size 

Description 

Example 

See also 

Chapter 8 Macros 

Use this function to create an array of numeric variables. 

None 

ARRAY $name(size) 

The name of the variable. 

An expression indicating the size of the array. 

This function creates an array of numeric variables that can 
be accessed with one name and a index expression. 

The following example shows hoY! to fill an array of items. 

ARRAY $v(50) 

CALC $index = 1 
REPEAT $index <= 50 

END 

GETVALUE "Enter Next Value:" $val 
CALC $v($index) = $val 

STRARRAY 
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ASIN 

Purpose 

Menu command 

Syntax 

Parameters 

numvar 

exp 

Description 

Example 

This function calculates the principal value of the arcsin 
function of a given value. 

None 

ASINnumvar exp 

A numeric variable that is assigned the arcsin of expo 

An expression to take the arcsin of. 

Use this function to calculate the arcsin of a number. The 
resulting value will be assigned to numvar While the object 
on the right side of the equal sign can be either a numeric 
variable or numeric literal, the value on the left of the equal 
sign must be a numeric variable. Note that an error occurs 
if the argument is less than -1.0 or greater than 1.0. 

The following example takes the arcsin of 0.5984271 and 
assigns its value (2.5 radians) to the variable $answer. 

ASIN $answer = 0.5984271 
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ATAN 

Purpose 

Menu command 

Syntax 

Parameters 

numvar 

exp 

Description 

Example 

Chapter 8 Macros 

This function calculates the principal value of the 
arctangent function of a given value. 

None 

ATAN numvar exp 

A numeric variable that is assigned the arctangent of expo 

The expression to take the arctangent of. 

You can calculate the arctangent of a number. The 
resulting value will be assigned to numvar. While the 
object on the right side of the equal sign can be either a 
numeric variable or numeric literal, the value on the left of 
the equal sign must be a numeric variable. 

The following example takes the arctangent of -0.7470223 
and assigns its value (2.5 radians) to the variable 
$answer. 

ATAN $answer = -0.7470223 
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CALC 

Purpose 

Menu command 

Syntax. 

Parameters 

numvar 

expl 

operator 

exp2 

Description 

Example 

Use this function to perform mathematical calculation. 

None 

CALC numvar expl operator expl 

A numeric variable that is assigned the results of the 
mathematical operation. 

The first variable or literal used in the calculation. 

The mathematical operation to perform. Valid operations 
are+-/*. 

The second variable or literal used in the calculation. 

Use this function to perform mathematical calculations 
inside a macro. While the objects on the right side of the 
equal sign can be either numeric variables or numeric 
literals, the value on the left of the equal sign must be a 
numeric variable. Like any other programming language, it 
is possible for a variable to be on both sides of the equal 
sign at the same time. The result of doing this is that the 
value of the variable is first used in the calculation, and the 
answer is placed back into the variable. 

The following example takes the contents of the variable 
$size, multiplies it by 2.5 and assigns the result to the 
variable $result. 

CALC $result = $size * 2.5 
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CEIL 

Purpose 

Menu command 

Syntax 

Parameters 

numvar 

exp 

Description 

Example 

Chapter 8 Macros 

This function calculates the smallest integer not less than 
the input value. 

None 

CEIL numvar exp 

A numeric variable that is assigned the ceiling value of the 
expression on the right hand side of the equal sign. 

The expression to take the absolute value of. 

Use this function to find the largest integer value of a 
number. 

The following example takes the ceiling value of -7.658 
and assigns its value (-7.0) to the variable $answer. 

CEIL $answer = -7.658 
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CSIN 

Purpose 

Menu command 

Syntax 

Parameters 

numvar 

exp 

Description 

Example 

This function calculates the trigonometric cosin value of a 
given value. 

None 

CSIN numvar exp 

A numeric variable that is assigned the cosin ofthe 
expression. 

The expression from which the cosin is derived. 

Use this function to calculate the cosin of a number. The 
resulting value will be assigned to numvar While the object 
on the right side of the equal sign can be either a numeric 
variable or numeric literal, the value on the left of the equal 
sign must be a numeric variable. Note that this functions 
assumes the value given it is represented in radians and not 
degrees. 

The following example takes the cosin of 2.5 radians and 
assigns its value (-0.8011436) to the variable $answer. 

CSIN $answer = 2.5 
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FLOOR 

Purpose 

Menu command 

Syntax 

Parameters 

numvar 

exp 

Description 

Example 

Chapter 8 Macros 

This function calculates the largest integer not greater than 
the input value. 

None 

FLOOR numvar exp 

A numeric variable that is assigned the floor value of the 
expression on the right hand side of the equal sign. 

The expression to take the floor value of. 

Use this function to find the smallest integer value of a 
floating point number. 

The following example takes the value of -7.658 and 
assigns the integer value (-8.0) to the variable $answer. 

FLOOR $answer = -7.658 
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ROUND 

Purpose 

Menu command 

Syntax 

Parameters 

numvar 

exp 

Description 

Example 

This function calculates the nearest integer of the input 
value. 

None 

ROUND numvar exp 

A numeric variable that is assigned the nearest integer 
value of the expression on the right hand side of the equal 
sign. 

The expression to take the absolute value of. 

Use this function to round a floating point number to its 
nearest integer value. 

The following example rounds the input of7.658 and 
assigns the result of 8.0 to the variable $answer. 

ABS $answer = 7.658 
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SET 

Purpose 

Menu command 

Syntax 

Parameters 

numvar 

exp 

Description 

Example 

Chapter 8 Macros 

This function creates and assigns a value to a numeric 
variable. 

None 

SET numvar exp 

A numeric variable that is assigned the value of expo 

An expression whose value is assigned to numvar. 

Use this function to assign a value to a variable. While the 
object on the right side of the equal sign can be either a 
numeriC variable or numeric literal, the value on the left of 
the equal sign must be a numeric variable. 

The following example assigns the contents of the variable 
$val ue to the variable $var1 and the number 4.12 to the 
variable $var2. 

SET $var1 
SET $var2 

$value 
4.12 
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SETGLOBAL 

Purpose 

Menu command 

Syntax 

Parameters 

numvar 

exp 

Description 

Example 

This function creates and assigns a value to a global 
numeric variable. 

None 

SETGLOBAL numvar exp 

A numeric variable that is assigned the value of the 
expression. 

An expression whose value is assigned to numvar. 

Use this function to assign a value to a global variable. 
Global variables must be defined before any other variables 
are defined in a macro. Once set, global variables last the 
duration of your GerbTool session and are available to all 
macros. Global variables are persistent from one macro 
invocation to another. 

The following example shows some typical global variable 
assignments. 

SETGLOBAL $gvar1 
SETGLOBAL $gvar2 

1. 75 

$gvar1 * 4.12 
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SIN 

Purpose 

Menu command 

Syntax 

Parameters 

numvar 

exp 

Description 

Example 

Chapter 8 Macros 

This function calculates the trigonometric sin of a value. 

None 

SIN numvar = exp 

A numeric variable that is assigned the sin of expo 

The variable or literal to take the sin of. This value is 
assumed to be in radians. 

Use this function to take the sin of a number. The resulting 
value will be assigned to numvar. While the object on the 
right side of the equal sign can be either a numeric variable 
or numeric literal, the value on the left of the equal sign 
must be a numeric variable. Note that this functions 
assumes the value given it is represented in radians and not 
degrees. 

The following example takes the sin of 2.5 radians and 
assigns its value (0.5984721) to the variable $answer. 

SIN $answer = 2.5 

DreAD Layout for Windows GerbTool User's Guide 209 



Chapter 8 Macros 

SQRT 

Purpose 

Menu command 

Syntax 

Parameters 

numvar 

exp 

Description 

Example 

This function calculates the square root of a value. 

None 

SQRT numvar exp 

A numeric variable that is assigned the square root of expo 

The variable or literal to take the square root of. 

Use this function to take the square root of a number. The 
resulting value will be assigned to numvar While the object 
on the right side of the equal sign can be either a numeric 
variable or numeric literal, the value on the left of the equal 
sign must be a numeric variable. Attempting to take the 
square root of a negative number will result in an error. 

The following example takes the square root of 36 and 
assigns its value (6) to the variable $answer. 

SQRT $answer = 36 
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TAN 

Purpose 

Menu command 

Syntax 

Parameters 

numvar 

exp 

Description 

Example 

Chapter 8 Macros 

This function calculates' the trigonometric tangent of a 
given value. 

None 

TAN numvar exp 

A numeric variable that is assigned the tangent of expo 

The variable or literal to take the tangent of. 

Use this function to calculate the tangent of a number. The 
resulting value will be assigned to numvar While the 
object on the right side of the equal sign can be either a 
numeric variable or numeric literal, the value on the left of 
the equal sign must be a numeric variable. Note that this 
functions assumes the value given it is represented in 
radians and not degrees. Also, attempting to produce the 

tangent of odd multiples of rc/2 will produce an error. 

The following example takes the tangent of 2.5 radians and 
assigns its value (-0.7470223) to the variable $answer. 

TAN $answer = 2.5 
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Plotting functions 

PLOTHPGL 

Purpose 

Menu command 

Syntax 

Parameters 

Use this function to create an HPGL plot. 

HPGL (Plot item, Files menu) 

PLOTHPGL 

OUTFILE string 
MEDIASIZE exp, exp 
SCALE exp 
MODE string 
ROTATE yesno 
BORDER yesno 
BORDERTEXT string 
BORDERPEN exp 
PENWI DTH exp 
PENS PEED exp 
PADSONLY yesno 
GO 

END 

OUTFILE A text string specifying the name of the file to place the 
plot. 

MEDIASIZE A pair of expressions specifying the horizontal and vertical 
size of the printable area of the output media. 

OFFSETS A pair of expressions specifying the horizontal and vertical 
offsets. This can be used to position the plot at a specific 
location on the media. 

SCALE An expression specifying the scale factor to apply to the 
plot. 

MODE A string indicating the plotting mode. Choose from "S" 
(Sketch), "0" (Outline), or "F" (Fill). 

BORDERTEXT This parameter allows you to specify the text that will 
appear in the border, if borders are enabled. GerbTool 
looks for the key words $DATE, $TIME, $DESIGN and 
$PROG. NOTE: These are not variable names. If GerbTool 
finds any of these keywords they will be replaced with the 
appropriate text. All other text specified will be included in 
the border verbatim. 
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BORDERPEN An expression specifying the plotter pen to use when 
drawing the border if enabled. 

PENWIDTH An expression specifying the size of the pens used. 

PENS PEED An expression specifying the speed of the plotter pens. 

GO Executes the command using the current parameters. 

Description This function plots the currently visible layer to a HPGL 
plotter. 

Example The following example plots all loaded layers, one layer 
per output file, using a predefined plotting scale and media 
size. 

CALLMACRO "MaxLoadedLayer", $maxlyr 
SET $lyr = 1 
REPEAT $lyr <= $maxlyr 

END 

ACTIVELAYER $lyr 

IF $$STATUS 

END 

CALLMACRO II GetLayerFileName " , $lfn 

SPLITPATH $lfn, $dir, $fn, $ext 

STRWRITE $fn, "%s.%.On", $fn, $lyr 

PLOTHPGL 

END 

OUTFILE $fn 
MEDIASIZE $mediax, $mediay 
SCALE $fscale 
GO 

CALC $lyr $lyr + 1 
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PLOTPS 

Purpose 

Menu command 

Syntax 

Parameters 

Use this function to create an PostScript plot. 

PostScript (Plot item, Files menu) 

PLOTPS 

OUTFILE string 
MEDIASIZE exp, exp 
OFFSET exp, exp 
SCALE exp 
MODE string 
ROTATE yesno 
WINDOWMODE yesno 
PADSONLY yesno 
BORDER yesno 
BORDERTEXT string 
GREYSCALE yesno 
FITTOPAGE yesno 
GO 

END 

OUTFILE A text string specifying the name of the output file. 

MEDIASIZE A pair of expressions specifying the horizontal and vertical 
size of the printable area of the output media. 

OFFSETS A pair of expressions specifying the horizontal and vertical 
offsets. This can be used to position the plot at a specific 

. location on the media. 

SCALE An expression specifying the scale factor for the plot. 

MODE A string indicating the plotting mode. Choose from S 
(sketch) or F (fill). 

BORDERTEXT Use this parameter to specify the text to appear in the 
border, if borders are enabled. GerbToollooks for the key 
words $DATE, $TIME, $DESIGN and $PROG. NOTE: 
These are not variable names. If GerbTool finds any of 
these keywords they will be replaced with the appropriate 
text. All other text specified will be included in the border 
verbatim. 

GO Executes the command using the current parameters. 

Description This function plots the currently visible layer to a 
PostScript plotter. 
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Example 

Chapter 8 Macros 

The following example plots all of the visible layers using 
the FITTOPAGE option to automatically scale the image 
to the media size. 

PLOTPS 

OUTFILE 
MEDIASIZE 
OFFSETS 
FITTOPAGE 
GO 

END 

"output.ps" 
$mediax, $mediay 
0.0, 0.0 

$$YES 
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Query functions 

HILIDCODE 

Purpose 

Menu command 

Syntax 

Parameters 

DCODE 

LAYER 

Description 

Example 

You can highlight items in their database based on 
specified criteria. 

Dcode (Highlight item, Query menu) 

HILIDCODE 

FLASHES yesno 

DRAWS yesno 

ARCS yesno 

DCODE exp 

LAYER exp 

END 

An expression that describes the D-Code you are interested 
in highlighting. Use a value of zero to select all D-Codes. 

An expression that describes the layer you are interested in 
highlighting objects from. Use a value ofzero to select 
from all visible layers. 

Use this function to highlight objects on the screen that 
match the given criteria. Note that since this is a block 
command, only the variables that you want to change need 
to be given when using the command. 

The following example highlights all of the flashes on 
layer 10 that use D-Code 45. 

HILIDCODE 

FLASHES $$YES 
DRAWS $$NO 
ARCS $$NO 
DCODE 45 

LAYER 10 

END 
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HILIITEM 

Purpose 

Menu command 

Syntax 

Parameters 

layer 

seqno 

Description 

Example 

Use this command to highlight an item. 

None 

HILIITEM layer, seqno 

Chapter 8 Macros 

A numeric variable containing the layer of the item. 

A numeric variable containing the sequence number of the 
item. 

This function highlights an item using the current regular 
highlight color. The layer and seqno parameters would 
normally be returned by GETFIRSTITEM/ 
GETNEXTITEM calls. 

The following example scans the database highlighting all 
flashes. 

REPEAT $$STATUS 

END 

IF $type == $$FLASH 

HILIITEM $layer, $seqno 

END 

GETNEXTITEM 
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MEASUREE2E 

Purpose Use this function to measure the minimum distance between 
two database items. 

Menu command Edge 2 Edge (Measure item, Query menu) 

Synt~ MEASUREE2E layer, seqnol, seqno2 

Parameters 

layer 

seqnol 

seqno2 

Description 

Example 

A numeric variable containing the layer of the item. 

A numeric variable containing the sequence number of a 
item. 

A numeric variable containing the sequence number of a 
item. 

This function measures the minimum distance between two 
database items. The calculated distance is returned in the 
$$STATUS variable. The layer and seqnol/ seqno2 
parameters would normally be returned by 
GETFIRSTITEM/GETNEXTITEM calls. 

The following example scans the database measuring the 
distance between flashes. 

REPEAT $$STATUS 

END 

IF $type == $$FLASH 

END 

MEASUREE2E $layer,$seqno,$lastSeqno 

IF $$STATUS < $minDist 
STOP "Too Close!" 

END 
Calc $lastSeqno = $seqno 

GETNEXTITEM 
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String handling functions 

STRARRAY 

Purpose 

Menu command 

Syntax 

Parameters 

name 

size 

Description 

Example 

See also 

Chapter 8 Macros 

Use this function to create an array of string variables. 

None 

STRARRAY $name(size) 

The name of the variable. 

An expression indicating the size of the array. 

This function creates an array of string variables that can 
be accessed with one name and a index expression. Each 
element of the array can hold up to 256 characters. 

The following example shows how to fill an array of items. 

STRARRAY $s(50) 
CALC $index = 1 
REPEAT $index <= 50 

END 

GETSTRING "Enter Next Line:", $str 
STRCPY $s($index), $str 

ARRAY 
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STRCAT 

Purpose 

Menu command 

Syntax 

Parameters 

Use this function to concatenate two strings. 

None 

STRCAT destination, source 

destination A string variable to which the source string will be 
appended. 

source A string that will be appended to the destination string 
variable. 

Description This function copies the source string to the end of the 
destination string variable. 

Example The following example appends the string literal "400" to 
the $refdesg string variable. The value of $refdesg 
following the STRCAT function would be "U4 0 0 " . 

STRSET $refdesg, "U" 
STRCAT $refdesg, "400" 
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STRCMP 

Purpose 

Menu command 

Syntax 

Parameters 

stringl 

string2 

Description 

Example 

Chapter 8 Macros 

Use this function to determine if two strings are equal. 

None 

STRCMP stringl, string2 

A string. 

A string. 

This function compares two strings, without regard to case, 
and determines whether stringl is less than, equal or 
greater than string2. A string is less than another when 
it would come first in the ASCII collating sequence. A 
value of zero indicates that the two strings are equal. 

In the following example $$ST A TUS would contain a 
value less than zero, indicating that ONE is less than TWO. 

STRCMP "ONE", "TWO" 
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STRCPY 

Purpose 

Menu command 

Syntax 

Parameters 

Use this function to make a copy of a text string. 

None 

STRCPY destination, source 

destination A string variable that will receive a copy of the source 
string. 

source A string that will be copied into the destination string 
variable. 

Description This function copies a string variable or literal into another 
string variable. 

Example The following example sets the value of $refdes to 
"U400". 

STRCPY $refdes, "U40Q" 
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STRLEN 

Purpose 

Menu command 

Syntax 

Parameters 

string 

Description 

Example 

Chapter 8 Macros 

Use this function to calculate the number of characters in a 
string. 

None 

STRLEN string 

A string. 

This function counts the length of a string in characters. 
The calculated length is returned in the $$STATUS 
variable. 

In the following example $$STATUS would contain the 
value of 12 after executing the STRLEN function. 

STRLEN "Short string" 
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STRLOC 

Purpose 

Menu command 

Syntax 

Parameters 

source 

search 

Description 

Example 

Use this function to find an occurrence of a string within 
another string. 

None 

STRLOC source, search 

The string to search in. 

The string to search for. 

You can locate the search string anywhere within the 
source string. Iffound, the $$STATUS variable contains 
the index of the first matching character within the source 
string. 

In the following example $$STATUS contains the value 3 
after the STRLOC function is executed. 

STRSET $line, "This is a test" 
STRLOC $line, "is" 
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STRREAD 

Purpose 

Menu command 

Syntax 

Parameters 

source 

format 

output_ 
variables 

Description 

Example 

See also 

Chapter 8 Macros 

Vse this function to parse a line of text into a series of 
variables. 

None 

STRREAD source, format, 
output_variables 

A text string. 

A string describing the format of the data fields in the input 
line. 

A list of variables that will receive the data from the input 
line. 

This function reads the source string, converts the data 
according to the format string and places the converted 
data into individual string and numeric variables. The 
format string describes the position and type of each data 
field within the source string. White space characters in 
the source string are not converted and serve only to 
delimited the data fields. Within the format string %s 
matches a text string and %n matches a numeric value. 

Note: For those familiar with the C programming language, 
the format string is similar to the scanf format string, 
with %n being mapped to % f. 

The following example results in $ref containing "VI" 
$x containing 5.0, and $y containing 4.25. 

STRSET $line = "U1 5.000 4.250" 
STRSET $ref "" 
SET $x = 0 
SET $y = 0 
STRREAD $line, "%s %n %n", $ref, $x, $y 

STRWRITE 
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STRSET 

Purpose 

Menu command 

Syntax 

Parameters 

strvar 

string 

Description 

Example 

This function creates and assigns a value to a string 
variable. 

None 

STRSET strvar, string 

A string variable that is assigned the value of string. 

A string whose value is assigned to strvar. 

Use this function to assign a value to a string variable. 
While the object on the right side of the comma can be 
either a string variable or literal, the value on the left of the 
comma must be a string variable. 

The following example assigns the contents of the variable 
$val ue to the variable $varl and the number 4.12 to the 
variable $var2. 

SETSTR $varl, "This is a string" 
SETSTR $var2, $varl 
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STRSETGLOBAL 

Purpose 

Menu command 

Syntax 

Parameters 

strvar 

string 

Description 

Example 

Chapter 8 Macros 

This function creates and assigns a value to a global 
numeric variable. 

None 

STRSETGLOBAL strvar, string 

A string variable that is assigned the value of string. 

A string whose value is assigned to strvar. 

Use this function to assign a value to a global variable. 
Global variables must be defined before any other variables 
are defined in a macro. Once set, global variables last the 
duration of your GerbTool session and are available to all 
macros. Global variables are persistent from one macro 
invocation to another. 

The following example shows some typical global variable 
assignments. 

STRSETGLOBAL $gvarl, "A Global Str Var" 
STRSETGLOBAL $gvar2, $gvarl 
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STRSUB 

Purpose Use this function to copy a portion of one string to another. 

Menu command None 

Sym~ STRSUB destination, start, count, source 

Parameters 

destination A string variable that will receive the sub-string. 

start 

count 

source 

Description 

Example 

An expression indicating the index of the first character in the 
sub-string. 

An expression indicating the number of characters in the sub
string. 

A string that contains the sub-string. 

This function copies a specified portion of a string into 
another. 

In the following example $subline would contain the 
string" sub-string" after the STRSUB function executes. 

STRSET $line, "A small substring example" 
STRLOC $line, "sub" 
STRSUB $subline, $$STATUS, 10, $line 
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STRTOK 

Purpose 

Menu command 

Syntax 

Parameters 

Chapter 8 Macros 

Use this function to parse a text string into individual 
tokens. 

None 

STRTOK destination, delimiters, source 

destination A string variable that will receive the string token. 

delimi ters A string of characters that are used to separate tokens in the 
source string. 

source 

Description 

Example 

A string that contains the list of tokens or the numeric 
literalO. 

This function parses the source string for sub-strings that 
are separated by any character present in the 
delimi ters parameter. This function is meant to be 
initialized by a call with a valid source parameter. 
Subsequent calls are then made with the source 
parameter set to the numeric literal O. As long as there are 
more tokens in the source parameter, this function 
continues to return the next string token. The $$STATUS 
variable is set to the length of the returned token. A 
$$STATUS value of zero, therefore, indicates that there are 
no more tokens. 

In the following example, Sloops will contain the value 5 
when the REPEAT block completes. 

STRSET $line, "This is a token test" 
SET Sloops = 0 
STRTOK $token, " ", $line 
REPEAT $$STATUS > 0 

END 

Calc Sloops = Sloops + 1 
STRTOK $token, " ", 0 
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STRWRITE 

Purpose 

Menu command 

Syntax 

Parameters 

destination 

format 

input_ 
variables 

Description 

Example 

See also 

Use this function to output a formatted string to a string 
variable. 

None 

STRWRITE destination, format, 
input_variables 

A string variable that will receive the formatted output 
string. 

A string describing the variables that will used to construct 
the output line. 

A list of variables that will provide the data for the output 
line. 

This function writes to the destination string 
converting the input data according to the format string. 
The format string contains a combination of conversion 
specifiers and characters that will be output verbatim. The 
% character is used to indicate a conversion specifier. 
Currently only two types are supported: % s and %n. When 
a %s is found, the next string input variable is output in its 
place. Similarly, if a %n is found, it it is replaced with the 
value of the next numeric input variable. Each conversion 
specifier can be further enhanced with a precision specifier 
such as % 6 . 3 n. This indicates that the output data should 
be 6 characters wide with 3 places after the decimal point. 
For string conversions, the precision specifier allows you 
to specify a output field width such as %20s. The output is 
padded with spaces to achieve the proper width if the input 
variable is not very wide. 

Note: For those familiar with the C programming language, 
the format string is similar to the printf format string, 
with %n being mapped to % f. 

In the following example the variable $line would 
contain the value U10 10.500 5.500. 

STRWRITE $line, "%10s %6.3n %6.3n", \ 
"U10", 10.5, 5.5 

STRREAD 
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Tool functions 

DRAWNPADS 

Purpose 

Menu command 

Syntax 

Parameters 

Chapter 8 Macros 

Use this function to setup and execute the Convert Pads 
command. 

Pads (Convert item, Tools menu) 

DRAWNPADS 

NEWDCODE exp 
TOLERANCE exp 
BY exp 
BOUNDARY yesno 
DRAWS exp 
ARCS exp 
DCODE exp 
LAYER exp 
GO [lx, ly, ux, uy] ... 

END 

NEWDCODE Specifies the D-Code to replace found drawn pads. 

TOLERANCE An expression specifying the allowable tolerance to use 
when finding matching drawn pads. 

BY An expression indicating how to select items to convert. 
Valid values are: l=window,2=group. 

DCODE An expression specifying the D-Code filter. Use zero to 
operate on all D-Codes. 

LAYER An expression specifying the layer filter. Use zero to 
operate on all visible layers. 

GO An optional list of expressions describing windows that 
enclose drawn pads that are to be converted. 

Description This function converts drawn pads into flashes. 
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Example This example converts all drawn pads that match the 
example drawn pad contained in the current select group. 

DRAWNPAD 

NEWDCODE $newDcode 
TOLERANCE 0.004 
BY $$GROUPMODE 
GO 

END 
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ORe 

Purpose Use this function to setup and execute the DRC 

Menu command 

Syntax 

Parameters 

REPFILE 

PAD2PAD 

PAD2TRACE 

command. 

DRC (Tools menu) 

DRC 

REPFILE string 
PAD2PAD exp 
PAD 2 TRACE exp 
TRACE2TRACE exp 
MINFLASH exp 
MINTRACE exp 
MINRING exp 
LAYER exp 
DRILLLAYER exp 
USETOOLSIZE yesno 
WELLBEHAVED yesno 
WINDOWMODE yesno 
GO [lx, ly, ux, uy] 

END 

A string containing the filename to which the report file 
will be written. 

An expression indicating the minimum pad-to-pad 
spacing. 

An expression indicating the minimum pad-to-trace 
spacing. 

TRACE 2 TRACE An expression indicating the minimum trace-to-trace 
spacing. 

MINFLASH An expression indicating the minimum flash size 
allowed. 

MINTRACE An expression indicating the minimum trace size 
allowed. 

MINRING An expression that indicates the minimum annular ring 
allowed between drilled hole and pad size. 

LAYER An expression that indicates the layer on which to 
perform the DRC. A value of zero indicates that all 
signal layers are to be processed. 
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DRILLLAYER 

GO 

Description 

Example 

An expression that indicates the drill layer to be used 
when performing the annular ring check. 

Executes the command using the current parameters, 
using an optional quad of expressions indicating a 
window to operate on. 

This function allows the setup and execution of the 
DRC command. 

The following example executes the DRC command. 

DRC 

REPFILE "drc.rep" 
PAD2PAD 0.006 
PAD 2 TRACE 0.006 
TRACE2TRACE 0.005 
MINFLASH 0.020 
MINTRACE 0.004 
MINRING 0.010 
LAYER 0 
DRILLLAYER $drillLayer 
USETOOLSIZE $$NO 
WELLBEHAVED $$YES 
WINDOWMODE $$NO 
GO 

END 
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DRILL 

Purpose 

Menu command 

Syntax 

Parameters 

OUTFILE 

REPFILE 

SWATH 

SORT 

LAYER 

Chapter 8 Macros 

Use this function to setup and execute the Drill command. 

Drill (Tools menu) 

DRILL 

OUTFILE string 
REPFILE string 
SWATH exp 
SORT exp 
LAYER exp 
MERGELAYER exp 
WINDOWMODE yesno 
GO [lx, ly, ux, uy] 

END 

A string containing the filename to which the drill file will 
be written. 

A string containing the filename to which the report file 
will be written. 

An expression indicating the swath size. 

A string indicating the sort method: None, X, or Y. 

Indicates the layer to be used in generating the drill data. 

MERGELAYER Indicates the layer to be merged into the normal drill data. 

GO 

Description 

Uses the current parameters, using optional quad of 
expressions, to indicate a window to operate on. 

Sets up and executes the Drill command. This command 
sets the $$DRILLHITS and $$DRILLTRAVEL system 
variables, as well as returning the hit count in $$STATUS. 
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Example The following example executes the Drill command. 

DRILL 

END 

OUTFILE "final.drl" 
REPFILE "final.rep" 
SWATH 0.100 
SORT "Y" 
LAYER $drillLayer 
WINDOWMODE $$NO 
GO 
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FIXSS 

Purpose 

Menu command 

Syntax 

Parameters 

Chapter 8 Macros 

Use this function 0 setup and execute the Fix SS command. 

Fix SS (Tools menu) 

FIXSS 

END 

PADLAYER 
SILKLAYER 
SPACING 
WINDOWMODE 
GO 

exp 
exp 
exp 
yesno 
[lx,ly,ux,uy], ... 

PADLAYER An expression indicating the pad master layer. 

SILKLAYER An expression indicating the silkscreen layer. 

SPACING An expression indicating the minimum spacing allowed 
between a pad and any silkscreen data. 

GO An optional quad of expressions describing a window to 
operate on. 

Description 

Example 

This function allows the setup and execution of the Fix SS 
command. 

The following example executes the Fix SS command. 

FIXSS 

END 

PADLAYER 
SILKLAYER 
SPACING 
WINDOWMODE 
GO 

$padMaster 
$silkLayer 
0.020 
$$NO 
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NETLIST 

Purpose 

Menu command 

Syntax 

Parameters 

OUTFILE 

M.N 

GO 

Description 

Example 

Use this function to generate a internal netlist and/or output 
such a netlist to a disk file. 

Netlist (Tools menu) 

NETLIST 

END 

OUTFILE 
WELLBEHAVED 
METRIC 
M.N 
GO 

string 
yesno 
yesno 
exp, exp 
exp 

A string indicating the output filename. This parameter is 
only required when writing a netlist to disk. 

A pair of expressions specifying the m . n of the output file. 

An expression indicating whether to generate a netlist (0) 
or write an existing netlist to the output file (1) specified 
with the OUTFILE parameter. 

This function generates an internal netlist and optionally 
writes the netlist data to a disk file. 

The following example executes the Netlist command. 

NETLIST 

END 

WELLBEHAVED 
GO 0 
OUTFILE 
M.N 
METRIC 
GO 1 

$$YES 
#generate a netlist 
"final.net" 
2, 4 

$$NO 
#write netlist to file 
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PADREMOVAL 

Purpose 

Menu command 

Syntax 

Parameters 

TYPE 

LAYER 

DCODE 

GO 

Description 

Example 

Chapter 8 Macros 

Use this function to set up and execute the Pad Removal 
command. 

Pad Removal (Tools menu) 

PADREMOVAL· 

END 

TYPE 
LAYER 
DCODE 
WINDOWMODE 
GO 

string 
exp 
exp 
yesno 
[lx,ly,ux,uy], ... 

A string indicating the type of pad removal to be 
performed: I (isolated) or S (stacked). 

An expression that indicates the layer to perform the pad 
removal on. A value of zero indicates that all visible layers 
are to be processed. 

An expression indicating a D-Code filter to be used when 
considering a pad for removal. 

An optional quad of expressions describing a window to 
operate on. 

You can set up and execute the Pad Removal command. 

The following example executes the Pad Removal 
command. 

PADREMOVAL 

TYPE 

END 

LAYER 
DCODE 
WINDOWMODE 
GO 

"I" # isolated only 
$$ACTIVELAYER 
o 
$$NO 
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PANELIZE 

Purpose 

Menu command 

Syntax 

Parameters 

Use this function to setup and execute the Panelize 
command. 

Panelize (Tools menu) 

l.'lANELIZE 

ROWS exp 
COLS exp 
TABSIZE exp, exp 
VENTBORDER exp 
VENTSPACING exp, exp 
VENTDCODE exp 
VENTLAYER exp 
DOCUMENT string 
AUTOPANEL yesno 
AUTOVENT yesno 
VIRTUAL yesno 
GO [lx, ly, ux,uy] 

END 

ROWS An expression indicating the number of rows you want. 

COLS An expression indicating the number of columns you want. 

TABS I ZE A pair of expressions indicating the X and Y spacing 
between images on the panel. 

VENTSPACING A pair of expressions specifying the X and Y spacing 
between flashes in the vent pattern. 

VENTBORDER An expression indicating the spacing to maintain between 
the vent pattern and each image. 

VENTDCODE An expression that indicates the D-Code to be used in the 
vent pattern. 

VENTLAYER An expression that indicates the layer to output the vent 
pattern into. 

DOCUMENT A string containing the filename to which the report file 
will output. 

GO Executes the command using the current parameters using 
optional quad of expressions indicating a window to 
operate on. 
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Description 

Example 
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Use this function to setup and execute the GerbTool 
Panelize command. This command also sets the following 
system variables: $PANELXOFF, $PANELYOFF, 
$PANELXSPACING, $PANELYSPACING, 
$PANELROWS, $PANELCOLS. 

The following example execures the Panelize command 
using auto panel and auto vent modes. 

PANELIZE 

VENTBORDER 0.5 
VENTSPACING 0.25, 0.25 
VENTDCODE 250 
VENTLAYER $$ACTIVELAYER 
DOCUMENT "panel.rep" 
AUTOPANEL $$YES 
AUTOVENT $$YES 
VIRTUAL $$YES 
GO 

END 
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SEGMENTARCS. 

Purpose 

Menu command 

Syntax 

Parameters 

Use this function to set up and execute the Convert Circles 
command. 

Circles (Convert item, Tools menu) 

SEGMENTARCS 

END 

CHORDANGLE 
BY 
BOUNDARY 
DCODE 
LAYER 
GO 

exp 
exp 
yesno 
exp 
exp 
[xl, yl , x2 , y2 ... ] 

CHORDANGLE An expression indicating the chord angle, in degrees, to be 
used when segmenting each arc. 

BY 

DCODE 

LAYER 

GO 

Description 

Example 

An expression indicating how to select items to convert. 
Valid values are: O=item, l=window, 2=group. 

An expression specifying the D-Code filter. Use zero to 
operate on all D-Codes. 

An expression specifying the layer filter. Use zero to 
operate on all visible layers. 

An optional list of expressions describing either locations 
of arcs or windows that enclose arcs depending on the 
setting of the BY parameter. 

You can set up and execute the Panelize command. The 
converted arcs consist of a series of short line segments. 
The smoothness of the converted arcs depend on the setting 
of the CHORDANGLE parameter. The larger the chord 
angle the coarser the arc wil be. 

The following example converts all interpolated arcs that 
are in the current select group. 

SEGMENTARCS 

END 

CHORDANGLE 
BY 
GO 

.5 

$$GROUPMODE 

242 DrCAD Layout for Windows GerbTool User's Guide 



SNOMAN 

Purpose 

Menu command 

Syntax 

Parameters 

Chapter 8 Macros 

Use this function 0 set up and execute the Snoman 
command. 

Snoman (Tools menu) 

SNOMAN 

REPFILE string 
PAD2PAD exp 
PAD 2 TRACE exp 
OFFSET exp 
MINPERCENT exp 
MAXPERCENT exp 
FROMLAYER exp 
TOLAYER exp 
DCODE yesno 
GO [lx, ly,ux,uy] 

END 

REPFILE A string containing the filename to which the report file 
will be written. 

PAD 2 PAD An expression indicating the minimum pad-to-pad spacing. 

PAD 2 TRACE Indicates the minimum pad-to-trace spacing. 

OFFSET An expression indicating the host pad offset. 

MINPERCENT An expression indicating the minimum percent of host pad 
. size that a Snoman pad is allowed to be. 

MAXPERCENT An expression indicating the maximum percent of host pad 
size that a Snoman pad is allowed to be. 

FROMLAYER An expression that indicates the layer to perform the 
Snoman on. A value of zero indicates that all signal layers 
are to be processed. 

TOLAYER An expression that indicates the output layer for the 
generated Snoman pads. A value of zero indicates the 
output layer is the same as the input layer. 

DCODE An expression that indicates the D-Code filter used when 
determining which host pads to consider for generating 
Snoman pads. A value of zero indicates all D-Codes should 
be considered. 
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GO 

Description 

Example 

Executes the command using the current parameters with 
optional quad of expressions indicating a window to 
operate on. 

This function allows the setup and execution of the 
Snoman command. 

The following example executes the Snoman command. 

SNOMAN 

REPFILE "drc.rep" 
PAD 2 PAD 0.006 
PAD 2 TRACE 0.006 
OFFSET -0.005 # close hug 
MINPERCENT 40 
MAXPERCENT 80 
FROMLAYER 0 
TOLAYER 0 
DCODE 0 
WINDOWMODE $$NO 
GO 

END 
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TEARDROPS 

Purpose 

Menu command 

Syntax 

Parameters 

Chapter8 Macros 

Use this command to create a maximum material 
condition at the point of trace entry into a pad, or at T 
junctions for traces. 

Teardrops (Tools menu) 

TEARDROPS 

REPFILE string 
LAYER exp 
DCODE exp 
WINDOWMODE exp 
DELETEEXISTING yesno 
HOSTPERCENT exp 
LENGTHMULTIPLE exp 
WIDTHMULTIPLE exp 
PAD 2 TRACE exp 
TRACE2TRACE exp 
GO 

END 

REPFILE A string containing the filename to which the report file 
will be written. 

LAYER An expression indicating the layer to which GerbTool 
applies the teardrops. 

DCODE An expression that indicates the D-code filter used when 
determining which host pads to consider for generating 
teardrops. A value of zero indicates all D-codes should 
be considered. 

WINDOWMODE An expression that determines whether GerbTool applies 
teardrops to a viewing window or to the entire layer. 

DELETEXISTING Determines whether or not GerbTool deletes existing 
teardrops before performing the teardrop command. 

HOSTPERCENT An expression that determines the size of the teardrops 
as a percentage of the width of the host pad. 

LENGTHMULTIPLE An expression that specifies the "T" junction tail length. 
GerbTool calculates this value in multiples of the host 
trace diameter. The value you enter can be fractional. 
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WIDTHMULTIPLE 

PAD 2 TRACE 

TRACE2TRACE 

Description 

Example 

An expression that specifies the "T" junction tail width. 
GerbTool calculates this value in multiples of the host 
trace diameter.' The value you enter can be fractional. 

An expression that specifies the pad to trace spacing 
parameters for teardrops. 

An expression that specifies the trace to trace spacing 
parameters for teardrops. 

This function allows the setup and execution of the 
Teardrops command. 

The following example executes the Teardrops 
command. 

TEARDROPS 

REPFILE "drc.rep" 
LAYER $$ACTIVELAYER 
DCODE 0 
WINDOWMODE $$NO 
DELETEXISTING $$YES 
HOSTPERCENT 40 
LENGTHMULTIPLE .5 
WIDTHMULTIPLE .5 
PAD2TRACE 0.006 
TRACE 2 TRACE 0.006 
GO 

END 
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SPREAD 

Purpose 

Menu command 

Syntax 

Parameters 

ROWS 

COLS 

TABSIZE 

LAYER 

SORTYPE 

GO 

Description 

Example 

Chapter 8 Macros 

Use this command to set up and execute the Lyr Spread 
command. 

Lyr Spread (Tools menu) 

SPREAD 

ROWS exp 
eOLS exp 
TABSIZE exp, exp 
LAYER exp 
AUTOSPREAD yesno 
SORTTYPE exp 
GO 

END 

An expression indicating the number of rows you want. 

An expression indicating the number of columns you want. 

A pair of expressions indicating the X and Y spacing 
between images in the spread. 

An expression that indicates the layer to output the spread 
pattern into. 

An expression where O=ROW _MAJOR and 
l=COL_MAJOR sorting. 

Executes the command using the current parameters. 

This function allows the setup and execution of the Lyr 
Spread command. 

The following example executes the Lyr Spread command 
using autospread modes. 

SPREAD 

END 

SORTTYPE 0 
LAYER 
AUTOSPREAD 
GO 

#row major 
$$ACTIVELAYER 
$$YES 
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VENT 

Purpose 

Menu command 

Syntax. 

Parameters 

SPACING 

DCODE 

GO 

Description 

Example 

Use this function to set up and execute the Vent command. 

Vent (Tools menu) 

VENT 

END 

SPACING 
DCODE 
GO 

exp, exp 
exp 
[lx, ly, ux, uy] ... 

A pair of expressions indicating the spacing between the 
flashes in the generated vent pattern. 

An expression specitying the D-Code to be used in the 
generated vent pattern. 

An optional quad of expressions describing a window to 
operate on. 

You can set up and execute the Vent command. 

The following example executes the Vent command. 

VENT 

SPACING 0.100, 0.200 
DCODE $$CURRENTDCODE 
GO # go interactive 

END 
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User data entry functions 

GETPOINT 

Purpose 

Menu command 

Syntax 

Parameters 

prompt 

x 

y 

Description 

Example 

Queries you for a point. 

None 

GETPOINT prompt, x, y 

Chapter 8 Macros 

A string variable or string literal representing the prompt 
that will be shown the user when this command is run. 

A numeric variable that returns the x coordinate of the 
point entered by the user. 

A numeric variable that returns the y coordinate of the 
point entered by the user. 

You can display a message and enter a location. You can 
specify the coordinates in the same fashion as they would if 
one of the built-in GerbTool commands were querying 
them. The resulting coordinate is returned in the two 
provided variables. 

The following example queries you for a location and then 
adds a flash at that point. 

GETPOINT "where do you want a flash?", \ 
$x,$y 

ADDFLASH $x, $y 
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GETSTRING 

Purpose 

Menu command 

Syntax 

Parameters 

To prompt a user to enter a text string. 

None 

GETSTRING prompt, destination 

prompt A string containing the prompt text 

destination A string variable that will receive the user's response. 

Description You can use a macro to display a simple dialog box that 
contains a prompt message and a text field for the user to 
enter a response. 

Example The following example prompts you to enter y<?ur name. 

GETSTRING "Enter your name:", $name 
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GETWINDOW 

Purpose 

Menu 
command 

Syntax 

Parameters 

Queries you for a window. 

None 

Chapter 8 Macros 

GETWINDOW prompt, xl, yl, x2, y2 

prompt A string variable or string literal representing the prompt that 
will be shown the user when this command is run. 

xl A numeric variable that returns the x coordinate of one comer 
of the user-specified window. 

yl A numeric variable that returns the y coordinate of one comer 
of the user-specified window. 

x2 A numeric variable that returns the x coordinate of the second 
comer of the user-specified window. 

y2 

Description 

Example 

A numeric variable that returns the y coordinate of the second 
comer of the user-specified window. 

You can display a message and enter a window. You can 
specify the coordinates in the same fashion as they would if one 
of the built-in GerbTool commands were querying them. The 
resulting coordinates are returned in the four provided 
variables. 

The following example queries you for a window, and views 
that window. 

GETWINDOW "Enter window", $xl, $yl, $x2, $y2 
VIEWWINDOW $xl, $yl, $x2, $y2 
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GETVALUE 

Purpose 

Menu command 

Syntax 

Parameters 

prompt 

x 

Description 

Example 

Queries you for a numerical value. 

None 

GETVALUE prompt, value 

A string variable or string literal representing the prompt 
that will be shown the user when this command is run. 

The numeric variable that returns the user-specified value. 

This command allows you to display a message box to the 
user, and allow them to enter a numerical value The 
resulting value is returned in the provided variable. 

The following example queries you for a layer number. 

GETVALUE "which layer", $layer 
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GETYESNO 

Purpose 

Menu command 

Syntax 

Parameters 

prompt 

yesno 

Description 

Example 

Queries you for a YeslNo value. 

None 

GETYESNO prompt, yesno 

Chapter 8 Macros 

A string variable or string literal representing the prompt 
that will be shown the user when this command is run. 

A numeric variable that returns the user's choice. The 
possible values are $$YES and $$NO. 

You can display a message box and make a YeslNo 
decision. The resulting value is returned in the provided 
variable. 

The following example queries you to see if it should 
terminate the macro. 

GETYESNO "Quit? ", $value 
IF $value == $$YES 

STOP 

END 

OrCAD Layout for Windows GerbToo/ User's Guide 253 



Chapter 8 Macros 

MESSAGEBOX 

Purpose 

Menu command 

Syntax 

Parameters 

title 

message 

button 
style 

Description 

Example 

This function displays a dialog box with a title, message, 
and a choice of button labels. 

None 

MESSAGEBOX title, message, button_style 

A string containing the dialog box title. 

A string containing the dialog box message. 

An expression indicating your choice of button labels. 

You can display a dialog box with both a title and a 
message. The body of the message can contain multiple 
lines of text by separating the lines with the two characters 
\n. The button_style parameter controls which 
buttons are displayed; O=Okay, 1 =Okay/Cancel, 
2=Yes/No. The $$STATUS variable is set to 1 ($$YES) 
for Okay/Yes and 0 ($$NO) for CancellNo. 

The following example prompts you for confirmation to 
continue. 

MESSAGEBOX "MyMacro", \ 
"Found some errors\nContinue?", 2 

IF $$STATUS == $$NO 

STOP 

END 
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SETPROMPT 

Purpose 

Menu command 

Syntax 

Parameters 

cmd name 

Chapter 8 Macros 

You can control the prompts shown while running a macro. 

None 

SETPROMPT cmd_name, [cmd-prompt] 

Any type of variable, literal or expression that will be 
displayed as the command name in the prompt area. 

cmd -prompt Any type of variable, literal or expression that will be 
displayed is the command prompt. 

Description 

Example 

This command updates the prompt area. 

The following example sets the prompt bar to reflect the 
status of a variable used in a macro. 

REPEAT $counter < $maxnets 

END 

SETPROMPT "Processing net", $counter 
CALC $counter = $counter + 1 
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SHOWPROMPT 

Purpose 

Menu command 

Syntax 

Parameters 

yesno 

Description 

Example 

Use this command to enable or disable the display of 
normal GerbTool prompts and messages in the prompt bar. 

None 

SHOWPROMPT yesno 

An expression evaluating to zero for disable, otherwise 
enable. 

You can disable system prompts with this function. This 
allows some commands to run much faster, as there is less 
screen writing. 

The following example disables prompts, performs some 
time critical processing and finally turns prompts back on. 

SHOWPROMPT $$NO 
... time critical processing ... 
SHOWPROMPT $$YES 
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PAUSE 

Purpose 

Menu command 

Syntax 

Parameters 

time 

cmd name 

cmdyrompt 

Description 

Example 

This function causes the macro to pause. 

None 

Chapter 8 Macros 

PAUSE [time] [cmd_name] [cmdyrompt] 

An optional expression specifying the amount of time to 
wait in tenths of a second. 

An optional string specifying the command name portion 
of the prompt. 

An optional string specifying the command prompt. 

This command causes the macro to pause, and presents 
message to the user to press any key to continue. Upon 
pressing any keyboard key, the macro continues. If the 
optional time value is included, the system waits for that 
period of time and then resumes, even if no key was 
pressed. A good use for this macro is when preparing 
demonstration macros showing how to perform some 
function. 

The following example pauses for 10 seconds or until the 
user presses a key. 

PAUSE 100, "My Cmd", "hit a key to cont" 
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Utilities and other functions 

ABORTCHECKRATE 

Purpose 

Menu command 

Syntax 

Parameters 

exp 

Description . 

Example 

This function provides control on how often a macro 
checks for user aborts. 

None 

ABORTCHECKRATE exp 

An expression indicating the check rate. 

You can control how often a macro is interrupted to check 
for a user abort. The lower the checkrate number the more 
responsive a macro is to a user's request to abort and the 
slower the macro will run. Raising the checkrate has the 
opposite effect. The default checkrate is 200. 

The following example sets the default abort check rate to 
a high value inside a database scan loop. 

# high speed, slow response 
ABORTCHECKRATE 5000 
REPEAT $$STATUS 
... da tabase processing . .. 

GETNEXTITEM 

END 

# slow speed, fast response 
ABORTCHECKRATE 10 
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CREATELAYER 

Purpose 

Menu command 

Syntax 

Parameters 

Chapter 8 Macros 

Use this function to create and/or load a new layer. 

None 

CREATELAYER layer, filename, 
ap_filename 

layer An expression evaluating to a layer number. 

filename A string containing the filename ofa Gerber file. 

ap_filename A string containing the filename an aperture list. 

Description This function creates a new layer in the currently loaded 
design. If the Gerber filename specified is found on disk, it 
will be loaded. Otherwise, an empty layer is created. If the 
layer parameter evaluates to zero, this function searches 
the layer table for the first unused layer. The actual layer 
created is returned in the $ $ STATUS variable. A return 
value less than or equal to zero indicates failure. This 
function operates similarly to normal design loading in that 
you do not need to specify an ap_filename if you 
intend to use a previously loaded aperture list. 

Example The following example creates a new unnamed layer in the 
first available empty layer and returns the new layer 
number in $$STATUS. 

CREATELAYER a, "", "" 
Calc $tempLayer = $$STATUS 
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SPLITPATH 

Purpose 

Menu command 

Syntax 

Parameters 

fullpath 

dir 

filename 

ext 

Description 

Example 

Use this function to split a complete file path specification 
into its separate directory, filename, and extension 
components. 

None 

SPLITPATH fullpath, dir, filename, ext 

A string containing a complete file path specification. 

A string variable that will receive the directory portion of 
the fullpath string. 

A string variable that will receive the filename portion of 
the fullpath string. 

A string variable that will receive the extension portion of 
the fullpath string. 

This function separates the individual components of a 
complete file path specification. 

In the following example, if $$DSNNAME contained the 
value C:\PROJECTS\JOBS\GROMMIT.GTD, then 
$filename would end up' containing the value 
GROMMIT.ZIP. 

SPLITPATH $$DSNNAME, $dir, $file, $ext 
STRWRITE $filename, "%s.zip", $file 
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SYSCMD 

Purpose 

Menu command 

Syntax 

Parameters 

command 
line 

Description 

Example 

Chapter 8 Macros 

Use this function to execute another program. 

None 

SYSCMD command line 

A string that will be passed to the host operating system for 
execution. 

You can execute external programs while GerbTool waits. 
More than a simple convenience feature, this function 
allows you to have an external program perform a 
specialized task on a file created within a GerbTool macro. 
This modifed file would then be read back into GerbTool, 
thereby extending GerbTool beyond its own limits. 

Note: This function CANNOT be used to execute a 
Windows executable even when issued from GerbTool. 

The following example shows how you can obtain a sorted 
copy data extracted from GerbTool. 

STRWRITE $cmd, "sort %s %s", $infile, $outfile 
SYSCMD $cmd 
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Viewing functions 

REDRAW 

Purpose 

Menu command 

Syntax 

Parameters 

Description 

Example 

Use this function to redraw the screen. 

Redraw (View menu) 

REDRAW 

None 

This command causes the screen to redraw. The scale or 
viewing positions are not changed. 

The following example changes the prompt to inform you 
that some calculations have been finished, and then 
performs a redraw so you can seethe results. 

SETPROMPT "Finished", $count 
REDRAW 
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VIEWALL 

Purpose 

Menu command 

Syntax 

Parameters 

Description 

Example 
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Use this function to view the extents of all visible layers. 

All (View menu) 

VI EWALL 

None 

This command changes the view scale so that all of the 
Gerber layers whose visibility is turned on are displayed on 
the screen. 

The following example changes the prompt to inform you 
that some calculations have been finished, and then 
performs a VIEWALL so you can see the results. 

SETPROMPT "Finished", $count 
VI EWALL 
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VIEWFILMBOX 

Purpose 

Menu command 

Syntax 

Parameters 

Description 

Example 

Use this function to view the film box and its contents. 

Filmbox (View menu) 

VIEWFILMBOX 

None 

This command changes the view scale so that the entire 
film box and its contents are displayed on the screen. 

The following example changes the prompt to inform you 
that some calculations have been finished, and then 
performs a VIEWFILMBOX so you can see the results. 

SETPROMPT "Finished", $count 
VIEWFILMBOX 
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VIEWPAN 

Purpose Use this function to set the view window in GerbTool to a 
particular location. 

Menu command Pan (View menu) 

Syntax VIEWPAN [x, y] ... 

Parameters 

x 

y 

Description 

Example 

An expression describing the x coordinate of the point to pan 
to. 

An expression describing the y coordinate of the point to pan 
to. 

This function accepts a set of coordinates and changes the 
current view such that this coordinate is placed in the center 
of the screen. This function assumes that the point you want 
to pan to is currently on the screen. If this is not the case, you 
can use the VIEWWINDOW command to change the viewing 
location of the system. 

This example takes a coordinate specified by $x, $y and pans 
to that location, changing the view window so that the entire 
screen is taken up by the 2 square inches surrounding the 
point. 

CALC $winLx $x - 1.0 
CALC $winLy $y - 1.0 
CALC $winUx $x + 1.0 
CALC $winUy $y + 1.0 

VIEWWINDOW $winLx, $winLy, $winUx, $winUy 
VIEWPAN $x, $y 
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VIEWPREVIOUS 

Purpose 

Menu command 

Syntax 

Parameters 

Description 

Example 

Use this function to cause the current view to be set to the 
state before it was last changed. 

Previous (View menu) 

VIEWPREVIOUS 

None 

This command recalls the last viewing window. This last 
viewing window is automatically saved after performing a 
view command such as ViewlWindow. 

The following example views a window whose size has 
been calculated previously, pauses 10 seconds to allow you 
to view the area, and then restores the view to its previous 
state. 

VIEWWINDOW $lx,$lx, $ux, $uy 
PAUSE 100 
VIEWPREVIOUS 
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VIEWRECALL 

Purpose 

Menu command 

Syntax 

Parameters 

location 

Description 

Example 

Chapter 8 Macros 

Use this function to cause the current view to be set to that 
stored in the specified save locations. 

Recall (View menu) 

VIEWSAVE location 

An expression giving the save location that contains the 
view. Valid locations are from I to 8. 

This command causes the current view to be changed to the 
value stored in one of the available save locations shown 
under the View/Save command, or set with the VIEWSAVE 
macro function. 

The following example saves the current view so that it can 
restore it after performing some calculations. 

VIEWSAVE 1 
... perform calculations here ... 
VIEWRECALL 1 
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VI EWSAVE 

Purpose 

Menu command 

Syntax 

Parameters 

location 

Description 

Example 

Use this function to cause the current view to be saved. 

Save (View menu) 

VIEWSAVE location 

An expression giving the save location to place this view. 
Valid locations are from 1 to 8. 

This command causes the current view to be saved in one 
of the available save locations shown under the View/Save 
command. 

The following example saves the current view so that it can 
restore it after performing some calculations. 

VIEWSAVE 1 
... perform calculations here ... 
VIEWRECALL 1 
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VIEWWINDOW 

Purpose 

Menu command 

Syntax 

Parameters 

lx 

ly 

ux 

uy 

Description 

Example 

Chapter 8 Macros 

Use this function to set the view window in GerbTool to a 
particular location. 

Window (View menu) 

VIEWWINDOW lx, ly, ux, uy 

An expression describing the lower x coordinate of the 
view window. 

An expression describing the lower y coordinate of the 
view window. 

An expression describing the upper x coordinate of the 
view window. 

An expression describing the upper y coordinate of the 
view window. 

This function accepts four values representing the lower
left and upper-right coordinates of a rectangle. GerbTool 
then performs the equivalent of a Window command 
(View menU)on this area. Since there is no guarantee that 
the coordinates provided will coincide exactly with the 
view window, some of the design outside of the specified 
rectangle may be visible. 

The following example gets the size of the film box and 
then views that area. 

GETFILMBOX $ux, $uy 
VIEWWINDOW 0, 0, $ux, $uy 
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ZOOMIN 

Purpose 

Menu command 

Syntax 

Parameters 

x 

y 

Description 

Example 

Use this function to set the view window in GerbTool to a 
particular location. 

Zoom In (View menu) 

ZOOMIN [x, y] ... 

An expression describing the x coordinate of the point to 
Zoom in around. 

An expression describing the y coordinate of the point to 
zoom in around. 

This function accepts a set of coordinates and changes the 
current view such that this coordinate is placed in the 
center of the screen and the magnification factor of the 
view is doubled. 

The following example gets the size of the film box and 
then zooms into its center. 

GETFILMBOX 
CALC 

CALC 
ZOOMIN 

$ux, $uy 
$ux = $ux / 2 
$uy = $uy / 2 
$ux, $uy 
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ZOOMOUT 

Purpose 

Menu command 

Syntax 

Parameters 

x 

y 

Description 

Example 

Chapter 8 Macros 

Use this function to set the view window in GerbTool to a 
particular location. 

Zoom Out (View menu) 

ZOOMOUT [x, y] ... 

An expression describing the x coordinate of the point to 
zoom out around. 

An expression describing the y coordinate of the point to 
zoom out around. 

This function accepts a set of coordinates and changes the 
current view such that this coordinate is placed in the 
center of the screen and the magnification factor of the 
view is decreased by half. 

The following example gets the size of the film box and 
then zooms out from its center. 

GETFILMBOX 
CALC 

CALC 
ZOOMOUT 

$ux, $uy 
$ux = $ux / 2 

$uy = $uy / 2 
$ux, $uy 
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Chapter 9 

Aperture Conversion Rule files 

In addition to providing the ability to convert most popular CAD and photoplotter 
aperture lists directly into the popular GerbTool format, you can create your own 
Aperture Conversion Rule (ACR) files for specialty, proprietary or otherwise 
unsupported aperture list formats. 

Definition of an ACR file 

An Aperture Conversion Rule (ACR) file is an ASCII file that describes a particular 
aperture list format using conversion language statements. Using a text editor, you 
can create your own ACR file that describes the expected format of your aperture 
list. Once it is read in, GerbTool can convert your new aperture list format 
automatically, just as it converts the supported aperture list formats (see Converting 
a CAD aperture list in Chapter 3: Quick start). 

Creating an ACR file 

An ACR file contains two types of statements. The first type describes the 
environment, such as the expected file extension, metric mode, number of header 
lines to skip, and so on. The second type is the actual rule statement, which is used 
to match incoming aperture list entries to corresponding GerbTool aperture shapes. 
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Chapter 9 Aperture Conversion Rule files 

The following are descriptions of the environment-type of ACR statements and their 
expected parameters, if any. 

NAME 

Syntax 

Parameters 

converter name 

Description 

Example 

VERSION 

Syntax 

Parameters 

version number 

Description 

Example 

NAME converter name 

The name of the ACR file. Should be a single 
word. 

This statement will place the parameter in the 
header of the resulting aperture list. 

The following example sets the name of the 
converter to ALLEGRO.ACR. 

NAME allegro.acr 

VERSION version number 

The version number of the ACR file. The version 
number should be a single decimal number. 

This statement will place the parameter in the 
header of the resulting aperture list. 

The following example sets the version number of 
the converter to 6. 

VERSION 6 

274 OrCAD Layout for Windows GerbTool User's Guide 



HEADER 

Syntax 

Parameters 

lines_to_skip 

Description 

Example 

SKIP 

Syntax 

Parameters 

skip_string 

Description 

Example 

Chapter 9 Aperture Conversion Rule files 

The number oflines to skip in the header of the 
aperture list. 

If this line is present, the number oflines specified 
will be skipped from the header of the aperture list 
file you are attempting to convert. This can be 
used to bypass information at the top of a file that 
you know does not contain any apertures. 

The following example instructs GerbTool to skip 
the first twenty lines of the aperture list. 

HEADER 20 

SKIP skip_string 

A text string to mark text to be skipped. 

If this line is present, all lines in the aperture list 
that start with the given character string will be 
ignored. 

The following example will allow GerbTool to 
skip over lines that begin with MOIRE. 

SKIP MOIRE 
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Syntax 

Parameters 

mode 

Description 

Example 

CUSTOM 

Syntax 

Parameters 

yesno 

Description 

Example 

DEFAULT UNITS mode 

One of $$INCH, $$MIL, or $$MM. 

If given, will cause the values read in to be 
interpreted as Inches, Mils, or Millimeters, 
depending on the value used. 

The following example sets the units mode to 
metric. 

DEFAULT UNITS $$MM 

CUSTOM yesno 

Either $$YES or $$NO. 

If set to $$YES, GerbTool will attempt to create 
custom aperture names whenever possible. 
Otherwise a Diamond shape will be substituted. 
Note: GerbTool will not create the custom 
apertures themselves, only their names in the 
aperture list. 

The following example sets the creation of custom 
apertures to off. 

CUSTOM $$NO 
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EXTENSION 

Syntax 

Parameters 

extension 

Description 

Example 

DEBUG 

Syntax 

Parameters 

mode 

Description 

Example 
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EXTENSION extension 

The default aperture list extension. 

The default extension of the aperture lists you will 
be converting with this rule file. If the value is 
entered here, you will not need to enter it when 
specifying the aperture list for conversion. 

The following example sets a default aperture list 
extension of MY A. 

EXTENSION my a 

DEBUG mode 

A value of 0, 1, or 2. 

Enables debugging infonnation to be output into 
the aperture converter's log file. If zero is used, no 
debug information will be output. If 1 is used, 
GerbTool will output debug information while 
parsing the ACR file, and if the value is set to 2, 
debug information will be output while converting 
the aperture file itself. This function is for 
advanced users and should either not be included 
or be set to zero for normal converter operation. 

The following example sets the current debug 
mode to 2. 

DEBUG 2 
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XTENSION 

Syntax 

Parameters 

dll filename 

Description 

Example 

DCODE 

Syntax 

Parameters 

mode 

Description 

Example 

# 

Syntax 

Parameters 

any_text 

Description 

Example 

XTENSION dll filename 

The name of a .DLL file that you supply. 

Causes the converter to look for the specified 
.DLL file to help in converting the aperture lists. 

The example specifies a user-supplied .DLL. 

XTENSION myapfmt.dll 

DCODE mode 

One of $$ONLINE, $$SEQUENTIAL, or 
$$GERBER_ORDER. 

Controls how D-Code values will be derived. If 
set to $$ONLINE (the default) the codes read on 
each line will be used. If $$SEQUENTIAL is 
used, lines that match the rules given will be 
assigned sequential numbers. Some aperture lists 
have their D-Codes arranged in a special non
sequential order used in certain Gerber 
photoplotters. Walcer will use this order if 
$$GERBER _ORDER is set. 

The example sets the D-Code mode to sequential. 

DCODE $$SEQUENTIAL 

# any_text 

The body of a comment. 

This symbol leads comments in an ACR file. 

The example shows a typical comment. 

# Created By A. Designer 
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The following is a description of each rule type of ACR statement and the expected 
parameters, if any. 

Syntax 

Parameters 

shape 

rule 

Description 

Example 

FORMAT_UNITS 

Syntax 

Parameters 

rule 

Description 

Example 

FORMAT_shape rule 

The possible shapes are: ROUND, SQUARE, 
RECT, OBLONG, DONUT, DIAMOND, 
OCTAGON, THERMAL, THERM45, TARGET, 
and CUSTOM. Note that this parameter should be 
combined with the FORMAT statement to form a 
single word such as FORMAT_ROUND. 

A rule for matching apertures that are to be 
mapped to a GerbTool shape aperture. 

If the rule matches a line in the aperture list being 
converted, that line will be converted into a 
GerbTool shape aperture. 

The following example will match the line: JUNK 
DlO 0.0600.060 ROUND. 

FORMAT_ROUND $skip +D$dcode 
$xsize $ysize ROUND 

FORMAT UNITS rule 

A rule for matching a line in the aperture list that 
specifies the format of the file. 

A line matching this is used to determine the 
format of the aperture list. This statement allows 
the aperture list itself to override a previous 
UNITS statement. 

The following example will match the line: 
FORMAT MM. 

FORMAT UNITS $skip $units 
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FORMAT_SPECIAL 

Syntax 

Parameters 

rule 

Description 

Example 

FORMAT SPECIAL rule 

A rule for matching lines for use by an 
XTENSION DLL. 

Does not produce a GerbTool D-Code line. It is 
used for special processing by an XTENSION
specified DLL. 

The following example will match the line: SQR . 
DlO 0.060 0.060. 

FORMAT SPECIAL SQR +D$dcode 
$xsize $ysize 

When constructing rules to match apertures, there are special keywords that you 
place in the rule that will cause GerbTool to assign the values contained in the fields 
to the corresponding GerbTool aperture list fields. These keywords are as follows: 

Keyword 

$dcode 

$xsize 

$od 

$ysize 

$id 

$rot 

$tool 

$skip 

$custom 

$units 

Meaning 

Assigned to D-Code 

Assigned to xsize 

Assigned to xsize 

Assigned to ysize 

Assigned to ysize 

Assigned to rotation 

Assigned to tool num 

Skip this field 

Use this field to make a custom aperture 

Used to determine the format of the aperture list 
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The following is a sample ACR file. 

# Aperture converter for Mentor 

NAME Mentor 

VERSION 1.0 

EXTENSION rpt 

# handle swapped X/Y columns 

XTENSION mentor.dll 

DEBUG a 

CUSTOM $$NO 

DEFAULT_UNITS $$INCH 

HEADER 1 

Chapter 9 Aperture Conversion Rule files 

FORMAT_ROUND $skip +circle +$skip +$xsize +$ysize +$rot +false +false 
+$dcode 

FORMAT_THERMAL $skip +circle +$skip +$xsize +$ysize +$rot +false +true 
+$dcode 

FORMAT_RECT $skip +rectangle +$skip +$xsize +$ysize +$rot +false +false 
+$dcode 

FORMAT SPECIAL position +Shape 

# Mentor now has multiple formats 

FORMAT_ROUND +$skip +$dcode +circle +$skip +$xsize +$ysize 

FORMAT_THERMAL +$skip +$dcode +circle +$skip +power +$xsize +$ysize 

FORMAT_RECT +$skip +$dcode +rectangle +$skip +$xsize +$ysize 

FORMAT SPECIAL Aperture position 
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Chapter 10 

Extended Gerber 

GerbTool supports the extended Gerber data format, (sometimes referred to as 
274X), developed by Gerber Systems, Inc. (GSJ). This format provides for the 
inclusion of aperture- data directly in the Gerber data files (embedded apertures), 
flexible aperture definitions and easy single file compositing. 

Embedded apertures 

R:J Note While it not necessary to understand the syntax of extended Gerber to 
manipulate Extended Gerber files within GerbTool, several examples of this syntax 
are provided below. These examples are provided to acquaint you Extended Gerber 
only. See the instruction manuals provided with your photoplotter, or contact GSI 
directly, for more information on the extended Gerber syntax. 

An extended Gerber file contains all aperture definitions necessary to plot the data, 
thereby eliminating the need for an external aperture list. An aperture is defined 
within an extended Gerber file with an AD command as follows: 

%ADD<code><macro_name>,<parameter_list>*% 

For example: 

%ADD10C,O.06XO.020% 

This example defmes D I 0 as a simple 60-mils round flash using the GSI intrinsic 
aperture macro "C." 

GerbTool allows you to edit aperture definitions using the Edit AD button within the 
Edit dialog box. See Chapter 7: Command reference for more information. 
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Aperture macros 

Aperture macros describe the size and shape of special apertures. Using aperture 
macro primitives, you can design complex aperture shapes. Each primitive describes 
a basic shape such as a circle or a line. Each primitive also specifies its polarity 
(on/off) allowing data to be removed for such features as donuts or spokes in a 
thermal. Shown below are the different primitives available. 

Number Type Parameters 

Circle on/off diameter xcenter ycenter 

20 Line-Vector on/off width xbeg ybeg xend xend rot 

21 Line-Center on/off width height xcenter ycenter rot 

22 Line-Lower left on/off width height xloc yloc rot 

4 Outline on/off count x y ... rotation 

5 Polygon on/off sides xcenter ycenter diameter rot 

Extended Gerber aperture macro primitives. 

Aperture macros are also programmable using replaceable parameters, which allow 
a macro to produce different results, depending on the aperture definition specified 
by the AD aperture definition command (explained in the preceding section). 
Replaceable parameters are indicated by a dollar sign ($) followed by a numeric 
value. The numeric value indicates the parameter's position within the AD aperture 
definition. A typical donut macro and corresponding definitions are shown below. 

%AMDONUT* 
1,1,$1,0.0,0.0* 
1,0,$2,0.0,0.0* 
% 

%ADD10DONUT,O.60XO.40% 
%ADD20DONUT,O.08XO.70% 

In the above example, D lOis defmed as a 60-mils donut with a 40-mils hole, and 
D20 is defined as a 80-mils donut with a 70-mils hole. Note that both DlO and D20 
refer to the same macro but have different sizes. 

GerbTool allows you to edit aperture macros using the Edit AM button within the 
Apertures/Edit dialog box. See Chapter 7: Command reference for more 
information. 
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Layer compositing 

With extended Gerber, a single Gerber file defines a composite image of arbitrary 
complexity. Each "layer" of data within the Gerber file is prefixed with an 
appropriate polarity command. Ordering of the layers is critical as the data is 
processed sequentially. For assistance, check the example files provided and notice 
how each layer either adds or removes from the initial image. 

GerbTool automatically creates separate layers for composite layers when reading an 
extended Gerber file and conversely creates a single file for all layers that form a 
composite when writing out data. 

Viewing composites 

Composite layers can be displayed with the V shortcut key. This nested command 
toggles composite viewing on or off. When enabled, GerbTool displays composite 
layers as they are plotted. When disabled, GerbTool displays composite layers as if 
all layers were dark (positive). You can also control composite viewing using the 
Edit dialog box. 

Converting from RS·274·0 to extended Gerber format 

In order to convert a set of standard Gerber 274D files into a single extended Gerber 
composite file, load the 274D files as you normally do and then perform the 
following steps using the Edit command (Layers menu): 

• Set the Layer Name field of each layer to a meaningful name. 

~ Tip Setting the Layer Name field to the original filename of the same layer will 
label the extended Gerber "layers" in a fashion that will be familiar to the user. 

• Decide on the filename you want to use for the new extended Gerber file and 
rename all of the Gerber filenames to this new name. It is important that each 
extended Gerber "layer" have the same filename. 

• Set the Layer Type for each of these layers to Composite. 

• Assign a polarity and a common number to the Key field for each of the 
extended Gerber "layers." For example, D I for "Dark composite number I" or 
CI for "Clear composite number I." A polarity of Dark means that the layer is 
to be displayed in the style a normal Gerber file is displayed. Clear tells 
GerbTool to display the layer using the current background color. This erases, 
or "clears," areas from an image that were previously drawn by a "dark" layer. 

, Set negative layers to clear. 

Fb Note The common number portion of the Key field allows GerbTool to load 
multiple extended Gerber composite files at the same time. Each set of layers within 
an extended .Gerber file should have a common number assign to the Key field. 

OrCAD Layout for Windows GerbTool User's Guide 285 



Chapter 10 Extended Gerber 

• . Click on the Edit button within the File Format group box. Change the Dialect 
field to extended Gerber (274X). 

• Save the composite file using the Save command (File menu). All the layers will 
all be written into a single extended Gerber file with the name that you 
specified, along with an embedded aperture list. 

To load this new extended Gerber composite file into another design, enter its 
filename into the Filename field as you would with any other Gerber file, making 
sure the file format has been set to extended Gerber (274X). There is no need to load 
in an aperture list as it is included in the file. 
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Chapter 11 

Using custom apertures 

Using GerbTool, you can create custom apertures. A custom aperture is nothing 
more than a Gerber file, and can therefore be of virtually any size or shape. This 
chapter details the steps for creating a custom aperture. 

Create a custom aperture 
m Using the Format command (Files menu), set the Gerber format to Inch, 

absolute, 2.3 and no zero suppression. 

• Select the Load command (Files menu). 

• Enter the appropriate design filename. 

~ Tip Use one design file for all of your custom apertures. 

• In the Layers dialog box, enter a descriptive name in the Filename field, such as 
FIDUCIAL.CUS (the .CUS .extension is mandatory). 

• Enter the filename of the aperture list that you will be using for this custom 
aperture in the Aperture List field. 

• Choose the OK button. GerbTool will inform you that the specified Gerber file 
doesn't exist. Respond affirmatively to create the new layer. 

• At this point you can create your custom aperture using any of the apertures 
defined in the aperture list assigned to the new layer. 

Fb Note Before you save your custom aperture, ensure that the origin is where you 
want it. You can use the Origin command (Edit menu) to relocate the origin. 
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Chapter 11 Using custom apertures 

To use the new custom aperture, enter its filename (less extension) in the Shape field 
of an aperture list using the Edit command (Apertures menu). 

Caution The aperture list used while designing your custom aperture must be 
specified in the Custom Ap List field within the Defaults dialog box. Use the 
Defaults command (Options menu) to change this field if necessary. A aperture list 
used for custom apertu~es should not itself contain any custom apertures. 

~ Tip It is recommended that you set aside one aperture list dedicated to all Your 
custom apertures. 
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Chapter 12 

Working with text fonts 

Editing a font 

GerbTool uses a font file containing a list ofX-Y coordinate pairs that constitute the 
"strokes" required to display each character inserted by the Text command (Edit 
menu). You can have more than one font file but GerbTool will always read the 
STROKE.FNT file at startup. To use a different font file, rename STROKE.FNT to 
some other name, then rename your font file to STROKE.FNT. GerbTool allows 
you to edit existing fonts and create new fonts that are used for text insertion. This 
chapter details the steps for editing fonts. 

Before you edit a font you must convert it into individual Gerber files for each 
character. To do this, from the system prompt change to the GerbTool fonts 
directory and type the following command, then touch the ENTER key: 

f2g .. /stroke.fnt 

This will create an individual Gerber file for each character in the font file. You can 
now start GerbTool and load one of the provided design files UPCASE.GTD, 
LWCASE.GTD, NUMBERS.GTD, P{}NCI.GTD, or PUNC2.GTD, which cover 
uppercase, lowercase, numbers, and punctuation characters respectively. The Film 
Box is set to a 7 -mils square, which each character must remain within. You can 
draw any shape you want as long as you stay in or on the film box and you don't try 
to add flashes. 

Fb Note Itis important that the file format of the individual Gerber files for each 
character remain at Inch, absolute, 2.3, and no zero suppression. 

Once you have finished editing the characters, you can use the following command 
at the system prompt to create a new font file, then touch the ENTER key. 

g2f newfile.fnt 

In the above example a new font file would be created with a filename of 
NEWFILE.FNT. Note that this program does not purge the individual Gerber 
character files. You may do this manually if you want. Remember that GerbTool 
will not recognize your new font file unless it is named STROKE.FNT and is in the 
GerbTool program directory. 
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Creating a new font 

To create a completely new font you can follow the steps detailed in Editing a font 
above, but skip the font file to Gerber file conversion step. 

Fb Note It is usually easier (and faster) to modify an existing font than to create one 
from scratch. 
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Appendix A 

Command 10 values 

The tables in this appendix contain the command ID values associated with each 
GerbTool command. You can use these values to program your mouse and function 
keys. 

Command ID 

Compact (Apertures menu) AO 

Convert (Apertures menu) AV 

Edit (Apertures menu) AE 

Load (Apertures menu) AL 

Merge (Apertures menu) AM 

Report (Apertures menu) AR 

Save (Apertures menu) AS 

Unload (Apertures menu) AU 

Arc 3 Pt (Add item, Edit menu) EAA3 

Arc Ctr (Add item, Edit menu) EAAC 

Circle (Add item, Edit menu) EAC 

Draw (Add item, Edit menu) EAD 

Flash (Add item, Edit menu) EAF 

Polygon (Add item, Edit menu) EAP 

Rectangle (Add item, Edit menu) EAR 

Text (Add item, Edit menu) EAT 

Vertex (Add item, Edit menu) EAV 

Align (Edit menu) EA 

Clip (Edit menu) EK 

Command 10 values (page 1 of 5). 
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Command ID 

Copy (Edit menu) BC 

Expand (Dcode item, Edit menu) EDE 

Polarity (Dcode item, Edit menu) EDP 

Scale (Dcode item, Edit menu) EDS 

Transcode (Dcode item, Edit menu) EDT 

Erase (Edit menu) EE 

Item (Edit menu) ET 

Mirror (Edit menu) EI 

Move (Edit menu) EM 

Origin (Edit menu) EO 

Purge (Edit menu) EP 

Rotate (Edit menu) ER 

Add (Select item, Edit menu) ESA 

Invert (Select item, Edit menu) EPI 

New (Select item, Edit menu) ESN 

Off (Select item, Edit menu) ESO 

Remove (Select item, Edit menu) ESR 

Undo (Edit menu) EU 

Chgdir (File menu) FD 

Close (File menu) FC 

Exit (File menu) FQ 

BARCO DPF (Export item, File menu) FEB 

IPC-D-350 (Export item, File menu) FE350 

IPC-D-356 (Export item, File menu) FE356. 

Drill (Format item, File menu) FFD 

Gerber (Format item, File menu) FFG 

Load (Format item, File menu) FL 

BARCO DPF (Import item, File menu) FIB 

Command ID values (page 2 of 5). 
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Command ID 

Drill (Import item, File menu) FIN 

HPGL (Import item, File menu) FIH 

IPC-D-356 (Import item, File menu) FI356 

Design (Merge item, File menu) FMD 

Gerber (Merge item, File menu) FMG 

Auto (New item, File menu) FNA 

Manual (New item, File menu) FNM 

Open (File menu) FO 

HPGL (Plot item, File menu) FPH 

PostScript (Plot item, File menu) FPP 

Print (File menu) FP 

Save (File menu) FS 

Colors (Layers menu) LC 

Edit (Layers menu) LE 

Arcs 360 (Options menu) OA 

Bg Color (Options menu) OB 

Defaults (Options menu) OD 

Filmbox (Options menu) OF 

Grid (Options menu) OG 

KeyCmds (Options menu) OK 

Metric (Options menu) OM 

Ortho (Options menu) OR 

Overlay (Options menu) 00 

Save (Options menu) OV 

Show Errs (Options menu) OE 

Sketch (Options menu) OS 

Undo (Options menu) OU 

Copper (Query menu) QC 

Command ID values (page 3 of 5). 
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Command 

Extents (Query menu) 

Dcode (Highlight item, Query menu) 

Net (Highlight item, Query menu) 

Off (Highlight item, Query menu) 

Item (Query menu) 

Edge to Edge (Measure item, Query menu) 

Point to Point (Measure item, Query menu) 

Circles (Convert item, Tools menu) 

Pads (Convert item, Tools menu) 

DRC (Tools menu) 

Fix SS (Tools menu) 

Lyr Spread (Tools menu) 

Load (Macro item, Tools menu) 

Run (Macro item, Tools menu) 

Drawing (NC Drill item, Tools menu) 

Write· (NC Drill item, Tools menu) 

Generate (Netlist item, Tools menu) 

Write (Netlist item, Tools menu) 

Isolated (Pad Removal item, Tools menu) 

Stacked (Pad Removal item, Tools menu) 

Panelize (Tools menu) 

Snoman (Tools menu) 

Vent (Tools menu) 

All (View menu) 

Errors (View menu) 

Filmbox (View menu) 

Pan (View menu) 

Previous (View menu) 

Command ID values (page 4 of 5). 
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QE 

QHD 

QHN 

QHO 

QI 

QME 

QMP 

TCA 

TCP 

TD 

TF 

TL 

TML 

TMR 

TNDD 

TNDW 

TNLG 

TNLW 

TPI 

TPS 

TP 

TS 

TV 

VA 

VE 

VF 

VP 

VV 
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Command 10 

Recall (View menu) VC 

Redraw (View menu) VR 

Save (View menu) VS 

Window (View menu) VW 

ZoomIn (View menu) VI 

ZoomOut (View menu) va 

Command ID values (page 5 of 5). 

Command 10 

All (View menu) VA 

Film Box (View menu) VF 

Pan (View menu) VP 

Previous (View menu) VV 

Redraw (View menu) VR 

Window (View menu) VW 

Zoom In (View menu) VI 

Zoom Out (View menu) va 

Command ID values assignable to mouse buttons. 
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Appendix B 

Apertu re list file format 

This appendix describes the format of a GerbTool aperture list and provides an 
example of an aperture list. 

Aperture lists are stored as simple ASCII files. There are nine fields in each line of 
the file. Each line defines one D-code. The fields consist of the following: 

Field 

D-Code 

Shape 

Width 

Height 

Type 

Tool 

Tool Size 

Legend 

R90 

Possible values 

10 - 4095 

Round, Square, Rectangle, Oblong, Donut, Diamond, 
Octagon, Thermal, Therm45, Target, Complex, or a filename 
prefixed by a "%" 

0.0 - 9.9999 

0.0 - 9.9999 
When referring to Donuts or Thermals, this field represents 
the diameter of the inner hole. When referring to Targets, it 
refers to the diameter of the inner ring of the Target. 

SM (surface-mount) or TH (through-hole) 

0-999 
Specifies the Tool used to drill this D-Code. 

0.0 - 9.9999 
Specifies the size of the above Tool number. 

10 - 4095 
Specifies the D-Code to use in place of this D-Code when 
creating a Drill Drawing using the Drawing command from 
the Tools>Drill menu. 

10 - 4095 
Specifies the D-Code to substitute for this D-Code when 
rotating 90 or 270 degrees. This field exists only for 
compatibility with older versions ofGerbTool, as newer 
versions perform the D-Code substitutions automatically. 

Aperture list field definitions. 
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All fields are separated by white space. Lines that begin with a ''#'' are treated as 
comments. Although the author and data comments are not required, they are 
generally included as an aid for other users. The header of a GerbTool aperture list 
may contain a format line proceeded by a "%." This line contains either IMPERIAL 
or METRIC followed by a version number. If IMPERIAL is specified, all sizes are 
in inches. If METRIC is specified, they are in millimeters. Ifno format line is 
provided, IMPERIAL is assumed. The version number is for documentation 
purposes only. An excetpt from an aperture list showing the required format follows. 

# Format, Version 

%IMPERIAL, V3.0 

# 

# Author: GerbTool V1.0 (c) 1992 WISE Software 
Solutions, Inc. 

# Date: Wed Oct 7 13:28:46 1992 

# 

# Shape Width Height Type Tool Size Legend R90 

# 

D12 Round 0.0100 0.0100 TH 0 0.0 0 0 
D21 Square 0.0200 0.0200 TH 2 0.0 0 0 
D22 Rectangle 0.0220 0.0180 SM 3 0.0 85 0 
D23 Oblong 0.0220 0.0180 TH 3 0.0 0 0 
D24 Diamond 0.0240 0.0240 TH 4 0.0 0 0 
D25 Target 0.1800 0.1600 TH 0 0.0 0 0 
D26 %FIDUCIAL 0.0000 0.0000 TH 0 0.0 0 0 
D70 Octagon 0.0240 0.0240 TH 5 0.0 0 0 
D71 Thermal 0.0240 0.0200 TH 0 0.0 0 0 

Sample aperture list file. 

In the above example, D26 is specified as a Custom aperture with a filename of 
FIDUCIAL.CUS. The "%" is required, to notify GerbTool that what follows is a 

. custom aperture filename. 
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Appendix C 

Snoman concepts 

Snoman creates a maximum material condition at the point where a trace segment 
enters a pad, thereby eliminating the possibility of pad/trace separation (breakout). 
This is accomplished by examining a Gerber file (layer) and outputting pad flashes 
at the correct locations, and of the correct size, to provide the most material where a 
trace enters a pad. Automatic adjustments are made to the size and location of the 
generated Snoman pads to eliminate design rule spacing violations. 

The following illustration shows the original pad and trace, as well as the resultant 
Snomanpad. 

Host pad Snomanpad 

Host offset Trace 

Snoman concept. 

The distance maintained between the host pad center and the edge of the generated 
Snoman pad (see Host offset in illustration above) is adjustable. Negative values 
allow the Snoman pads to closely hug the host pads. 
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A 
absolute mode When all X-Y coordinates 
are referenced to a common origin (0,0). 

active layer The layer that all items added to 
the database will go to. 

aperture list A list of Gerber D-Code 
definitions. 

B-C 
block size The size of a coordinate value in 
characters. Also known as m.n format. 

breakout Pad and trace separation during 
fabrication. 

D-H 
design file A file containing information 
about the layer structure of a single PCB design. 
This file also stores various information about 
the GerbTool operating environment. 

ORe Acronym for Design Rules Check. 

Glossary 

J-M 
incremental mode When each X-V 
coordinate is a displacement from the previous 
coordinate. 

isolated pads Pads that do not have a trace 
connected to them. 

N-O 
NC drill Refers to files produced to drive 
Numerically Controlled drilling machines. 

netlist A file containing groups of pad X-V 
locations that are connected by traces. 

p-u 
pad removal The act of removing isolated or 
stacked pads. 

pan Moving the location of the viewing 
window without changing its size. 

panelize Placing multiple copies of a PCB on 
one piece of film. The multiple copies are then 
manufactured on a single panel, thereby 
reducing manufacturing costs. 

point A X-Y location within the drawing area. 
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·'···ll· ... ' .... ' .... , ': .... :, :.~. '. :. '; .~ 

virtual memory A combination of hardware 
and software that allows an application to 
address all memory that the CPU is capable of 
addressing, even when there is less actual 
memory. The virtual memory manager swaps 
data back and forth to the disk and remaps 
memory addresses to provide applications with 
virtually unlimited memory. Available disk 
space becomes the limiting factor. 

w-z· 
wildcard specification A method of 
specifying more than one filename at a time. Use 
the asterisk (*) character to match any character 
or group of characters. Use a question mark (?) 
to match a single character. For example: *.GTD 
represents all files that end with the .GTD 
extension. 
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A 
active layer, 14 
add 

arc, 56 
arc 3 pt, 56 
circle, 55 
draw, 55 
flash, 55 
polygon, 56 
rectangle, 55 
text, 58 
vertex, 55 

aligning layers, 21, 51 
annular ring, 89 
aperture conversion rules 

#,278 
CUSTOM, 276 
DCODE,278 
DEBUG, 277 
DEFAULT_UNITS, 276 
EXTENSION; 277 
FORMAT_shape, 279 
FORMAT_SPECIAL, 280 
FORMAT_UNITS, 279 
HEADER, 275 
NAME, 274 
SKIP, 275 
VERSION,274 
XTENSION, 278 

aperture list 
compacting, 68 
converting, 6, 68 
create, 68 
editing, 64 
embedded, 283 

files, 15 
format, 297 
load,68 
merging, 68 
saving, 68 
unloading, 68 
use report, 67 

apertures 
custom, 65 
definition, 66 
macro, 65, 66, 284 
maximum size, 75 

arcs 
chord angle, 75, 242 
conversion, 100 
interpolated, 13, 73 

B 
background color, 77 
BARCODPF 

exporting, 36 
importing, 34 

birdseye view, 11 
breakout, 299 

c 
calculating 

copper, 72 
data extents, 72 

chord angle, 75 
color list file, 3 
command ID, 291 
compacting 

aperture list, 68 

I n d e X 
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Index 

composite layers, 23 
274X,61 

composites, 274X, 285 
composites, viewing 274X, 53, 285 
configuration, 3 
configure 

aperture converters, 78 
function keys, 77 
macro files, 80 
mouse, 77 
paths, 79 
user menu, 81 

conversion 
aperture lists, 15 
arcs, 100 
drawn pads, 99 
RS274D to 274X, 285 

converting aperture list, 68 
coordinate display, 14 
copper calculation, 72 
copying, 47 
creating a soldermask layer, 26 
creating NC Drill files, 22 
crosshair 

size, 76 
crosshair cursor, 14 

o 
data extents calculation, 72 
D-code 

expand, 50 
highlight, 72 
polarity, 51 
scale, 50 
transcode, 26, 50 

deleting, 48 
deleting with clipping, 48 
design 

automatic, 8, 29 
closing, 30 
creating, 9, 29 
merging, 24, 33 
opening,9,30 
save, 30 
save all, 30 
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save as, 30 
destination layer 

copying, 47 
moving, 48 

drawing 
interrupting, 18, 19 

drawing area, 11, 14 
drawn pads, 25 

conversion, 99 
DRC, 88 

annular ring, 89 
keepouts, 90 
missing drill, 89 
stubs, 89 
view errors, 90 
well behaved, 89 

E 
edit item, 47 
editing 

aperture list, 64 
editing layers, 59 
ending a command, 18 
exiting GerbTool, 10, 42 
exporting 

BARCO DPF, 36 
HPGL,37 
IPC-D-350, 36 
IPC-D-356, 36 
PostScript, 39 

F 
file format 

critical, 35 
detection, 62 
global,31 
local, 31, 62 
metric, 32 

film box, 15 
change, 76 

fonts 
creating, 290 
editing, 289 

function key assignments, 16 



G 
Gerber dialect 

274X,31 
EIE,31 
FlRE9xxx, 31 

Gerber files, 15 
grid 

change size, 76 
display, 13, 53 
snap, 13 

group 
selecting, 45 

GTMAPDIR, 79 

H 
highlight 

clear, 53 
colors, 76 
D-codes,72 
nets, 70 
selections, 54 
toggle, 53 
userdata, 71 

importing 
BARCO DPF, 34 
IPC-D-356 netlist, 35 
NC Drill file, 35 

interactive plot positioning, 38 
IPC-D-350 

exporting, 36 
IPC-D-356 

exporting, 36 
IPC-D-356 netlist 

importing, 35 
isolated pad removal, 97 
item 

editing, 47 
item information 

displaying, 69 

J-K 
join, 49 
joining lines, 49 

L 
layers 

active, 14 
aligning, 51 
alignment, 21 
color and visibility, 63 
color, floating, 11 
composite, 23 
create, 63 
editing, 59 
maximum, 75 
path, 60 
rearranging, 61 
ref mode, 75 
save, 30 
save all, 30 
save as, 30 
spread, 101 
visibility, 61 

lines 
chamfer, 49 
fillet, 49 
joining, 49 

loading macros, 106 

M 
macro 

coordinate lists, 105 
edit, 82 
function keys, 77 
language reference, 107 
loading, 82, 106 
running, 82, 106 
system variables, 104 

macros 
ABORTCHECKRATE,258 
ABS, 198 
ACTIVELA YER, 165 
ADD3PTARC,108 
ADDARC, 109 

Index 
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ADDCIRCLE,110 
ADDDRA W, 111 
ADDFILL, 112 
ADDFLASH,113 
ADDPOUR,114 
ADDTEXT,115 
ADDVERTEX,116 
ALIGNLA YERS, 138 
APREPORT, 117 
ARRAY, 199 
ASIN,200 
ATAN,201 
BKCOLOR, 166 
CALC, 202 
CALLMACRO, 120 
CEIL,203 
CLIP, 139 
COPY, 141 
COPYITEM,125 
CREATELA YER, 259 
CSIN,204 
CURRENTDCODE, 167 
DCEXPAND,143 
DCODESCALE, 144 
DEBUG,121 
DELETEITEM, 126 
DRAWNPADS, 231 
DRC, 233 
DRILL,235 
ERASE,146 
EXTENSIONS, 168 
FILECLOSE, 191 
FILEOPEN,192 
FILEREAD,193 
FILESP A TH, 169 
FILE WRITE, 194 
FILMBOX, 170 
FIXSS, 237 
FLAGS, 171 
FLOOR, 205 
FORMAT,172 
GETAPINFO,118 
GETEXTENTS, 127 
GETFILMBOX, 128 
GETFIRSTITEM, 129 
GETLA YER, 131 
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GETNEXTITEM, 133 
GETPOINT, 249 
GETSTRING,250 
GETUSERDATA,134 
GETV ALUE, 252 
GETVIEWEXTENTS, 135 
GETWINDOW, 251 
GETYESNO, 253 
GRID SIZE, 174 
GRIDSNAP, 175 
GRIDVISIBLE, 176 
HILICOLORS, 177 
HILIDCODE,216 
HILIITEM, 217 
IF,122 
LAYERN,178 
MAPPATH, 180 
MEASUREE2E,218 
MERGEDRILL,195 
MERGE GERBER, 196 
MERGEHPGL,197 
MESSAGEBOX, 254 
MIRROR,148 
MOVE,150 
MOVEITEM, 136 
NETID,181 
NETLIST, 238 
OFFSETS, 182 
ORIGIN,152 
OVERLAYMODE,183 
PADREMOV AL, 239 
PANELIZE, 240 
PAUSE,257 
PLOTHPGL, 212 
PLOTPS,214 
POUR,153 
PREVIOUS VIEW, 184 
PURGE,155 
PUTAPINFO, 119 
PUTUSERDATA, 13 7 
REDRAW,262 
REPEAT,123 
ROTATE,156 
ROUND,206 
SCALE,185 
SEGMENTARCS, 242 



SELECTCRITERIA, 158 
SELECTGROUP, 159 
SET,207 
SETGLOBAL, 208 
SETPROMPT, 255 
SHOWERRORS, 186 
SHOWPROMPT,256 
SIN,209 
SKETCHMODE, 187 
SNOMAN,243 
SPLITPATH, 260 
SPREAD,247 
SQRT,210 
STOP, 124 
STRARRAY, 219 
STRCAT,220 
STRCMP, 221 
STRCPY, 222 
STRLEN,223 
STRLOC, 224 
STRREAD, 225 
STRSET,226 
STRSETGLOBAL,227 
STRSUB,228 
STRTOK,229 
STRWRITE, 230 
SYSCMD,261 
TAN,211 
TEARDROPS, 245 
TEXT,161 
TRANSCODE, 163 
UNDO, 188 
VENT,248 
VIEWALL,263 
VIEWCOMPOSITES, 189 
VIEWFILMBOX, 264 
VIEWMETRIC, 190 
VIEWPAN, 265 
VIEWPREVIOUS, 266 
VIEWRECALL, 267 
VIEWSA VE, 268 
VIEWWINDOW, 269 
ZOOMIN,270 
ZOOMOUT, 271 

measuring 
edge-to-edge, 71 

point-to-point, 71 
merging 

aperture list, 68 
design file, 24, 33 
Gerber file, 33 
HPGL file, 34 

metric mode, 13, 73 
mirroring, 49 
mouse button assignments, 16 
moving, 48 

N 
NC Drill, 15 

creating, 22, 98 
drawing, 97 
importing, 35 
tools, 65 

netlist 
generate, 94 
highlight, 70 
saving, 32, 95 
well behaved, 94 

o 
offsets 

applying, 50 
operating environment, 15 
origin, 51 
ortho 

line angle, 75 
orthogonal mode, 13, 73 
overlay mode, 12 
overview, 5 

p 
pad removal 

isolated, 97 
stacked,97 

page setup, 41 
panelize, 23, 83 

virtual, 87, 98 
panning, 52 
plotting 

batch mode, 38, 40, 41 

Index 
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borders, 37, 39, 212, 214 
composite layers, 39 

polygon 
filling, 56 
pouring, 56 

PostScript plotting, 39 
print preview, 42 
printer setup, 42 
printing, 42 

borders, 41 
programming 

function keys, 20 
mouse buttons, 20 

purging, 51 

Q 
query 

nets, 70 
userdata, 71 

querying 
database information, 69 

R 
redraw 

minimize, 77 
rotating, 49 
rule violation 

displaying, 12, 54 
running macros, 106 

s 
save, 30 
save all, 30 
save as, 30 
scale 

database, 50 
D-codes,50 

selecting groups, 45 
selection criteria, 43 
settings 

current, 12 
shortcut keys, 17, 19 
silkscreen 

automatic cleanup, 25 

auto fixup, 96 
sketch mode, 12 
Snoman, 27, 91 
soldermask layer 

creating, 26 
split scre~n, 11 
starting GerbTool, 5 
status bar, 15 
step and repeat, 98 
surface-mount pads, 65 

T 
teardrops, 92 
text, 58 
thieving, 101 
through~hole pads, 65 
tool tips, 11 
toolbar,11 
transcode,26 

u 
undo, 19,44 

toggle, 75 
unused pad removal, 97 
userdata 

editing, 47 
highlight, 71 

v 
vent 

automatic. 86 
manual, 101 

view 
all, 52 
birdseye, 14 
composites, 12, 53 
errors, 12, 90 
film box, 52 
grid, 53 
new window, 52 
overlay mode, 53 
panning, 52 
previous, 54 
recall, 54 
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redrawing, 53 
saving, 54 
sketch mode, 53 
split screen, 14, 54 
toolbars, 54 
virtual panel, 53 
zoom in, 52 
zoom out, 52 

W-y 
well behaved 

DRC, 89 
netlist,94 

window, 11 
wizard 

new design, 29,74 

z 
zero suppression, 32 
zooming in, 52 
zooming out, 52 
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